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Safety Information

The safety information section provides information on the safe use of the instrument. It
includes the use of user-attention statements in this guide, a key to understanding the
safety labels on the instrument, precautions to follow before operating the instrument, and
precautions to followwhile operating the instrument.
Read and observe all warnings, cautions, and instructions. Remember, themost important
key to safety is to operate the instrument with care.

WARNING! If the instrument is used in a manner not specified by Molecular
Devices, the protection provided by the equipment might be impaired.

Warnings, Cautions, Notes, and Tips
All warning symbols in the user guide are framed within a yellow triangle. An exclamation
mark is used for most warnings. Other symbols can warn of other types of hazards such as
biohazard, electrical, or laser safety warnings as are described in the text of the warning.
When warnings and cautions are displayed in this guide, be careful to follow the specific
safety information related to them.
The following user-attention statements can be displayed in the text ofMolecular Devices
user documentation. Each statement implies a particular amount of observation or
recommended procedure as described:

WARNING! A warning indicates a situation or operation that could cause
personal injury if precautions are not followed. The warning symbol can vary
depending on the warning. The definition of the symbol is included in the text of
the warning.

CAUTION! A caution indicates a situation or operation that could cause damage to
the instrument or loss of data if correct procedures are not followed.

Note: A note calls attention to significant information.

Tip: A tip provides useful information or a shortcut, but is not essential to the
completion of a procedure.
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Symbols on Instrument Labels
Each safety label found on the instrument contains an alert symbol that indicates the type of
potential safety hazard related to the label. The following table lists the alert symbols that
can be found on Molecular Devices instruments.

Symbol Indication

Indicates that the product documentation must be consulted.Indicates a
warning for a situation or operation that could cause personal injury if
precautions are not followed. There are specific details written next to
the warning symbol.

Indicates a potential ultraviolet light hazard.

Indicates a potential pinch hazard.

Indicates a potential heat hazard.

Indicates power on.

Indicates power off.

Indicates the instrument manufacture date.

Indicates European technology conformity.

Indicates certification by TUV Rheinland for compliance with US and
Canadian product safety standards.
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Symbol Indication

Indicates compliance with TUV Rheinland product safety for Germany.

Indicates compliance with Chinese RoHS Pollution Control
Requirements.

Electrical Safety
To prevent electrically related injuries and property damage, inspect all electrical equipment
before use and immediately report all electrical deficiencies. Contact Molecular Devices
Technical Support to service equipment that requires the removal of covers or panels.
The instrument must be connected to a properly grounded power outlet to protect from the
risk of electric shock. Themain chassis of the instrument is grounded together with all
related electrical components.
Do not remove the fixed covers, as there are no user-serviceable parts inside. All electrical
work must be referred to Molecular Devices approved service personnel.
In the event of a liquid spillage into themain cavity of the instrument, disconnect themains
power supply before trying to clean up.
If the external covers on the instrument are removed, the power supply does not
automatically stop.

WARNING! HIGH VOLTAGE Power off the instrument and disconnect the
power cord before you do maintenance procedures that require removal of a
panel or cover or disassembly of an interior instrument component.

Do not try to use the instrument until all covers are replaced.
To provide access for disconnecting power from the instrument, maintain a 66 cm (26 in.)
minimum clearance area on the right side of the instrument.
To protect against fire hazard, replace the fuses only with the same type and rating as the
original factory-installed fuses.

Chemical and Biological Safety
Normal operation of the instrument can involve the use ofmaterials that are toxic,
flammable, or otherwise biologically harmful. When using such materials, observe the
following precautions:

Handle infectious samples based on good laboratory procedures and methods to
prevent the spread of disease.
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Observe all cautionary information printed on the original containers of solutions before
their use.
Dispose of all waste solutions based on the waste disposal procedures of your facility.
Operate the instrument in accordance with the instructions outlined in this guide, and
take all the required precautions when using pathological, toxic, or radioactivematerials.
Splashing of liquids can occur. When working with potentially hazardous liquids, take
applicable safety precautions, such as wearing safety glasses and protective clothing.
Observe the applicable cautionary procedures as defined by your safety officer when
using hazardous materials.
Observe the applicable cautionary procedures as defined by your safety officer when
using flammable solvents in or near a powered-up instrument.
Observe the applicable cautionary procedures as defined by your safety officer when
using toxic, pathological, or radioactivematerials.

WARNING! Never use the instrument in an environment where potentially
damaging liquids or gases are present.

Moving Parts Safety
To prevent injury due to moving parts, observe the following:

Never try to exchange labware, reagents, or tools while the instrument is operating.
Never try to physically restrict themoving components of the instrument.
Keep the interior of the instrument clear to prevent obstruction of themovement.

Themotors use high-powered magnets. The linear drive units and encoders are delicate, so
be very careful with them. To prevent serious damage to the instrument or its auxiliary parts,
follow the preparation instructions in this guide before every process.
The instrument is equipped with an automatically locking door that locks whenever you run
a process. The door prevents UV light from passing through during operation.
As a safety measure, if the door is open, an electromagnetic switch prevents the instrument
from running. Never tamper with this switch, as it serves two purposes:

It prevents themotors from running to reduce the potential of physical damage.
It disables the UV light to prevent the risk of damage from UV radiation.

Motors and their related drives and cabling are sources of electromagnetic fields. Keep
magnetic storage devices or strips, such as hard drives and credit cards, away from the
instrument covers.

Note: Observe all warnings and cautions listed for all external devices attached to or in
use during the operation of the instrument. See the applicable user guide for the
operating and safety procedures of that device.

Ultraviolet (UV) Light Safety
The instrument is equipped with an automatically locking door that locks whenever you run
a process. The door prevents UV light from passing through during operation.
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As a safety measure, if the door is open, an electromagnetic switch prevents the instrument
from running. Never tamper with this switch, as it serves two purposes:

It prevents themotors from running to reduce the potential of physical damage.
It disables the UV light to prevent the risk of damage from UV radiation.
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Chapter 1: Introduction

The FLIPR® Penta High-Throughput Cellular Screening System provides an automated
solution for identifying early leads in the drug discovery process and for evaluating drug
efficacy and toxicity. With simultaneous pipette and read function, the system supports fast
kinetic cellular assays. It can be quickly configured based on library size, detection mode,
screening format, assay and target. A fully integrated solution from assay development to
lead optimization.
The FLIPR Penta System includes:

Simultaneous 96-well, 384-well or 1536-well liquid or cell transfer
Expanded wavelength support
User-configurable pipettors and optics
FLIPR® Cycler, internal robotic plate handler option that works in conjunction with
external robotic software
Choice of camera:

EMCCD camera for fluorescence applications
HS EMCCD high-speed, high-sensitivity camera for fluorescence and luminescence
ICCD camera for fluorescence and luminescence

Cell suspension option
Compact platform with minimal facilities requirements
ScreenWorks® Software and optional ScreenWorks® Peak Pro™ Softwaremodules for
analysis

This chapter includes the following introductory topics:
Workflow on page 14
Before You Start on page 14
System Requirements on page 14
Software Installation on page 16
Powering On and Powering Off the System on page 18
Checking Instrument Status and Configuration on page 20

1
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Workflow
The FLIPR Penta High-Throughput Cellular Screening System uses the following sequence of
processes:
1. Prepare the cells.
2. Power on the system.
3. Run a system check.
4. Load cell dye.
5. Prepare source plates.
6. Set up an assay protocol.
7. Run the experiment.
8. Analyze the data.

Before You Start

CAUTION! Before using the instrument, it is very important that you read and
understand all the safety instructions. Then follow the procedures in Powering On the
System on page 18.

System Requirements
The following is an overview of electrical, physical and environmental requirements for the
FLIPR Penta System.

Electrical

The FLIPR Penta System draws 12 Amaximum and requires 100-240 VAC power source at
50-60 Hz. The system ships with a power cord appropriate for the receiving country.
Additional shared outlets are required for computer and monitor. A power strip is acceptable
for providing the additional outlets for the computer and monitor.

Minimum Lab Space

System dimensions are as follows:
Without Cell Suspension Module or FLIPR Cycler: approximately 39 inches wide x
27 inches deep x 70.25 inches high (99 cm wide x 69 cm deep x 1780.44 mm high).
With Cell Suspension Module and FLIPR Cycler: approximately 53 inches wide x 27 inches
deep x 70.25 inches high (134.6 cm wide x 69 cm deep x 1780.44 mm high).

Note: To open the stage access door completely, you need more than 30 inches
(76 cm) additional space in front of the instrument.
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The external ScreenWorks Software host computer, is mounted on the right side of the
instrument cabinet. Themonitor, keyboard, and mouse are installed on an adjustable arm
attached to the front right side of the instrument cabinet. Combined, they require an
additional minimum amount of space of 40 inches (102 cm)wide x 40 inches (102 cm) deep
for maneuverability.
For instruments with the ICCD camera, a chiller with dimensions 11 inches wide by 13 inches
deep by 13 inches high (28 cm x 33 cm x 33 cm) is connected to the right side of the
instrument with a 3-foot (91.4 cm) long tube. It can be placed anywhere within that 3-foot
(91.4 cm) radius as long as there is access to the on/off button on the chiller.
Aminimum 32 inch (81 cm) square footprint is required on the right side of the instrument
for tip wash bottles.
The instrument cabinet should have servicing access space of 48 inches (122 cm) in front,
24 inches (61 cm) behind , and 10 inches (25.4 cm) on the left.
The FLIPR Penta System is designed with rolling castors so it can be readily moved to make
necessary adjustments and perform maintenance. Leveling feet are also installed on the
lower instrument chassis. These feet stabilize the instrument when integrated with a robot,
but can also be used to establish a uniform instrument deck level in situations where the lab
floor is not flat. When running an experiment, make sure the instrument feet are lowered
and leveled.

WARNING! The FLIPR Penta System can weigh as much as 860 lbs (390 kg).
Follow all necessary safety precautions and use proper moving techniques.

Computer System

The FLIPR Penta System uses two computers, an embedded computer and a host computer.

Embedded Computer

An embedded computer, supplied with the system in the lower chamber of the instrument
cabinet, controls all of the FLIPR Penta System basic functions. These functions are initiated
through the ScreenWorks Software installed on the host computer, and sent to the
embedded computer to execute the function. This configuration allows separate data
processing and instrument control to ensuremaximum productivity during an experiment.
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Host Computer

All normal user interaction with the FLIPR Penta System is done using the ScreenWorks
Software that runs on the provided external host computer.

Item Description

CPU 2.5 GHz, quad processor or faster

Operating system Windows 10, 64-bit
Windows 7, 32-bit and 64-bit older systems supported

Memory 16 GB RAM
4 GB RAM minimum

Data Connection 10/100 Ethernet port

Storage 500 GB hard drive

Table 1-1: ScreenWorks Software Computer Requirements

Software Installation
Your FLIPR Penta System is completely set up in your lab by your Molecular Devices
representatives. The following software installation procedures are for when you might need
to update the ScreenWorks Software System Control Software on your host computer.
You must have administrative privileges on the computer to install the ScreenWorks
Software.
Installing the software includes the following procedures:
1. Installing ScreenWorks Software on page 16
2. (Optional) Activating the ScreenWorks Peak Pro License on page 17

Installing ScreenWorks Software

As of version 3.1, the installer automatically uninstalls the old software version as long as it is
the samemajor release (3.1 to 3.2). If you are replacing ScreenWorks Software version 3.2 or
version 4.x with version 5.0, manually uninstall the old software. See Uninstalling
ScreenWorks Software.
Use the following procedure to upgrade your ScreenWorks Software when needed.
To install the software:
1. Double-click the ScreenWorks_5_0_x.exe ScreenWorks Software installation file. A

Welcome to the ScreenWorks Setup Wizard dialog is displayed.
2. Click Next.
3. In the License Agreement dialog, select I accept the terms of the license agreement,

and click Next.
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4. In theOnline/Offline Mode dialog, designate the default mode in which you want the
software to start.

In Online, ScreenWorks Software automatically looks for a connected instrument
when the software is started.
In Offline, ScreenWorks Software does not automatically look for a connected
instrument.

See OnlineMode vs. OfflineMode on page 47 for details.
5. Click Next.
6. In theDestination Folder dialog, the Install ScreenWorks 5.0 to field displays the default

installation directory. To change the installation directory, click Change, navigate to the
desired directory, then click OK.

7. Click Next.
8. In the Select Program Folder dialog, leave the displayed default Program Folder

settings. Select Anyone who uses this computer to make ScreenWorks Software
available to all users on the FLIPR Penta System host computer, then click Next.

9. In the Configuring the ScreenWorks installation dialog, if you want to make any
changes, click Back to go to the previous screen, otherwise click Next to start the
installation.

10. When the installation is complete, the Completing the installation process dialog
appears. Click Finish to exit the wizard.

(Optional) Activating the ScreenWorks Peak Pro License

The ScreenWorks® Peak Pro™ Software functionality is license-protected. The software
license activation enables the Peak Pro analysis functionality any time after the trial period
expires. The following Peak Pro analysis licenses are available for purchase:

ScreenWorks Peak Pro Software version 1.0—adds additional Kinetic Reduction
Configuration types
ScreenWorks Peak Pro Software version 2.0—adds a new Peak Pro 2.0 Analysis dialog
and support for high-speed and high-sensitivity data

Note: There is a one time 14-day Peak Pro trial usage option in the Help menu. When
the trial period expires, the Peak Pro 1.0 analysis functionality disappears, the Peak
Pro 2.0 analysis functionality disables, and the Help menu trial option is inactive. The
rest of the ScreenWorks Software version 5.0 remains functional.

To activate the ScreenWorks Peak Pro Software software license:
1. Start the ScreenWorks Software.
2. Click theHelp tab.
3. Click Software License.
4. If you have not started the available 14-day Peak Pro trial, the option to start the 14-day

Peak Pro trial, or enter the product key appears. Click Yes.
After the trial expires, only the option to provide a software license product key appears.
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5. If you have internet connectivity, type the provided Product Key in the field and click
Activate Online, and then follow the on-screen instructions.

6. If you do not have Internet connectivity, click Activate Offline and follow the on-screen
instructions. Activate Offline requires the following:

Your product key
A separate computer with Internet connectivity
A USB drive for transferring files between the computers

7. Restart ScreenWorks Software to finish the license activation.

Uninstalling ScreenWorks Software

The following is the recommended method for removing ScreenWorks Software from a
Windows-based computer because it also removes related information from theWindows
Registry.
To uninstall ScreenWorks Software:
1. Open Control Panel.
2. Depending on yourWindows operating system:

Windows 7—Click Add or Remove Programs
Windows 10—Click Programs and Features

3. In the list that displays, select ScreenWorks.
4. Click Remove or Uninstall.
5. Follow the on-screen instructions to finish uninstalling the software.

Powering On and Powering Off the System
The following procedures are for powering on and powering off the FLIPR Penta System,
which includes connecting the ScreenWorks Software to the instrument.

Powering On the System

Before continuing, do as instructed in Before You Start.
To power on the FLIPR Penta System:
1. Power on the computer and monitor.
2. Simultaneously press the CTRL+ALT+DELETE keys to launch theWindows operating system.
3. At the prompt type your password.

Note: The first time you log in after your system installation, the default password
is fliprtetra.
Wait for the operating system to finish starting-up before continuing.

4. Power on the external chiller with the switch located on the left side of the chiller.
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5. Power on the FLIPR Penta System power switch located on the right side of the
instrument.

CAUTION! The system goes through an initialization cycle to register all of the
instrument components. This cycle is not complete until the green Assay Finished
(Unlock) light on the upper door is the only light illuminated on the instrument
status panel.

6. Double-click on the desktop icon to start the ScreenWorks Software.

Tip: Do not repeatedly double-click the software icon. Starting the software can
take several seconds.

Note: The system is ready for use when the camera temperature is at operating
temperature. The camera temperature and status display in the ScreenWorks
Software Instrument Status panel. The camera operating temperature depends on
the camera in your instrument. See CCD Camera Options on page 35.

Connecting the Software to the Instrument

After powering on the instrument, when you start the ScreenWorks Software, it should
automatically connect to the instrument. In the software, in the Instrument Status panel, in
the lower right corner of the screen, a green connection status icon indicates the connection

and in the toolbar, the button displays.

If you see a black connection status icon, the software is disconnected from the instrument,

and in the toolbar, the button displays.

To connect to the instrument, click .
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Powering Off the System and the Software

To power off the FLIPR Penta System:
1. At the end of an experiment run, wait for the Assay Finished (Unlocked) light on the

upper door, Instrument Status Panel turns green, indicating the experiment is finished.
2. If the last protocol run did not remove the tips from the pipettor head, Molecular

Devices recommends making sure that you remove them using themanual command.
Failure to remove tips can result in an error on next start.

3. Exit ScreenWorks Software by selecting File > Exit.
4. Power off the computer and monitor.
5. Power off the FLIPR Penta instrument.
6. Power off the chiller.

Checking Instrument Status and Configuration
You can check instrument status on the front of the instrument and from within the
ScreenWorks Software. You can only check the instrument configuration status from within
the ScreenWorks Software. For more details see System Status Panel and Software Status
Tabs on page 21.

System Status Panel

The system status panel, located next to the upper door handle, indicates if the door is
locked or unlocked, depending on the instrument activity. It also includes an emergency
Interrupt button to stop any running processes.

Figure 1-1: The System Status Panel
The panel has two lights and the Interrupt button. From the top of the panel these are:

Assay Running (Locked)—Yellow light
The FLIPR Penta System is performing a task. The upper and lower doors are locked until
the task finishes or is stopped using the Interrupt button.
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Assay Finished (Unlocked)—Green light
No tasks are being run and it is safe to open the upper and lower instrument doors.
Interrupt—Flashing green light
A system override to stop all tasks, so you can access the instrument. When pressed, the
light flashes until the system has reached a safe state to open the doors.

CAUTION! The Interrupt button immediately ends the experiment and should only be
used in emergencies. Before you can use the instrument normally again, the system
might need to be reinitialized from within the software by selecting Instrument >
Reset from themenu.

Software Status Tabs

Within the ScreenWorks Software, the Instrument Status-Configuration-Process tab panel,
located on the bottom of themain screen, is open automatically and reports the status of
and settings for the FLIPR Penta System hardware; and it includes the processes used to
create protocols. For more details, see Instrument Status-Configuration-Process Panel on
page 66.
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Chapter 2: System Hardware Overview

The FLIPR Penta System consists of a cabinet 39 inches (965 mm)wide x 27 inches (686 mm)
deep x 70 inches (1780 mm) high, with two compartments, accessed by manually opening
front doors, top for wet components and bottom for dry components. Outside the cabinet
are the wash system fluid bottles, optional Cell Suspension module, chiller, computer,
monitor, keyboard, and mouse.

Figure 2-1: FLIPR Penta System With Optional Modules
For system component details, see the following topics:

Five-Position Stage on page 24
Plate Support on page 25
Plate-Handling System on page 26
Liquid-Handling System on page 29
Optical System on page 35
Chiller on page 45
Observation Panel on page 45

2
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Five-Position Stage
You run your experiment from the five-position stage in the upper compartment of the
FLIPR Penta System. You can manually load plates through the upper compartment door
before an experiment or robotically during the experiment using the optional FLIPR® Cycler
internal plate handler.
The following are the five plate positions of the stage from left to right:

Position 1—Tips and Source Plate 1
Position 2—Source Plate 2
Position 3—Read Plate
Position 4—Cell Reservoir and Source Plate 3
Position 5—Tip Washer

Figure 2-2: The Five-Position Stage
Positions 1, 2, and 4 support standard, low-volume, deep-well and reservoir source addition
plates.
Position 1 is for tip loading and unloading, but this position can also be used as a source
plate position after tips load and the tip box is removed.
Position 3 opens to the optics chamber below for excitation of fluorophores in read plate
wells, the read position, and emission reading.
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Position 4 is used as a source plate position when the Cell Reservoir, included with the
optional Cell Suspension option, is not in use. A single Cell Reservoir is compatible with all of
the FLIPR Penta System pipettor heads.
Positions 1 through 4 have a mechanical plate sensor to identify the presence of plates, tips
or reservoirs.
Position 5 is used as a dedicated tip wash reservoir and should be configured to match
respective pipettor heads, such as 96, 384, or 1536. Appropriate tip wash reservoirs are
included in the purchase of a pipettor head. For more details, seeWashing Pipettor Tips and
Pin Tools on page 185.
Robotic integration enables the optional FLIPR Cycler internal plate handler to automatically
exchange in an experiment up to 12 source plates and tip racks and one read plate. See
Automating Plate Loading on page 26.
The plate indexers in Positions 1 through 4 registers plates and tip racks with well A1 in the
lower left corner. The indexers also serve as mechanical sensors to detect the presence of
plates or tips. If plates or tips are not sensed during a ManualMode experiment, but
requested by the software, the instrument stops and ends the experiment. During Remote
Mode, the system notifies the SynchroMax™ ET plate handler robot or third-party plate
handler robot that no plate or tip container is available and stops the instrument until it
detects plates or tips. It is then the responsibility of the SynchroMax ET plate handler or
third-party plate handler to deliver plates or tips to the system. See SynchroMax ET External
Plate Handler on page 28.

CAUTION! Sensors can only detect the presence of a plate or a tip container. Sensors
cannot identify the type of plates or tips, or if the lids are on the plates or not. It is
your responsibility to ensure that the correct plates and tips are loaded into position
without lids.

Note: Molecular Devices no longer sells the SynchroMax ET plate handler robot. The
FLIPR Penta System becomes a slave to whichever attached robot system is
configured.

Regulating Stage Temperature

Plate stage positions 1, 2 and 4 for source plates, have temperature control. Stage
temperature settings range from ambient 25°C (77°F) to 40°C (104°F). It can take
approximately 15minutes to reach equilibrium temperature.
Configure temperature regulation with the Temperature Control ON/OFF toggle command
in the Instrument >Manual Operationmenu or corresponding button.

Plate Support
FLIPR Penta System supports the use of 96-well, 384-well and 1536-well plates that conform
to the ANSI standards submitted by the Society for Biomolecular Sciences.

Note: Only low-profile 1536-well plates are supported.
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Black walled, clear-bottomed read plates provide an optimal imaging environment for
fluorescence assays. These plates prevent signal diffraction while allowing excitation and
signal access. Black walled, clear-bottomed plates or white walled, clear-bottomed plates can
be used for luminescence assays.
For 96-well read plates, an optional slit-shaped mask can be used to minimize saturation and
edge effects associated with these plates. Place themask over the read position. See
Consumables and Accessories on page 231 for types ofmasks available.

Note: No mask is required for 1536-well and 384-well plates.

The 96- and 384-pipettor heads can be used with source or read plates with equal or one
order higher well number. This is because the FLIPR Penta System can aspirate or dispense
into quadrants of a plate. The following combinations are possible:

The 96-pipettor head can be used with 96-well and 384-well plates.
The 384-pipettor and pin tool head can be used with 384-well and 1536-well plates.
The 1536-pipettor and pin tool head can be used only with 1536-well plates.

Deep-well plates or reservoirs can be substituted for standard well plates.
When compound is aspirated or delivered to a plate with a greater number of wells than the
pipettor head, the quadrant number (1 to 4)must be entered in the protocol configuration
in ScreenWorks Software for each dispense.
Many of the compatible source and read plates are available through Molecular Devices. See
Consumables and Accessories on page 231.
For more compatible plate details, see FLIPR Penta Plate Dimensions on page 241.

Plate-Handling System
The plate handling system includes the following methods for placing plates on the
five-position stage to run your experiments:

Loading Plates Manually on page 26
Automating Plate Loading on page 26

Loading Plates Manually

In ManualMode, before running an experiment, position all of the assay components in the
five-position stage by hand in the upper compartment. No additional plate or tip changes
can bemade after the experiment starts.

Note: Keep the top compartment door closed during normal system operation. All
system functions stop when the door is open.

Automating Plate Loading

Note: Molecular Devices no longer offers the SynchroMax ET external plate handler
robot. The following information is for reference only.
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Support for automated plate delivery with the FLIPR Penta System is facilitated using
optional robot systems.
To increase the number of plates you can use in an experiment, and minimize personnel
requirements, use the optional FLIPR Cycler internal plate handler coupled with the optional
external SynchroMax ET plate loader robot or a third-party plate loader robot, for example,
stacker system or robotic arm. One read and up to 12 source plates and tip racks can be
shuttled in and out of the FLIPR Penta System in one experiment using automated delivery.
When using automated delivery the SynchroMax ET plate loader or third-party plate loader
delivers plates to, and picks them up from, the landing pad on the outside left of the
instrument, from where the FLIPR Cycler plate handler shuttles them in and out of the plate
stage compartment. The shuttle door over the landing pad opens and closes to maintain a
light-tight environment within the compartment.
During automated operation the SynchroMax ET plate loader or third-party plate loader
controls the FLIPR Penta System by sending instructions to load protocols, run experiments,
and retrieve plates from the landing pad. These commands are executed immediately upon
receipt by the instrument. Persisting instrument settings cannot bemade from the remote
controlling program—thesemust be configured in ScreenWorks Software before control is
passed to the plate-delivery system.
To start RemoteMode:

To pass control to the plate-delivery software, in ScreenWorks Software, select
Instrument > Set Remote Mode.

To stop RemoteMode:
The FLIPR Penta System stays in remote control until you select Instrument > Set
Manual Mode.

The third-party plate loader software communicates with the FLIPR Penta System computer
through the serial communication port using TCP/IP. SynchroMax ET software is installed
with ScreenWorks Software on the FLIPR Penta System computer so it is able to
communicate directly with the instrument. See Robotic Integration on page 261 for remote
control syntax.

FLIPR Cycler Internal Plate Handler

The optional FLIPR Cycler plate handler system is a plate gripper that runs along the back
wall of the upper read compartment, giving it access to Positions 1 through 4 in the
five-position stage and the landing pad on the outer left-side of the cabinet.
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The FLIPR Cycler plate handler shifts source plates and tip containers between these
locations when under the control of the external SynchroMax ET plate holder robot or a
third-party plate handler.
The FLIPR Cycler plate handler carries standard, low volume and deep well 96-well, 384-well
and 1536-well plates that conform to proposed ANSI standards submitted by the Society for
Biomolecular Sciences. In addition, the FLIPR Cycler plate handler can moveMolecular
Devices qualified tips.

Note: Reservoirs can be used during robotic integration, however the FLIPR Cycler
plate handler is not able to move reservoir. All reservoirs must be loaded manually
before running an experiment, including the Cell Reservoir.

CAUTION! While the system is compatible with plates that conform to proposed ANSI
standards submitted by the Society for Biomolecular Sciences, some plates may not
be handled as reliably by the FLIPR Cycler plate handler because of their low plate
weight.

During robotic integration, Molecular Devices recommends evaluating plates and tips
handling by the FLIPR Cycler plate handler for handling reliability before starting a
screen. The FLIPR Penta System is only validated for use with theMolecular Devices
tips. We are not able to guarantee performance or troubleshoot any instrument
issues with any other tips.

The upper and lower door of the FLIPR Penta System must remain closed for the duration of
the experiment. Plates are transported in and out of the instrument only through the FLIPR
Cycler plate handler robotic landing pad door.

WARNING! Do not place your fingers in the FLIPR Cycler shuttle door as this can
cause injury.

SynchroMax ET External Plate Handler

Note: The SynchroMax ET plate handler robot is no longer an available option for new
purchases. Other robotic systems are still supported.
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The SynchroMax ET robot is a six-stack plate handler that use to be available as an optional
purchase with the FLIPR Penta System. It delivers plates to and from the landing pad,
integrating with the FLIPR Cycler internal plate handler, which ferries the plates to and from
their appropriate locations in the five-position stage. The configuration interface of the
SynchroMax ET software is opened directly from within ScreenWorks Software.

Liquid-Handling System
The liquid-handling system includes all the following components involved in moving liquids
to and from the five-position stage:

Standard Pipettor Head
Pin Tool Head on page 30
Pipettor Tip and Pin ToolWasher on page 31
Cell Suspension on page 32

Standard Pipettor Head

Standard pipettor heads are available in 1536-tip, 384-tip and 96-tip formats.
The 384-pipettor head and 96-pipettor head both use disposable plastic tips. In contrast, the
1536-pipettor head uses a stainless steel tip block with a disposable 1536-tip gasket.
You can wash the plastic tips, replace them between each compound addition, or at the end
of an experiment. The 1536-tip block is washed at specified times.
Pipettor operations are controlled from within ScreenWorks Software protocols, or some
operations, for example, loading tips can be done individually directly through commands in
the Instrument menu. Connectors on the back of the pipettor head identify the head format
as 1536-tips, 384-tips, or 96-tips, so ScreenWorks Software only offers valid plate formats and
pipetting parameters for protocol setup.
The standard pipettor head uses air displacement to control aspiration and dispense speed
and volume. Configure the volume of compound to be transferred in the software. You can
also configure drawing compound from multiple source plates to dispense into one
destination plate or to aspirate from one plate and dispense to multiple well plates or
quadrants.
The instrument also has 384-pin and 1536-pin pipettor heads available with pin tool and
specific aspirating, dispensing, and wash protocols. These protocols activate only when the
appropriate head is installed.

Wells Pipettor Head Range Pipetting Increments Precision

96 5–200 μL 1 μL 3% CV @ 75 μL

384 1–25 μL 0.5 μL 4% CV @ 25 μL

1536 0.5–3 μL 0.1 μL 6% CV @ 3 μL

Table 2-1: FLIPR Penta Fluidics Specifications

The 96-pipettor head and 384-pipettor head displace air in the disposable pipette tips.
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In the 1536-pipettor head, a plunger for each of the 1536 tips presses against an elastic
gasket seated on the tip block. When the plungers move down, they create an initial seal
between the gasket and tip-block. After creating the seal, further plunger movement causes
air displacement in the tip-block.

Figure 2-3: Seal creation in the 1536-pipettor head

CAUTION! Performance depends on tip-block and gasket seating and can be
compromised if the seal breaks.

Use only Molecular Devices recommended tip-blocks and gaskets to ensure the highest
accuracy and to reduce the possibility of damaging the pipettor and tips. For
recommendations, see Consumables and Accessories on page 231.

Pin Tool Head

Pin tools are blocks of solid or slotted pins, where the pins replace the hollow tips used with
a standard pipettor. The pins use capillary action to pick up and transfer liquid from one
plate to another. Their ability to accurately and reliably transfer compounds in nanoliter
volumes allows you to supply test compounds in 100%DMSO solution, removing the need
to prepare intermediate dilution plates.
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The volume that each pin picks up is determined by the size of the pin (and, if slotted, the
size of the slot) and the withdrawal speed of the pin from the liquid—a faster removal speed
leaves more liquid on the pin.
Pins for the 384 pin tool are supplied in four sizes, giving a total range (across all these sizes)
from 84 nL to 656 nL. The 1536 pin tool has seven different pin sizes, giving a total range from
19 nL to 117 nL.
Each pin size has a specified volume range that it carries:

The lowest reported volume is for a tip removal speed of 7.8mm/s.
The highest reported volume is for a tip removal speed of 57.0mm/s.

You specify the precise pick up volumes and tip removal speeds during your assay
development.
The FLIPR Penta System can be fitted with 384- or 1536-pin tool heads. Pin tools themselves,
in the appropriate 384 or 1536 format, can be easily and rapidly replaced to change the pin
size. See Exchanging Pin Tools on page 195.
All the pin tools used with the FLIPR Penta System are available with a hydrophobic and
lipophobic coating to prevent or reduce the nonspecific binding of proteins and lipids to the
pins.
In order to ensure uniform compound pick-up across the entire pin tool, pins can be
configured to ‘float’ in source plate wells. Individual pins are not rigidly attached to the pin
block, having a small amount of vertical movement up into the block. When set to float, the
pin head moves down very low so that all pins sit on the bottom of the well and push up a
little into the block. This ensures that all pins are equally immersed in their wells, for
example, sitting on the bottom. This outcome could not be guaranteed if the pins were
rigidly fixed to the block, given that plate bottoms are often not completely flat.

Pipettor Tip and Pin Tool Washer

The washer consists of a reservoir top of the selected pipettor format, mounted over a wash
basin. The wash basin is connected to two solvent-supply carboys and two waste carboys
located on the floor beneath the computer monitor. A basin beneath the tip washer base
drains to a waste carboy, to safely remove any solvent that overflows from the reservoir.
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Wash solution fills the reservoir for a calibrated amount of time. Solvent is then drained from
the reservoir after each wash cycle. Up to five wash cycles can be configured within a single
Wash Tips process in your experiment protocol. SeeWash Cell Reservoir Process on page
124, and Creating New Protocols on page 124.
For pipettor tips, set volume of solvent is drawn up, optionally held for a time, and then
expelled, up to 20 times.
For pins, vertical motion of the tip block is used to agitate the wash solvent around the pins.
The option is available to wash tips or pins in up to two solutions before reusing the tip
washer. When additional wash solutions are required, pipettor tips or pins can be washed in
a boat or reservoir, located in one of the source plate positions and using a protocolMix
Fluid process configuration. SeeMix Fluid Process on page 113.

WARNING! High volumes of volatile, flammable solvents in the reading
chamber can cause explosive conditions. Use of 100% isopropanol, etc., in the tip
washer is particularly discouraged without additional ventilation. Consult your
facilities expert to determine the appropriate ventilation to avoid explosive
conditions.

Pin tools are supplied with blotting stations that can be loaded into one of the plate
positions on the stage, such as Position 4 (Source 3).
Blot pin steps can be configured in the protocol to remove fluid from the pins, for example,
following pin washing.

Note: Awaste bottle sensor override (P/N 0700-0827) is available in the
FLIPR Penta System accessory kit to bypass the waste sensor and dispose waste in
containers other than the dedicated waste carboys.

To exchange the wash reservoir top, see Exchanging Pipettor Tips and Pin ToolWash
Reservoir Top on page 191.

Cell Suspension

The Cell Suspension module is optional. The first installation of the cell reservoir is done by a
Molecular Devices certified field service engineer.
The Cell Suspension module consists of two components:

The Cell Suspension module (Figure 2-4) located externally on the right–side of the
instrument.
The Cell Reservoir (Figure 2-6) installs in Position 4 (Source 3) in the 5–position stage. See
Five-Position Stage on page 24.

The Cell Suspension module (Figure 2-4) consists of a shelf with a magnetic motor mounted
underneath it, a cell flask with a magnetic stirrer, up to four fluid bottles for automated
cleaning, and a removable cover for keeping cells in a dark environment.
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Figure 2-4: External Cell Suspension Module
The spinner flask contains a stirrer, which is driven by a magnetically coupled motor
mounted in the lower part of the Cell Suspension module. The Cell Suspension stir speed can
be set in a protocol or with manual instrument controls. Stir speed of 5 equals approximately
1 revolution per second. From the uniform suspension in the spinner flask cells are pumped
into the Cell Reservoir, where the pipettor head in 96, 384, or 1536 format removes the
appropriate amount and cells are automatically pumped to a specified destination. A
protocol in ScreenWorks Software controls the stir speed and source/destination of cell
suspension activity.
The cell valve selects the source for filling, or the destination for draining. There are 8 valve
positions: flask fill for filling the reservoir, flask drain for draining the reservoir without
causing air bubbles, Waste Bottle A, Waste Bottle B, and Fluid 1 to Fluid 4.
Fluid 1 to Fluid 4 are user specifiable, and can be cleaning solutions, water or buffer. You can
choose to pump cells back into the cell flask or to any other fluid bottles. Bottles for Fluid 1
and Fluid 2 are automatically included with the Cell Suspension option.
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Figure 2-5 demonstrates how the system is connected and shows all the possible
combinations for protocol development.

Figure 2-5: Cell Suspension Module Connections
The Cell Reservoir is a special plate type that has one fluid line used for both input and
output, and an electronic plate ID that is part of the electrical/fluidic connector, which
identifies the reservoir. In the case of an overflow, an overflow trough catches excess fluid
and pipes it to the tip washer overflow trough, which directs it to the overflow bottle.

Figure 2-6: Cell Reservoir
When in use, the Cell Reservoir is filled from any of the bottles in the external Cell Suspension
module by a pump with adjustable speed and direction.
Wash the Cell Reservoir by either adding theWash Reservoir process to the protocol (see
Creating New Protocols on page 124), selectingWash Reservoir in the Instrument > Manual
Operationmenu, or manually removing the reservoir and autoclaving it.
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Optical System
The FLIPR Penta System optics are housed in the bottom compartment of themain cabinet.
In fluorescence assays, where excitation is required, light from light-emitting diodes (LEDs) is
directed at the base of the read plate exposed in position 3 in the 5-position stage above.
Light emitted from the plate travels down through emission filters before being captured in
the CCD camera.

Figure 2-7: System Optics

CCD Camera Options

Three camera options are available for purchase with the FLIPR Penta System:
EMCCD (Electron Multiplying CCD)—camera for fluorescence only experiments
HS EMCCD (High-Speed, High-Sensitivity Electron Multiplying CCD)—camera for both
high-speed, high-sensitivity, fluorescence, and luminescence assays
ICCD (Intensified CCD)—camera for both fluorescence and luminescence assays
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EMCCD Camera

The camera is located directly beneath the read plate on the five-position stage. The camera
is thermoelectrically cooled and requires about fiveminutes to reach its operating
temperature of -70°C (-94°F) ± 2°C.

CAUTION! The instrument does not let you use the camera before it has reached
proper operating temperature. Check the camera temperature on the Instrument
Status panel before starting an experiment.

The camera uses frame-transfer technology that shifts pixel values from the exposed portion
of the chip to the data processing portion. This method allows a high acquisition rate and
eliminates the possibility of camera shutter failure.
The camera is an integrating-type detector using temporal integration to build up the
signal-to-noise ratio. Depending on the intensity of the emitted light (reliant on dye efficiency
and LED power), it may be necessary to vary camera exposures. This prevents themeasured
fluorescence signal from being dominated by detector noise.
Images are taken of the bottom of the entire plate for a time specified in the ScreenWorks
Software protocol; exposure time can be set from 0.05 to 30 seconds. In ratiometric
experiments for example, where two or more wavelengths aremeasured, the number of
images captured increases so that an image is taken for each wavelength at the specified
rate. From each image a relative light value is calculated for each well. The
FLIPR Penta System reports relative fluorescence units (RFUs) in a range from zero to
approximately 12,000.
The light intensity detected by each pixel on the CCD chip can be amplified using the Gain
setting in ScreenWorks Software (Settings Process). This parameter has a range from one to
240. Amplification is exponential, with increments increasing as you go higher up the range.
Fluorescence assays typically use a gain of 80whereas luminescence assays should use 200
as a starting point. Gain optimization should be done during assay development to
determine optimal conditions for your screen.
When a luminescence experiment follows a fluorescence experiment we recommend that
you cycle the camera temperature to eliminate ghost images that may have been created
during the fluorescence assay. Select Cycle Camera Temperature from the Instrument >
Manual Operationmenu to choose this option. The camera warms up to room temperature
to release ghost images, before cooling back down to approximately -70°C (-94°F).

Note: Luminescence readings are available with the EMCCD camera option, however
camera sensitivity is not optimal for this type of experiment.
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HS EMCCD Camera

The camera is located directly beneath the read plate on the five-position stage. The camera
is thermoelectrically cooled and requires about fiveminutes to reach its operating
temperature range between -70°C (-94°F) ± 2°C.

CAUTION! The instrument does not let you use the camera before it has reached
proper operating temperature. Check the camera temperature on the Instrument
Status panel before starting an experiment.

The camera uses frame-transfer technology that shifts pixel values from the exposed portion
of the chip to the data processing portion. This method allows a high acquisition rate.
The camera is an integrating-type detector using temporal integration to build up the
signal-to-noise ratio. Depending on the intensity of the emitted light, which is reliant on dye
efficiency and LED power, it might be necessary to use shorter or longer camera exposures.
This prevents themeasured fluorescence signal from being dominated by detector noise.
Images are taken of the bottom of the entire plate for a time specified in the ScreenWorks
Software protocol. There are a variety of exposure settings available depending on themode
in which the camera is run. In ratiometric experiments for example, where two or more
wavelengths aremeasured, the number of images captured increases so that an image is
taken for each wavelength at the specified rate. From each image a relative light value is
calculated for each well. The FLIPR Penta System reports relative fluorescence units (RFU) in a
range from zero to approximately 64,000 RFU.
The light intensity detected by each pixel on the CCD chip can be amplified using theGain
setting in ScreenWorks Software (Settings Process). This parameter for the Fluorescence
Reading Mode has a range from 1.5 to 128. In the Camera Mode > Normal, Fluorescence
assays typically use a gain of 8 for bright calcium assays depending on the exposure time and
LED Power. This needs to be optimized for each different assay. Luminescence assays should
use a gain of 1.5 to 500 as a starting point. Run gain optimization tests during assay
development to determine optimal conditions for your screen.

Tip: When using the Camera Mode > HighSpeed, for optimal performance, use a
Camera Gain of 20 or higher and adjust the Exposure Time and Excitation Intensity for
your experiment.

When a luminescence experiment follows a fluorescence experiment, cycle the camera
temperature to eliminate ghost images that can be created during the fluorescence assay.
Select Instrument >Manual Operation > Cycle Camera Temperature to choose this option.
The camera warms up to room temperature to release ghost images, before cooling back
down to approximately -70°C (-94°F).
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When using the HighSpeed camera mode or the Sensitivity camera mode, the camera
behaves differently than in the Normal camera mode. The HighSpeed and the Sensitivity
camera mode use 2x2 pixel binning in the camera, which combines 4 pixels into one. This is
done to both increase sensitivity to smaller signals, as well as for speed. The effect of
overexposure in the camera sensor when using this binning mode is different than for a
non-binned exposure, due to the design of the sensor. For more details see Determining
Protocol Saturation Levels for the HS EMCCD Camera on page 139.

Stabilizing the HS EMCCD Camera
When you use the HS EMCCD camera, the optional stabilization process can be run before
your experiment starts to avoid camera signal drift.
The Stabilizing camera process takes 50 seconds to complete.

Tip: You might be prompted to run camera stabilization, but if it is not important for
your protocol, you can skip it and run your experiment immediately.

If your biology is time-sensitive you can ready the instrument before running your
experiment by selecting Instrument >Manual Operation > Pre-Stabilize.
If your biology is not time-sensitive, within your protocol settings, you can select Auto
Stabilize to start before your experiment begins. See Edit Read Mode on page 73.

Note: When Auto Stabilize is saved as part of your protocol, if the camera is not
already stabilized and your protocol has multiple reads, Auto Stabilize only runs the
first time.

Your instrument maintains the camera stability for a limited time. Look in the Instrument
Status tab to view the stabilization timer countdown. As long as your protocol is unchanged,
and the instrument door is closed, camera stability is sustained for two hours between
experiment runs. The two hour expiration countdown restarts after every experiment run.
When you open the instrument door, you have up to 15minutes with the instrument door
open before you have to run the camera stabilization process again. Within the 15minute
time limit, after you close the door, the timer returns to the two hour expiration countdown.

Understanding HS EMCCD Camera Protocol Saturation
When setting up a protocol, the read exposure settings must be set to avoid oversaturation
on the HS EMCCD camera sensor. If well signals hit saturation, then they cannot be
quantitatively compared. The camera provides a saturation warning when 5% ofwell values
on the plate exceed 90% of the camera sensor dynamic range. So you want to keep your
maximum signals below this level. Typically, the HS EMCCD camera threshold is about 45000
counts; but it can vary a few thousand counts between cameras. Use the Protocol Signal Test
dialog to determine your camera saturation level and to adjust your exposure accordingly
for your biology.
As the exposure increases past the saturation threshold, you get a saturation warning, and
the raw image in the Protocol Signal Test dialog shows the wells becoming bright white, as
before with Normal camera mode. See Figure 2-8 and Figure 2-9.
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Figure 2-8: HighSpeed Mode Signal Test Saturation With Warning

Figure 2-9: Image Display of HighSpeed Mode Signal Test Saturation
For a short range of over exposure the saturation warning works; but as the exposure
increases further, the brightest pixel values start to get darker in the center of the well areas,
as shown in Figure 2-10.
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Figure 2-10: Image Display of HighSpeed Mode Signal Test Saturation Reversing
As the brightest pixels get darker, the pixel values drop lower, instead of staying at the
maximum saturation value. This reversal effect happens when the binned image pixels are
overexposed. The overall average for the image decreases, and after about a 4x
overexposure increase, no saturation warning appears. As the exposure increases further,
the wells start to bloom and flood across the image as before, except that the center of the
streaks are darker, and no saturation warning appears, as shown in Figure 2-11.

Figure 2-11: Image Display of HighSpeed Mode Signal Test Blooming Without Saturation
Warning
This is a problem for detecting when the imagemeasurements are saturated, and the system
cannot give a reliable saturation warning for grossly overexposed well signals when using
HighSpeed camera mode.
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For adjusting the exposures for your specific biology, see Determining Protocol Saturation
Levels for the HS EMCCD Camera on page 139.

ICCD Camera

The camera is mounted directly beneath the read plate on the five-position stage, but at a
slightly different height than the EMCCD cameras. This camera is thermoelectrically cooled
and requires about fiveminutes to reach its operating temperature range between -20°C 
(-4°F) ± 5°C.

CAUTION! The instrument does not let you use the camera before it has reached
proper operating temperature. Check the camera temperature on the Instrument
Status panel before starting an experiment.

Similar to the Standard EMCCD camera, the camera also uses frame-transfer technology that
shifts pixel values from the exposed portion of the chip to the data processing portion. In the
ICCD camera, the signal is amplified in the intensifier before reaching the CCD chip. Using this
method there is less noise and therefore the camera is significantly more sensitive than the
Standard EMCCD camera.
When using the ICCD camera, images are taken of the bottom of the plate, amplified in the
intensifier, and transferred through a fiber optic taper to the CCD chip. The Gain control of
the intensifier allows for a bright signal from fluorescence as well as a dim signal from
luminescence to be enhanced accordingly, so as to provide the best signal and not saturate
the CCD chip below. In Fluorescencemode the Gain is preset to 2000, whereas in
Luminescencemode, the Gain defaults to 280,000, but can be lowered if the luminescence
assay is very bright.
This camera has a Gate Open % feature, adjustable in Fluorescencemode only. This feature
controls how long the intensifier is on for each of the frames collected during the exposure
time. This controls the signal intensity of the assay.
The recommended value range for the ICCD camera is 40,000 to 50,000 (at maximum signal).
This camera does not require temperature cycling when changing between Fluorescence and
Aequorin modes.

All Cameras

When calculated, relative luminescence units (RLU) and relative fluorescence units (RFU) are
displayed in real time in the ScreenWorks Software Analysis process window (within the
limits of computer processing speed). Data for one wavelength (for example, Readmode), for
all 1536-wells, 384-wells or 96-wells of the read plate, display in theMulti-Well Graph on the
right side of this view. TheDetail Graph can be populated by selecting wells in theMulti-well
graph. When an experiment is completed, post-assay analysis can be done via ScreenWorks
Software, or data can be exported.
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In normal operation images are discarded after relative luminescence units (RLU) and relative
fluorescence units (RFU) values aremeasured. However, for quality control purposes, users
can define the number of images per Read with Transfer Fluid step. Up to 100 images per
experiment can be retained. These images can be useful for troubleshooting problems, such
as cells lifting from well bottoms during compound addition. Images are saved as *.tif files
with the same name and to the same directory as the data file. They can be viewed by
clicking the Image button in the Analysis process page when the resulting data file is open in
ScreenWorks Software.

Note: The robustness of an assay is not dependent on the size of the signal. It is
better determined by the signal-to-noise ratio. A commonly used calculation for
determining assay robustness is the Z’ factor equation.

LED Modules

Figure 2-12: LED Configuration
The FLIPR Penta System has a total of four LED banks providing illumination for plate
reading. The LED banks pulse on, two at a time, only when an image is to be captured,
protecting cells from possible dye photo-bleaching.
The LED banks are divided between two modules, one on either side of the read plate
position above. LED banks in corresponding positions in either module are paired. The
paired LED banks pulse simultaneously during an experiment, so that light strikes the read
plate base from two directions, helping to ensure that the entire plate is maximally
illuminated.
Typically, the two LED bank pairs are set up with LEDs of different wavelengths, for example,
one pair might have LEDs of range 470 nm to 495 nm, while the other pair might be 510 nm
to 545 nm. Ratiometric experiments can be set up to use both of these wavelengths, in which
case the paired banks fire alternately.

Note: Despite the two excitation wavelengths firing alternately, output data files show
time points for each as occurring simultaneously.
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Deflectors around the LED banks direct all light from the LEDs through excitation bandpass
filters that further refine the wavelength. The light is then funneled into light pipes that focus
it onto the base of the read plate.
The FLIPR Penta System does not operate without the full complement of LED banks
installed, however blank LED banks can be used for one pair if only one excitation
wavelength is available. You can change the LED banks, if needed. See Exchanging LED
Modules on page 198.
Unless you buy additional LED banks, your FLIPR Penta System includes one set of default
calcium LED banks (470 nm–495 nm) and one set of blank LED banks.
Use the ScreenWorks Software Protocol builder Settings screen to configure the LEDs for
your experiment. See Setup Read Mode on page 73.
No LED warmup time is required before running an experiment. Start time is only dependent
on the time it takes for the camera to cool down and for the stage to heat up, if the option is
used.
The LEDs are air-cooled by fans, however the light output varies slightly as they heat up. To
help with the heat transfer, a piece of foam in inserted in the back of the LED bank on each
side. Also to counteract the temperature change, a temporal correction is automatically
applied to the LED feedback circuit to normalize the system.
Flat field calibration is automatically applied to the read plate to adjust for non-uniformity of
illumination across the plate. To manually calibrate the system, see Calibrating Optics on
page 131.

WARNING! Do not look into LED banks when turned on, especially at intensities
over 30% or in the UV spectrum, unless you are viewing them through the
observation panel. If light is seen escaping the instrument when the LED modules
are turned on, shut down immediately and call Molecular Devices Technical
Support.

Emission Filters

A three-position filter slider holding up to three 60mm diameter interference filters is located
in front of the CCD camera. The slider can be alternated in front of the camera to separate
out the emission band of the dye being used. These filters can be used with a single
excitation wavelength or can be paired up with additional emission filters and LEDs in a
ratiometric experiment, for example, as excitation LEDs alternate between two different
wavelengths, filters change at the same time so that each image taken by the camera
matches the right emission filter with the excitation LED bank. Themost common
FLIPR Penta System configuration is a LED excitation wavelength of 470–495 nm with a
515–575 nm bandpass emission filter. For luminescence experiments it is also possible to run
without the filter.
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Emission LEDs and emission filters are user-changeable in approximately 5minutes. See
Exchanging Filters on page 201. When installed, filters aremechanically sensed and the filter
configuration can be viewed in the ScreenWorks Software, in the Instrument Configuration
panel. If they are used in an experiment, the instrument prompts you to calibrate a new
emission filter to correspond to an LED module.

Note: If the needed filter is not available, a custom filter cassette (P/N 5018841) is
available for purchase for use with filters created by an outside vendor. When
installed, these filters appear in ScreenWorks Software as Custom 1, Custom 2 and
Custom 3.

Fluorescence Mode

In fluorescencemode the system LEDs illuminate the bottom of a 1536-well, 384-well, or
96-well ‘read’ plate containing cells loaded with fluorescent dye, and measure the
fluorescence in each well. By taking a sequence ofmeasurements in conjunction with
compound application, changes in fluorescence emission characteristics due to the change in
ion concentration, for example, Ca2+, TI+, or Membrane Potential.
Light-emitting diodes (LEDs) in the FLIPR Penta System produce light at distinct wavelength
ranges to excite the fluorescent dye that has been added to the cells in the read plate wells.
The entire well plate bottom is illuminated. Fluorescent light emitted by the dye—again, for
the entire plate—passes through an emission filter before being captured in a CCD camera,
high-speed, high-sensitivity HS EMCCD, EMCCD or ICCD. Fluorescence is measured from
each well independently, and converted into a numerical value. The FLIPR Penta System can
be configured with two LED banks and three emission filters, allowing the software
configuration of up to four excitation/emission wavelength combinations (‘read modes’). Up
to four different fluorescence effects can bemeasured within a single experiment.

Luminescence Mode

The FLIPR Penta System also provides luminescencemodewith the HS EMCCD camera
option and the ICCD camera option. The instrument has a light-tight enclosure to operate in
luminescencemode. A specialized high-sensitivity HS EMCCD camera can be installed in place
of the standard EMCCD camera to detect signal at both high-speed fluorescence or Aequorin
(Luminescence)mode. The camera is mounted directly beneath the read plate, so images are
taken of the entire bottom of the plate. For cell suspension experiments, an integrated Cell
Reservoir allows uniform cell suspension to be pipetted directly into the read plate. From the
3 filter positions available on FLIPR Penta System, it is recommended to have one open
position, so no filter is used during the luminescence assay.
As with fluorescence, luminescence is measured from each well independently, and
converted into a numerical value.
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Chiller
The chiller sits outside of the FLIPR Penta instrument and is connected with a cable and
tubing. It uses a special provided cooling liquid, and the instrument embedded computer
and firmware control it.

Figure 2-13: The Chiller
Because the FLIPR Penta System is a light-tight instrument, there is very limited airflow inside
the instrument enclosure. The external chiller provides the operating environment
requirement for all of the available camera options.

Observation Panel
Use the observation panel while testing or troubleshooting the FLIPR Penta System to view
hardwaremovements in the upper top compartment.
Under normal operating conditions, the upper door must be closed to run an experiment,
and keep light out of the chamber. When the observation panel is mounted onto the
chamber, the door can be left open, allowing you to viewmovements of the pipettor and
FLIPR Cycler plate handler. Normal instrument control comes from the ScreenWorks
Software. In Remotemode SynchroMax ET plate handling, or third-party plate handling
software controls the instrument.
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To mount the panel, remove it from the door and attach it with the four captive
thumbscrews to the top compartment frame.

When not in use, the observation panel attaches to the inside of the upper door.

To acquire quality data, re-attach the observation panel to the inner door before running an
experiment.

CAUTION! If pretending to run in luminescencemodewith the ICCD camera, DO NOT
touch the white door switches. Room light damages the Intensifier. The door switches
detect the open door to protect the camera.

Only use the observation panel to view internal pipettor movement or FLIPR Cycler
movement.

CAUTION! Do not use it during experiments when data is being acquired.
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Chapter 3: ScreenWorks Software Overview

This chapter provides an overview of the ScreenWorks Software functionality, including the
following topics:

OnlineMode vs. OfflineMode
User Interface Overview on page 48
Menu Bar on page 50
Experiment Window on page 65

Online Mode vs. Offline Mode
The software has two startup modes:

Online—the software is connected to the instrument.

Offline—the software is disconnected from the instrument.

The default start-up mode is determined during software installation in theOnline/Offline
dialog. Regardless of the startup mode, pipettor head and tip washer typemust always
match.

Note: To be able to select either modewhile generating protocols, you must install
the software in Offlinemode.

When the software is open, you can switch modes by selecting from the Instrumentmenu,
Go Online or Go Offline.

Note: Switching modes after the software is opened does not change the software
startup mode chosen at the time of installation. To change the default startup mode,
the ScreenWorks Softwaremust be reinstalled.

Online Mode

When started in Onlinemode, ScreenWorks Software checks for instrument connections. If
no connections are sensed, you are notified. You can then either check the connections and
attempt to connect again, or choose to run the software in Offlinemode.
Create new protocols in Onlinemode.
When ScreenWorks Software starts in Onlinemode and connects to the instrument, the
default installation configuration file is overwritten using the current instrument settings and
plate library information.
If you are working in Onlinemode and then switch to Offlinemode, the instrument setup
configuration is remembered as the last setting.

3
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Offline Mode

When ScreenWorks Software starts and no instrument connection registers, you are notified
and can then either check the connections and attempt to connect again in Onlinemode, or
choose to run the software in Offlinemode.
When ScreenWorks Software starts in Offlinemode, you can configure the following
hardware options:

Camera Type
Pipettor Format

Protocols created in Offlinemodewith hardware settings that do not match current
hardware settings are flagged. You must change the hardware settings to match those in the
protocol in order to run it.

User Interface Overview
The ScreenWorks Softwaremain screen includes menu and toolbar across the top, and a
status bar at the bottom. Themain working area in themiddle has two sections:

Experiment window—the central proportion of themain window, for protocol
configuration, data viewing and analysis.
Instrument Status-Configuration-Process panel—at the bottom of themain work area,
for displaying instrument information and creating protocols. This panel contains the
Instrument Status tab, Instrument Config tab, and the Process tab.

Item Description

1 Menu Bar

Table 3-1: Main Window Layout



Chapter 3: ScreenWorks Software Overview

5069582 B 49

Item Description

2 Toolbar

3 ExperimentWindow

4 Instrument Status-Configuration-Process Panel

5 Status Bar

Table 3-1: Main Window Layout (continued)
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Menu Bar

Themenu bar contains the following six sub-menus that group together related functions:
FileMenu
ViewMenu on page 52
Instrument Menu on page 53
Tools Menu on page 58
WindowMenu on page 62
Help Menu on page 62

Tip: Somemenu options can be opened with a keyboard shortcut using the ALT key to
underline the letter in each menu title that is used to open themenu; for example,
when you click ALT the I in the Instrumentmenu is underlined. Click the I key and the
Instrumentmenu opens.

File Menu

The Filemenu enables you to select the following options:

Option Description Keyboard
Shortcut

New Opens a new protocol (*.fmp) in the Experiment window, with
default settings for one read with fluid transfer.
New protocols are named Untitled[n], where n is a number.

Ctrl+N

Open Opens an Open File dialog to open a saved Protocol (*.fmp), Data
(*.fmd) or Image (*.png) file, as selected in the submenu. By
default, the dialog opens in the folder set in Tools > Set Default
Directories.

Note: Only data files created with ScreenWorks Software can be
opened in ScreenWorks Software. Data files from previous
FLIPR Tetra Systems (versions 1.X through 2.X) cannot be opened.

Ctrl+O
Ctrl+Shift+O

Close Closes the currently active protocol or data file displayed in the
Experiment window. If modifications have been made to the file,
you are prompted to save the modifications.

Alt+F,C

Save Saves the currently active protocol or data file, displayed in
foreground of the Experiment window. Also saves If the displayed
file is a default protocol that is untitled, the Save As dialog appears
so that you can name the file.

Crtl+S

Table 3-2: File Menu Options
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Option Description Keyboard
Shortcut

Save As Opens the Save As dialog and allows you to save a protocol or data
file under a new name or format (for example, save a data file as a
protocol). Also allows you to save a protocol or data file as an
earlier version of the ScreenWorks Software. When changing
formats, select the file type from the Save as type drop-down list.

Alt+F,S

Save All Files Saves all of the opened protocol and data files. If the default
protocol file was opened, the Save As dialog is displayed so that
you can name the files.

Close All Files Closes all of the opened protocol and data files. If any of the files
had changes since they were opened or the default protocol file
was opened, the Save or Save As dialog is displayed so that you
can name the files.

Export Opens the Export File or Batch Export dialog, as selected in the
submenu, to manually export data from the open data file, or
other data files on disk; see Exporting Data on page 157.

Page Setup Opens the Page Setup dialog to configure the printer and print
settings for the document.

Alt+F,G

Print Preview
Report

Displays how the document looks before printing. Alt+F,V

Print Report The Print Report dialog allows you to select the graphs or reports
to print from the current data file. Having made the selection you
can open Print Preview Report to check before printing, or open
the Print dialog to print.

Crtl+P

1–6 Data Files Lists the six most recently opened data files, with the most
recently opened at the top.

7–10 Protocol
Files

Lists the four most recently opened protocol files, with the most
recently opened at the top.

Exit Closes ScreenWorks Software. If you have unsaved data, you are
prompted to save it before closing.

Alt+F,X

Table 3-2: File Menu Options (continued)

Saving Data Files as Protocol Files
When the active file is a protocol file, you can add, remove, or change processes in the file,
then save the amended protocol and run it. Protocol information stored in data files cannot
be edited, nor used to run a new experiment, however it is possible to extract this
information to a new protocol file. Experiments run using this file have exactly the same
steps as the steps used to create the data file.
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To store a data file as a protocol file, select Save As, assign a protocol name, select *.fmp as
File Type and click Save. The stored file is stripped of all data and only associated protocol
information is stored in the protocol file.

Note: Saved changes only affect the protocol. The data file from which the protocol
was derived remains intact.

View Menu

The Viewmenu options enable you to select the following options:
The keyboard shortcut is ALT+V.

Option Description

Experiment Setup Displays the Experiment Setup view of a protocol or data file, showing
processes and associated dialogs in the Experiment window.

Experiment Summary Displays in the Experiment window the Experiment Summary for the
current protocol or data file in the Experiment window.

To return to the Experiment Setupview, select View > Experiment
Setup.

Save Layout Saves the proportions displayed in the Experiment window (including
Multi-Well and Detail Graphs as well as Group Statisticswindow) and
Instrument Status panel to one of four layouts. These layouts can be
toggled between when the appropriate Restore Layout selection is
made.

Restore Layout Restores the screen layout to one of four proportions saved in the
Saved Layout selection.

Instrument Status Toggles the Instrument Status panel in and out of view. See
Instrument Status Tab on page 67.

Toolbar Toggles the Toolbar in and out of view. See Toolbar on page 62.

Status Bar Toggles the Status Bar at the bottom of the main window in and out of
view. See Status Bar on page 71.

Table 3-3: View Menu Options
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Instrument Menu

The Instrumentmenu commands enable you to access instrument communication and
manual dialogs.

Options Description

Go Online/Offline Switches the instrument between Online mode and Offline mode. See
Online Mode vs. Offline Mode on page 47.
Go Online—Displays when ScreenWorks Software is offline. Click to
connect the software to the instrument, giving ScreenWorks Software
control of the instrument.
Go Offline—Displays when ScreenWorks Software is connected to the
instrument. Click to disconnect the software from the instrument.

Run Experiment Instructs ScreenWorks Software to start an experiment using the
uppermost protocol file in the experiment.

Stop Experiment Instructs ScreenWorks Software to stop the experiment.
Note: Stop Experiment should only be used in emergencies to halt an
experiment. If used, an instrument reset may be required.

Manual Operation Commands in this submenu control specific hardware operations.
Note: The commands are disabled if the associated hardware is not
available.
Load Tips—Instructs the pipettor to load tips or pin tool from the stage
Position 1.
Unload Tips—Instructs the pipettor to unload tips or pin tool to the
stage Position 1. Unload tips to a tip rack, otherwise, make sure there is
a container at stage Position 1 to receive tips.
Wash Tips—Instructs the pipettor to wash tips or pin tool. A dialog
opens for you to configure the wash.
Drain Wash Basin—Enables you to drain the wash basin to the waste
bottles when there is an instrument error.
Yellow Plate Signal Test—Coordinates the reading of the stage Position
3 read plate for the current protocol and displays the numerical results
in the Signal Test dialog. For more details, see Signal Test Dialog Options
on page 55.
Protocol Signal Test—Coordinates the reading of the stage Position 3
read plate and to display the numerical results in the Signal Test dialog.
Instrument settings can be saved to the open protocol. For more
details, see Signal Test Dialog Options on page 55.
Change Head—Instructs the pipettor head to move over stage Position
3 to be exchanged to a new head format. See Exchanging Pipettor or
Pin Tool Head on page 186.

Table 3-4: Instrument Menu Commands
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Options Description

Manual Operation
(continued)

Cycle Camera Temperature—Cycles the camera temperature when
you want to run a low-fluorescence or luminescence experiment
immediately after running a high-fluorescence experiment. The
temperature cycle runs for about 15 minutes, warming to room
temperature, 20°C to 25°C (68°F to 77°F), and then cooling to
operating temperature:
EMCCD camera: -70°C (-94°F) ± 2°C
HS EMCCD camera: -70°C (-94°F) ± 2°C
ICCD camera: -20°C (-4°F) ± 5°C
Temperature Control—Turns heating on and off for stage source plate
Positions 1, 2, and 3, and enables you to specify the heating
temperature.
Cell Flask Stirring Control—Enables you to set the stir speed rate for
the cell flask.
Wash Cell Reservoir—Enables Cell Reservoir washing by selecting the
Fluid Source, Fluid Destination, Fill Speed, Drain Speed, along with the
number of Wash Cycles and Hold Time. It also enables you to pre-coat
the tubes, which is recommended for the first run with any cells in
suspension.
Drain Cell Reservoir—Enables you to drain the Cell Reservoir to a
specified destination for manually pouring cells into the Cell Reservoir,
or in case of an instrument error.
Note: Resetting the instrument automatically drains the Cell Reservoir
to the waste bottle.

Set Remote/ Manual Mode Switches the instrument between manual and remote modes.
Set Remote Mode—Enables you to integrate a third-party robotics
system with the FLIPR Penta System. See Robotic Integration on page
261.
ScreenWorks Software automatically goes into Remote Mode when
you open SynchroMax Automation.
Set Manual Mode—Disables any robotics control, and switches
instrument communication to the ScreenWorks Software.

SynchroMax Automation Opens the SynchroMax dialog for configuring plate handling with the
SynchroMax ET. See SynchroMax™ Automation on page 57.

Reset Reinitializes the system to clear any fatal errors as designated in red at
the bottom of the Instrument Status panel.

Clear Error Clears minor system errors indicated in yellow in the Instrument
Status panel. See Instrument Status Colors on page 209.

Calibration Opens the Calibration dialog where Flat Field Calibration Calibrations
can be done. See Calibrating Optics on page 131.

Refresh Configuration Refreshes the instrument configuration after you change hardware
settings.

Table 3-4: Instrument Menu Commands (continued)
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Signal Test Dialog Options
The signal test has two functions:

Checking the state of the overall system: This test is typically run using the yellow test
plate with the respective plate format for your assay. Open the dialog with the Yellow
Plate Signal Test option in themain menu. Outlined in the table below are the default
settings used when performing the yellow plate signal test. These settings cannot be
saved with a protocol for later use.
Checking initial fluorescence of a plate before running an assay: This test is typically run
to evaluate the assay plate before running an experiment. Open the dialog with the
Protocol Signal Test option in themain menu. Settings outlined in the table below
reflect the Normal camera mode and default to the settings in the currently open
protocol when running the protocol signal test. These settings can be saved in the open
protocol for later use.

Options Description

Select Plate Choose the plate type from the drop-down list.

Excitation/Emission
Wavelength

Select the appropriate excitation/emission wavelength pair for the
signal test from the drop-down list.

Note: Only calibrated excitation/emission wavelength pairs are
displayed in the drop-down list.

Reading Mode Select Fluorescence or Luminescence from the list.

Camera Gain Select the camera gain for the signal test from the list.
For the 470–495/515–575 nm excitation/emission pair when
reading a yellow test plate:
Standard EMCCD Camera is 50
ICCD camera is 2000
HS EMCCD camera is 8 when in CameraMode > Normal, and is 20
when in CameraMode > HighSpeed

CameraMode In Reading Mode > Florescence: Normal, Sensitivity, and
HighSpeed for the HS EMCCD camera only
In Reading Mode > Luminescence: Normal and Sensitivity

Gate Open This option is available only for the ICCD camera. Typical Gate Open
values for Fluorescence are around 6% but can be set to 100%.
Luminescence gate is always 100%, and not user-adjustable.

Table 3-5: Yellow Plate Signal Test and Protocol Signal Test Setting Options
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Options Description

Excitation Intensity Select the LED intensity for the signal test from the drop-down list.
Excitation intensity is scaled as a percentage of the total LED
output (0–100%).
For the 470–495/515–575 nm excitation/emission pair when
reading a yellow test plate:
Standard EMCCD Camera is 80
ICCD camera is 30
HS EMCCD camera is 50

Exposure Time Enter the amount of time (in seconds) to keep the camera shutter
open during the Signal Test.
For the 470–495/515–575 nm excitation/emission pair when
reading a yellow test plate:
Standard EMCCD Camera is 0.4 seconds
ICCD camera is 0.53
HS EMCCD camera is 0.005

Highlight Range Highlights well values that lie within the set statistical range. Set the
statistical range by using the slider.

Wells Above Range Displays the number of wells above the statistical range as
determined by the Highlight Range.

Wells Below Range Displays the number of wells below the statistical range
determined by the Highlight Range.

Maximum Displays the largest value on the signal test plate.

Average Displays the average value on the signal test plate.

Minimum Displays the smallest value on the signal test plate.

Std. Dev Displays the standard deviation of the signal test plate.

Test Signal When clicked, initiates a new signal test.

Save When clicked, saves the signal test as an ASCII text file (*.sig).

Print When clicked, prints the signal test.

Image Viewer Displays the CCD image showing where relative fluorescence units
(RFU) values were derived for the signal test.
Show > Hide Mask—Shows or hides the mask used in the test,
indicating the pixel area used to derive the RLU value for each
well.
View Image—Refreshes signal test image.

Diagnostics For Technical Support use only.

Table 3-5: Yellow Plate Signal Test and Protocol Signal Test Setting Options (continued)

For procedures, see Running Signal Tests on page 135.
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SynchroMax™ Automation

Note: Molecular Devices no longer offers the SynchroMax ET external plate handler
robot. The following information is for reference only.

The SynchroMax Automation option is only enabled when you have a SynchroMax ET
external plate handler installed.
When you open the SynchroMax dialog from Instrument > SynchroMax Automation,
ScreenWorks Software automatically goes into Remote Mode, giving control of the
instrument to the SynchroMax ET software. ScreenWorks Software returns toManual Mode
when the SynchroMax dialog closes.
To run a series of experiments with the SynchroMax ET plate handler, first open the protocol
file that you want to use in ScreenWorks Software. Only one protocol is used in a run for as
many times as the SynchroMax ET plate handler delivers plates.
Having prepared the protocol, open the SynchroMax dialog and select a Stack Layout
Template. These files specify, for each plate location in the five-position stage, howmany
plates load to that position, from which stack, and where they aremoved after use. A
number of Stack Layout Templates are supplied—select the one that fits your assay.
When a Stack Layout Template is open in the dialog, the graphic in the dialog displays on
which stacks the plates load. You can use this as a guide for loading the plates. All plates in a
single stack should be of the same type.
If there are any stage positions that use the same plate throughout the duration of the run,
these stage positions should be loaded manually before the run begins. Stage positions that
have plates brought to them during the run must be empty at the start of the run.
Before selecting Run, make sure all output racks are empty prior to beginning the
experiment. When plates are in position and the FLIPR Penta System ready, click Run in the
SynchroMax dialog. After checking that the plate configuration is compatible with the
protocol Settings configuration, the instrument runs until all plates have been used. During
this time the Run button changes to Stop, so you can stop the run before it completes if
necessary.

Note: Stop should only be used in emergencies to halt an experiment. If used, an
instrument reset may be required.

When the SynchroMax ET plate handler is active, the system clears all plates at the end of an
experiment. The SynchroMax plate handler remembers only those plates it loaded during
the experiment and checks if any of those plates remain when the experiment completes. If
so, they are removed. A reagent reservoir can be used in a source position within the
FLIPR Penta System as long as it is manually loaded and the SynchroMax template does not
include the loading or removal of plates to that position.
Unless you need to run another set of experiments, click Done to close the dialog and return
ScreenWorks Software to Manual Mode.
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Tools Menu

Options Description

Set Default Directories Opens the Set Default Directories dialog to designate directories in
which to store protocol and data files, signal tests, group templates and
to which export files are written.

The Open > Protocol, Data and Image File commands in the File menu
open to the folders set here, as do the File > Export dialogs. In addition,
Group Templates *.fmg can be exported and imported from the
default folder defined in the directory.

The default protocol directory is: C:\Documents and Settings\[your_
user_name]\My Documents\Molecular
Devices\ScreenWorks\MyProtocols [MyData, MySignalTests, or
MyGroupTemplates]

The default data and export directories are: C:\Documents and
Settings\[your_user_name]\My Documents\Molecular
Devices\ScreenWorks\MyData \

The default signal test directory is: C:\Documents and Settings\[your_
user_name]\My Documents\Molecular
Devices\ScreenWorks\MySignalTests

The default group template directory is: C:\Documents and Settings\
[your_user_name]\My Documents\Molecular
Devices\ScreenWorks\MyGroupTemplates

Note: It is recommended that you save all protocol and data files on
the local hard drive to ensure instrument function or data is not lost if
your server fails during an experiment.

Plate Library Opens the Plate Process Definition dialog, which lists current plate
definitions and allows you to add additional plate definitions to the
system. See Plate Process Definition on page 59 for details.

Open Error Log Opens an error log generated by the FLIPR Penta System. This feature
is for technical support and requires a password.

Save Error Log Save error logs. Logs are saved as *.fel (FLIPR Penta System Error Log)
encrypted files. The files can be forwarded to Molecular Devices
Technical Support.

Assay Log For data files only, opens a dialog reporting when the protocol steps
were applied.

Note: This log can be accessed by selecting CTRL+SHIFT+A.
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Plate Process Definition
All plates currently in the system are listed in the Plate Process Definition dialog, opened
from Tools > Plate Library. They are categorized first into read and source plates and then
by well-number format.
A description of commands in the Plate Process Definition and Define Camera Parameters,
both accessed via Tools > Plate Library is provided below. For instructions on adding a new
read or source plate, see Define Basic Plate Parameters Dialog on page 60. The Plate Library is
camera-specific, so if any plates are added with one camera type, they are unavailable after
the camera type changes.
The Plate Process Definition dialog is accessible only to administrators, and is password
protected. The default user name is fliprtetra and password is flipr.
The following fifteen default plates are included with the system software:

Default 96
Default 96 small volume
Default 96 no slit mask
Default 96 boat
Default 384
Default 384 small volume 5X3mask
Default 384 small volume 3X3mask
Default 384 boat
Default 384 blot
Default 1536
Default 1536 boat
Default 1536 blot
Default Cell Reservoir 96
Default Cell Reservoir 384
Default Cell Reservoir 1536
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Options Description

Close Closes the Plate Process Definition dialog.

Open Plate Opens the Define Basic Plate Parameters dialog for the plate selected
in the tree view.

Copy Plate Opens the Define Basic Plate Parameters dialog allowing you to add a
new plate. See Define Basic Plate Parameters Dialog on page 60.

Note: When copying a plate, make sure that you select a plate with a
similar well format, as the number of wells and plate mask are
transferred to the new plate.

Delete Plate Deletes the plate displayed in the Plate Process Definition field.

Collapse All Collapses the Plate Process Definition tree.

Expand All Displays all items in the Plate Process Definition tree.

Table 3-6: Plate Process Definition Dialog Options

Define Basic Plate Parameters Dialog
This dialog opens when you select Open Plate or Copy Plate in the Plate Process Definition
dialog. Use the dialog to establish the critical dimensions of the plates you are using.

Note: Dimensions of default plates cannot bemodified. However, the platemask can
be realigned.

Options Description

Plate Name Enter the name you want assigned to the new plate (maximum
number of characters is 50).

Plate Type Select Source Plate or Read Plate for the new plate.

Source Plate—Creates a plate that does not include a plate mask.
These plates are typically used for compound storage.
Read Plate—Use for all plates that are read in the read position and
require a plate mask.

Table 3-7: Define Basic Plate Parameters Dialog Options
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Options Description

Plate Specifications Area for entry of physical plate dimensions. Refer to the diagram in the
upper right corner of the dialog.
For best results, obtain the plate dimensions from the plate
manufacturer. See FLIPR Penta Plate Dimensions on page 241.

Note: Molecular Devices is not responsible for instrument
malfunctions if plate specifications are not correct.

Rows—Enter the number of rows on the plate.
Columns—Enter the number of columns on the plate.
Well Shape—Select the appropriate shape from the drop-down list.
Well Volume (µL)—Enter the maximum well volume in microliters.
X (mm)—Enter the distance (in mm) from the left side of the plate to
the center of well A1.
Y (mm)—Enter the distance (in mm) from the top of the plate to the
center of well A1.
Bottom (mm)—Enter the distance (in mm) from the bottom of the
plate skirt to the inside of the well.
Top (mm)—Enter the distance (in mm) from the bottom of the plate
skirt to the top of the well.
Well Offset (mm)—Enter the distance (in mm) from the center of one
well to the center of adjacent well.

Table 3-7: Define Basic Plate Parameters Dialog Options (continued)

Define Camera Parameters Dialog
When Read Plate is identified as the Plate Type in theDefine Basic Plate Parameters dialog,
the Finish button is enabled. Before clicking Finish, place a read plate with 10-8M fluorescein
in the read position. When selected, the instrument reads the plate and defines a platemask
for the plate definition created. If a plate is in position, but no mask can be defined, the plate
definition is saved as a source plate.
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Window Menu

TheWindowmenu options allow you to change the way the Experiment window is viewed.
The keyboard shortcut is ALT+W.

Options Description Keyboard
Shortcuts

Cascade Aligns the open windows so that they are overlapped and
staggered with the title bars visible.

Alt+W,C

Tile Divides the screen into as many segments as there are windows
and aligns them so that they are displayed side-by-side. Each file
occupies a segment and is visible. However, each of the file
images is scaled according to the number of files being displayed.

Alt+W,T

1–10 Data Files Lists the open files (up to 10)

Table 3-8: Window Menu Options

Help Menu

TheHelpmenu options provide access to user guides and information about the software.
The keyboard shortcut is ALT+H.

Options Description

FLIPR Penta System User Guide (PDF) Opens a PDF version of this manual that is appropriate for
the version of software installed.

Release Notes (PDF) Opens a PDF version of the ScreenWorks Software Release
Notes.

Protocol Guide (PDF) Opens a PDF guide that provides detailed information,
procedures, and optimization guidelines for running
common types of experiments.

Software License Opens the Software License dialog, which enables
ScreenWorks Peak Pro Software activation.

Contact Us Links to the Molecular Devices website contact page.

About ScreenWorks Opens the About ScreenWorks dialog, which displays the
version numbers for ScreenWorks Software, the Firmware
EC, Firmware Motion, and Remote Interface.

Table 3-9: Help Menu Options

Toolbar

The toolbar, beneath themenu bar, contains tool button shortcuts for a number ofmain
menu commands.
The toolbar can be hidden or shown from the View > Toolbar toggle command.
For more detailed descriptions of the buttons, seeMenu Bar on page 50.
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Button Name Description

New Document Opens a new protocol file (*.fmp) with default
settings for an assay with a single read with fluid
transfer.

Files are named Untitled[n] where n is a number.

Open Protocol File Opens the Open File dialog to browse and open
protocol (*.fmp) files.

Open Data File Opens the Open File dialog to browse and open
data (*.fmd) or image files.

Save File Opens the Save File dialog that allows you to save
the current file in the desired location.

Export File Opens the Export File dialog that allows you to
manually export the current file in the desired
location.

Print Opens the Print dialog.

Experiment Summary Displays protocol contents (process steps and
correction) for the current protocol or data file.
This button toggles with Experiment Setup.

Experiment Setup Opens the Experiment Setup window to edit the
current protocol, view or analyze data in a data file.
This button toggles with Experiment Summary.

Help Opens various documentation in PDF format.

Stop Stops the experiment currently running.

Run Starts the protocol selected in the Experiment
window.

SynchroMax Automation Opens the SynchroMax™ Automation window to
select the desired template to run the SynchroMax
ET plate handler.

Online Mode This button is displayed when System Control
Software is in Offline Mode. Click to connect to the
instrument and go into Online Mode.
This button toggles with Offline Mode.

Table 3-10: Toolbar Buttons
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Button Name Description

Offline Mode This button is displayed when ScreenWorks
Software is in Online Mode. Click to disconnect
from the instrument and go into Offline Mode.
This button toggles with Online Mode.

Remote Mode Instructs ScreenWorks Software to disable the
manual connection and to only receive Remote
commands from a third-party robot.
This button toggles withManual Mode.

Manual Mode Instructs ScreenWorks Software to disable the
remote connection and to only receive Manual
commands from the ScreenWorks Software user
interface.
This button toggles with Remote Mode.

Calibration Opens the Calibration dialog where Flat Field
calibrations can be performed.

Yellow Plate Signal Test Opens the Yellow Plate Signal Test dialog to display
the numerical results using the Yellow Plate.

Protocol Signal Test Opens the Protocol Signal Test dialog to display the
numerical results before running an experiment.
Settings defined in this signal test can be saved to
the protocol *.fmp file.

Set Spinner Flask Stirring Rate Opens the Spinner Flask Control dialog where the
stirring rate can be set.

Set Stage Temperature Opens the Set Temperature dialog where the
stage temperature can be set in degrees
Centigrade, or disabled.

Restore Layout 1 Restores the Experiment window layout to those
defined as Save To Layout 1 in the Viewmenu.

Restore Layout 2 Restores the Experiment window layout to those
defined as Save To Layout 2 in the Viewmenu.

Restore Layout 3 Restores the Experiment window layout to those
defined as Save To Layout 3 in the Viewmenu.

Restore Layout 4 Restores the Experiment window layout to those
defined as Save To Layout 4 in the Viewmenu.

Table 3-10: Toolbar Buttons (continued)
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Experiment Window

The Experiment window is themain working area in ScreenWorks Software for either:
Experiment Setup on page 65
Experiment Summary on page 66

The Experiment window can have one protocol file and multiple data files open
simultaneously. Use the options in theWindows menu to view these file panes individually,
cascaded, or tiled. SeeWindowMenu on page 62.
Only the selected open file pane is active.

Experiment Setup

By default, ScreenWorks Software opens the View > Experiment Setup screen in the
Experiment window.

A new protocol file displays as a tab named Untitled1, and contains four default processes.
See Understanding Processes on page 72. This default protocol file can be used to create a
new protocol file, closed, or ignored to work with an existing protocol file or data file.
Protocol (*.fmp) and data (*.fmd) files both show the process steps they use at the top of
the window, ordered from left to right. Clicking on the process icons opens the related
settings dialog. A data file is a protocol file that also includes acquired data in the Analysis
process dialog.
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Experiment Summary

The Experiment Summary is a single, text-based protocol summary screen.

To view the Experiment Summary page:
Select View > Experiment Summary.

Instrument Status-Configuration-Process Panel

By default the Instrument Status-Configuration-Process panel is open and docked to the
bottom of themain screen. See User Interface Overview on page 48.
The following tabs are in the panel:

Instrument Status Tab on page 67
Instrument Configuration Tab on page 69
Process Tab on page 70

To undock and relocate the panel:
1. Click and drag on the title bar on the left of the panel.
2. Drag the panel to where you want it.
To hide the panel, do one of the following:

Click the x in the title bar of the dialog.
Select the View > Instrument Statusmenu option.

To show the panel when hidden, select the View > Instrument Statusmenu option.
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Instrument Status Tab

The current status of the system hardware components report in the Instrument Status tab
panel.

Figure 3-1: Example Instrument Status Tab Panel With Online Status Indicator

Options Description

Stage Temp (°C) Displays what the stage temperature is currently.

Set Point Displays the stage temperature setting.

Stage Status Displays whether the heated stage is turned on or off.

Camera Temp (°C) Displays the camera temperature. Operating temperature for the
camera depends on the installed camera.
EMCCD camera: -70°C (-94°F) ± 2°C
HS EMCCD camera: -70°C (-94°F) ± 2°C
ICCD camera: -20°C (-4°F) ± 5°C

Camera Status Indicates whether the camera is turned on or off.

Chiller status Indicates whether the chiller is available or not.

Pipettor Tips Reports when tips are loaded on the pipettor head.

Upper Door (Inner) Reports whether the inner-upper door (observation panel) is open or
closed.

Note: The system runs as long as the inner door is closed, however
data might not be valid if the outer door is open.

Upper Door (Outer) Reports whether the outer-upper door is open or closed.

Lower Door Reports whether the lower door is open or closed.

Tip Washer Indicates the status of the tip washer.

Chiller Temp (°C) Reports the current temperature in the chiller.

Read Plate Reports when a plate is present in Position 3 (Read Plate position).

Source Plate 1 Reports when a plate is present in Position 1 (Source Plate 1 or Tip
Loading position).

Source Plate 2 Reports when a plate is present in Position 2 (Source Plate 2).

Table 3-11: Instrument Status Options
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Options Description

Source Plate 3 Reports when a plate is present in Position 4 (Source Plate 3 or Cell
Reservoir).

Cell Reservoir Reports if Installed or Not_Installed.

Chiller Setpoint (°C) Reports the set point from the chiller.

Fill Bottle A Reports when bottle A is empty of wash solution.

Fill Bottle B Reports when bottle B is empty of wash solution.

Waste Bottle A Reports when waste bottle A is full.

Waste Bottle B Reports when waste bottle B is full.

Cell Flask Reports the last known state of the stir Cell Flask. At start the state is
Unknown until the Cell Flask is used.

Cell flask rate Reports the set stir rate of the cell flask. If the Cell Suspension option is
installed and the stir rate is 0, an exclamation sign displays.

Fluid 1 Reports the last known state of the Fluid 1 bottle. At the start the status
is Unknown until that Fluid is used.

Fluid 2 Reports the last known state of the Fluid 2 bottle. At the start the status
is Unknown until that Fluid is used.

Fluid 3 Reports the last known state of the Fluid 3 bottle. At the start the status
is Unknown until that Fluid is used.

Fluid 4 Reports the last known state of the Fluid 4 bottle. At the start the status
is Unknown until that Fluid is used.

Intensifier Reports if Installed or Not_Installed.

Mode Reports if ScreenWorks Software is inManual or Remote mode.

Table 3-11: Instrument Status Options (continued)

Identify Connection Status
To view the connection status:

In the bottom-right corner of the panel, identify the color-coded connection status icon,
which reports the connection status between ScreenWorks Software and the
instrument. Green means connected, and black means disconnected. For more details,
see Instrument Status Colors on page 209.

Figure 3-2: Example Instrument Status Tab Panel With Offline Status Indicator



Chapter 3: ScreenWorks Software Overview

5069582 B 69

View Messages and Faults
To view status messages and faults:

Next to the color-coded connection status icon, click Instrument Status to see a list of
the last thousand messages in the Instrument Status History dialog.

Figure 3-3: Example Instrument Status History Dialog

Tip: If needed, the dialog text can be copied to the clipboard to paste elsewhere.

Instrument Configuration Tab

The Instrument Configuration tab indicates the current instrument configuration of the LED
banks, emission filters, pipettor head, and optional FLIPR Cycler.

Figure 3-4: Example Online Instrument Config Tab Panel
If the system is Offline, you can configure these settings to define protocols. For camera
types details, see the CCD Camera Options section of the FLIPR Penta High-Throughput
Cellular Screening System User Guide. See OnlineMode vs. OfflineMode on page 47.

CAUTION! If a protocol created offline does not match the Instrument Configuration
when opened online, the protocol does not run until the configuration of the protocol
and instrument match.

Options Description

Excitation Wavelengths Displays the excitation wavelengths installed on the system.

Upper LEDs—Displays the wavelength range of the top set of LED banks in
the LED modules.
Lower LEDs—Displays the wavelength range of the lower set of LED banks
in the LED modules.

Table 3-12: Instrument Configuration Options
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Options Description

Emission Wavelengths Displays the emission filter wavelengths installed on the system. Up to
three filters can be installed at the same time.

Pipettor Displays the type of pipettor head (96, 384, 1536, 384 pin tool, or 1536
pin tool) installed on the system.

Note: The pipettor head format must agree with the tip wash reservoir
format. A warning is issued if these are different.

Tip Washer Displays the type of tip washer (96, 384 or 1536) installed on the system.

Camera Type Select from EMCCD, HS EMCCD, or ICCD camera.

Chiller Reports when a chiller is installed.

FLIPR Cycler Reports when the FLIPR Cycler is installed.

Barcode Reader Reports when a barcode reader is installed.

Cell Reservoir Use the check box to indicate whether or not the Cell Reservoir is
installed.

Table 3-12: Instrument Configuration Options (continued)

Process Tab

The Process tab is used to create new protocols and edit existing protocols.

Figure 3-5: Example Online Process Tab Panel Docked
The Process tab panel displays processes that can be incorporated into your experiment
protocols. See Using Protocols on page 71. The color of the process icon depends on the
function in the protocol. See Protocol Process Icon Colors on page 71.

Note: The available processes vary according to the instrument configuration. For
example, different process opts appear when the instrument is configured to use a pin
tool instead of a pipettor.

For details about each process, see Understanding Processes on page 72.
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Protocol Process Icon Colors

Green—indicates that the process is required to run an experiment and cannot be deleted.
Blue—indicates that the process involves liquid handling. These steps are always run series
with each other, and never run simultaneously.
Orange—indicates that the process runs simultaneously with any liquid handling process, if
possible.
Purple—indicates linked processes, such asMix with TF and Read with TF, which are
connected to the Transfer Fluid process.

Status Bar

The status bar, across the bottom of themain window, provides tool tips for commands in
themain menu. When you open a menu from themenu bar and place the cursor over a
command, a description of the command is displayed in the status bar.
The status bar can be hidden or shown from the View > Status Bar toggle command.

Using Protocols
The protocols you create determine how the system functions while running an experiment.
Protocols consist of a series of process configurations. As you create your experiment
protocol, you configure each process. See Creating New Protocols on page 124. Process
options are located in the Process tab in the Instrument Status-Configuration-Process panel.
See Process Tab on page 70.

Tip: Refer to the FLIPR Penta High-Throughput Cellular Screening System Protocol
Guide for specific assay protocols.

To save a data file as a protocol file, see Saving Data Files as Protocol Files on page 128.
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Understanding Processes

The following provides details for using the available Process options used to create your
experiment protocols.

Settings Process

Settings is the first process in all protocols. Use it to define read modes, plate positions, and
data directories. You can also configure automatic file naming, and set plate temperature.
Select the green Settings icon in the Experiment window to view the Settings page where the
settings aremade.
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Setup Read Mode
The Setup Read Mode table at the top of the Settings page displays settings for up to four
read modes that the FLIPR Penta System can run in a single experiment.

Each read mode defines:
Reading Mode
Excitation and Emission Wavelength
Excitation Intensity
Camera Mode (EMCCD camera and HS EMCCD camera)
Exposure Time
Camera Gain
Gate Open (ICCD camera only)
Auto Stabilize (HS EMCCD camera only)

For protocols that usemultiple read modes, the instrument alternates between the selected
read modes for each time point, outputting distinct sets of readings, one for each mode.
ScreenWorks Software automatically calculates the ratio of the readings from each mode for
each time point.
Protocol files that use read modes not supported by your instrument configuration display
the invalid read mode rows in red.
To enable a read mode:

In the Setup Read Mode table, select a Read Mode Name check box.
To disable a read mode:

In the Setup Read Mode table, deselect a Read Mode Name check box.

Edit Read Mode

To edit read mode settings:
1. Select a Read Mode Name row and click Edit Mode.

Alternatively, double-click a Read Mode Name row.
2. In the Edit read mode dialog, change the following settings options as needed, then click

OK to finish.

Note: Available options depend on the camera installed in your instrument.
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Options Description

Read Mode Name Enter a name for the selected read mode.

Reading Mode Select Fluorescence or Luminescence.

Excitation/Emission Wavelength Select a needed excitation LED and emission filter wavelength pair from the list.
NONE instructs the instrument to not turn on any LEDs or use an empty emission
filter position. These are typically used in luminescence experiments.
Note: Only calibrated wavelength pairs are available when the software is in Online
mode. See Calibrating the Optics on page 132.

Excitation Intensity Select a value from the list to regulate the intensity of light emitted by the LEDs for
a given Fluorescence read. The range is 20% to 100%.

CameraMode Select HighSpeed, Sensitivity, or Normal to specify your camera performance
preference.
Note: This option is only available with the HS EMCCD camera.
See Understanding HS EMCCD Camera Protocol Saturation on page 38.

Exposure Time Enter a time in seconds to regulate the time that light is collected and measured by
the camera. A longer exposure increases signal intensity.
Exposure time affects the read interval for data collection. For example, in Camera
Mode > Normal, an exposure time of 0.4 seconds added to a required 0.1 seconds
camera integration time makes the highest update frequency 0.5 seconds.
Depending on the camera, the range is 0.01 seconds to 30 seconds. For example,
using the HS EMCCD camera in CameraMode > HighSpeed, the range is 0.001
seconds to 30 seconds.

Camera Gain Select a value from the list to regulate the amplification of the camera power.
Increasing the camera gain increases the signal.
Ranges depend on the camera in use:
EMCCD camera: 1–240
HS EMCCD camera: Reading Mode >Fluorescence : CameraMode > Normal: 1-128
or CameraMode > HighSpeed or Sensitivity: 20-128. Luminescence mode: 1–500
ICCD camera: Fluorescence read mode: preset to 2000. Luminescence mode:
2000–280,000

Auto Stabilize Automatically adjusts the camera for 50 seconds for optimal functionality before
the protocol starts.
Note: This option is only available with the HS EMCCD camera.
See Stabilizing the HS EMCCD Camera on page 38.

Gate Open Select the percentage of each frame captured to further regulate the signal
intensity.
Note: This option is only available with the ICCD camera in Fluorescence mode.

Table 3-13: Edit Read Mode Dialog Options

Note: Differences in Camera Gain or Exposure Time between read modes significantly
increase theminimum update time. For fastest update time, use the same gain and
exposure time for all read modes.



Chapter 3: ScreenWorks Software Overview

5069582 B 75

Assign Plate to Position
Current plate assignments are reported in the Assign Plate to Position table. The pipettor
head must have a plate type assignment for each of the positions to be used in your
experiment.

For each plate position, the table lists:
Plate Name—the type of plate, as configured in Tools > Plate Library.
Bar Code Expect—Whether or not you want the system to read a bar code from the
plate. Bar code numbers can optionally be incorporated into output data file names.
Bar Code List—in data files only, the bar codes of plates used in the experiment, in the
given plate position.

To change these settings, click Edit Plate.
If Position 1 is to be used only for tips, and not to hold a source plate, select the Load Tips
Position check box. This removes Source Plate 1 from the assignment table.
If the Cell Reservoir is installed in the system, Source 3 is automatically dedicated to the head
format, such as defaultcellres384.

Edit Plate

To change a plate position assignment:
1. Select a Position row and click Edit Plate.

Alternatively, double-click a Position row.
2. In the Change Plate dialog, change the following settings options as needed, then click

OK to finish.
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Options Descriptions

Position Displays the plate position you are editing.

Plate Name Select the plate type from the drop-down list. The list contains default
plates and any additional plates that have been added using Tools >
Plate Library.

Note: Only plates with the same number of wells or one order of
complexity higher than the pipettor head format are displayed.

Bar Code Expected Check this option if using a bar code for the plate. The bar code
number can be incorporated into the file names of data files generated
by the protocol.

InManual Mode, you are prompted to enter the bar codes prior to
starting an experiment.

In Remote Mode the bar code number is automatically scanned on the
FLIPR Cycler landing pad or is passed to ScreenWorks by the third-party
plate handler.

Cell Flask Spinning Rate When the Cell Reservoir from the Cell Suspension option is installed,
spinning rate can be set here or Use Manual can be selected and the
manual settings apply.

Table 3-14: Change Plate Dialog Options

CAUTION! Each plate position has a mechanical sensor to detect the presence of a
plate, tip rack or boat in each position. However, the instrument does not distinguish
the type of apparatus placed in a position.

Data File Name
Use theData File Name options to configure a file-naming protocol for data files created in
experiments. The file-naming protocol applies to *.fmd (data) and *.png (image) files.

Options Description

Include Date Check to include the date in the file name. It is checked by default.

Note: To ensure that data files are not overwritten, we recommend that this
option remains checked.

Table 3-15: Date File Name Options
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Options Description

Include Bar Code When selected, the bar codes of the first five plates used in the experiment
are included in the file names. If there are fewer than five bar codes, then
only those available are used.

Note: Bar Code Expectedmust be selected for the desired plate position in
order for the bar code to be incorporated.

User Defined Name Enter a string of characters (up to 25) to be added to the file name.

Table 3-15: Date File Name Options (continued)

The base structure for file names is as follows:
Date_UserDefinedName_Barcode1_Barcode2_Barcode3_Barcode4_ Barcode5_NNN.fmd
where NNN is an integer from 1 to 999. The integer value NNN starts at 001 and increments
for each data file generated with the same base data file name.
The date uses format: MMDDYYYY, whereM =month, D = day, and Y = year.
If a software crash or other error occurs during a run that interferes with normal instrument
operation, then a data file is automatically stored as:
InterruptedExperiment_Date_Time_NNN.fmd

Folders
Use the Folders fields to specify into which directories your data and export files save.

Change—allows you to select a different directory.
Open Folder—opens theWindows Explorer dialog directly to the directory designated.

By default, data, image and export files save in the following location:
C:\Documents and Settings\[your user name]\My Documents\Molecular
Devices\ScreenWorks\MyData\

Temperature Control
The Temperature Control field allows you to set the plate-stage heaters to a needed
temperature for an experiment. Temperature range is from ambient 25°C (77°F) to 40°C
(104°F).
Select Use Manual to control the heaters manually from ScreenWorks Software at the time
the experiment is run.
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If at the start of an experiment, the stage temperature is different from the selected value, a
message displays. You can wait until the stage reaches the needed temperature or run the
experiment anyway.

Note: When the temperature is manually turned on through the Instrumentmenu, a
setting of “0” in the protocol does not affect the temperature setting. To turn off the
temperature, manually select Instrument > Manual Operations > Temperature
Control Off.

Analysis Process

The Analysis process is included in all protocols and is always the second process after
Settings.

Viewing Data
Grouping, see page 86
Corrections, see page 91
Exporting Data, see page 157

Viewing Data
Acquired data can be viewed in ScreenWorks Software on themain Analysis process page, in
theMulti-Well Graph, or in larger Detail Graph. The options are described in this section.

Multi-Well Graph

Themajor part of the Analysis process page consists of a grid representing the wells of the
read plate used in the protocol or data file (for example, with 96-wells, 384-wells, or
1536-wells). This is called theMulti-Well Graph. For protocol files this graph is empty, as no
data have been acquired, but in data files each cell of the graph has a trace of one of the
measurements taken from the corresponding read plate well. Themaximum and minimum
relative light units values of the displayed data are reported above theMulti-Well Graph.
TheMulti-Well Graph displays, for each well represented, one trace of relative light units
versus time. If two or more read modes were recorded, select themode to view from the
display list box above the graph. To see the ratio of two read modes, enable Ratiometric
Options in the Configure Corrections > Corrections dialog, and select Ratio in the display
list.
The Read Mode defined in theMulti-Well Graph is also applied to any traces displayed in the
Detail Graph.
The traces displayed in theMulti-Well Graph can be adjusted by the application of different
data-correction options available in the Correction dialog, for example, the traces can be
scaled relative to the average positive control response. See Corrections on page 91.
If groups have been defined for the assay, wells in theMulti-Well Graph are color-coded to
represent these. See Grouping on page 86. In addition, there is the option to include the
kinetic reduction value below each well trace in theMulti-Well Graph.



Chapter 3: ScreenWorks Software Overview

5069582 B 79

Buttons, just above theMulti-Well Graph, open dialogs that offer various data analysis
options; some relevant to protocol set up, some to already-acquired data in data files, and
some to both. Multi-Well Graph buttons and descriptions include:

Buttons Name Description

Configure Groups Opens the Grouping dialog to classify wells in the plate
into groups (for example, positive and negative
controls). Groups created in protocol files are
transferred to all the data files generated by the
protocol. In data files, new groups can be created or
existing groups edited. See Grouping on page 86.

Select Groups Opens the Select Groups dialog to classify which groups
are quickly displayed in the Detail Graph from a
predefined list based on the groups defined in the
Grouping dialog.

Note: Hold down the SHIFT or CTRL key to select
multiple groups.

Group Selection Mode Button toggles between Group Selection Mode and
Well Selection Mode.

During Group Selection Mode, wells selected within a
predefined group displayed in the Multi-Well Graph
cause all wells within those groups to be displayed in
the Detail Graph.

Well Selection Mode Button toggles between Group Selection Mode and
Well Selection Mode.

Well Selection Mode only displays wells selected in the
Multi-Well Graph on the Detail Graph with their
respective group colors assigned.

Notes In protocol files, use this dialog to write comments to be
stored with all data files generated by the protocol. In
the data files, view the comments (now read-only) in
the same dialog.

Images For data files only, where images have been saved
during an experiment (by checking Save Images in a
Read with TF step) these can be viewed by clicking the
Images button.

Copy Copies data in the Multi-Well graph to the clipboard so it
can be pasted in a different program such as Microsoft
Word.

Table 3-16: Multi-Well Graph Button Options
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Buttons Name Description

Configure Auto-Export Available for protocol files, this button opens the Auto-
Export dialog allowing configuration of statistics and
time sequence files to be automatically created
whenever the protocol is run. This button also works to
export data after a data file has been created.

For data files the button changes to Export, and opens
the File Export dialog, also opened from the File >
Export command. See Exporting Data on page 157.

Configure Correction Opens the Corrections dialog to apply various
corrections to modify data display. There is also the
option to view ratiometric data. Settings made here in
protocol files affect how data are viewed when the
protocol is run, but since all raw data are stored in data
files, these options all remain available for acquired data
as well. See Corrections on page 91.

Hide Kinetic Reduction Value Hides the kinetic reduction values that are displayed in
the Multi-Well Graph.

Show Kinetic Reduction
Value

Shows the kinetic reduction value in each well of the
Multi-Well Graph.

Configure Kinetic Reduction Opens the Kinetic Reduction Configuration dialog to
define the parameters used to define the kinetic
reduction.

Reduction Type—Defines the reduction to be applied to
the kinetic data traces displayed in the Multi-Well
Graph. See Kinetic Reduction Types on page 81.
Start Read—Define the first read to be used to
determine the kinetic reduction.
End Read—Define the last read used to determine the
kinetic reduction.
Read Mode—Select the read mode to apply the kinetic
reduction to.

Table 3-16: Multi-Well Graph Button Options (continued)
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Kinetic Reduction Types

The Reduction Type field is located in the Kinetic Reduction Configuration dialog. Available
options depend on the software version in use. A separate license for ScreenWorks® Peak
Pro™ Software Software Version 1.0 adds advanced peak detection and characterization
measurements to the field of standard measurement options (see Figure 3-6). This
functionality is optimal for relatively fast events that have been acquired with long sampling
intervals. Contact your Molecular Devices Sales Representative for details.

CAUTION! High speed camera data is not compatible with Peak Pro 1.0. You must use
ScreenWorks Peak Pro Software Software Version 2.0 for the high speed camera data
analysis. See Using ScreenWorks Peak Pro Software Version 2.0 on page 165.

Figure 3-6: Kinetic Reduction Types Including Additional ScreenWorks Peak Pro 1.0
Reductions
Standard measurement options and definitions include:

Average—Numerical average of relative light units counts of the selected reads.
Sum—Numerical sum of relative light units counts of the selected reads.
Minimum—Lowest detected count (a single number) of all the selected reads.
Maximum—Highest detected count (a single number) of all the selected reads.
Maximum-Minimum—Result of subtracting theminimum count (a single number) from
themaximum count (a single number).
Area Under Curve—Numerical calculation of the area under the curve for the selected
reads.
Slope of Curve—Result of calculating the slope between two selected reads.



FLIPR Penta High Throughput Cellular Screening System User Guide

82 5069582 B

(With optional license) ScreenWorks Peak Pro Software Software Version 1.0measurement
options and definitions include:

Peak Count—Number of peaks or action potentials detected within the read data that
meet the specifications in the Configure Peak Detection dialog settings.
Peak Frequency (BPM)—The Beats-Per-Minute frequency of the peaks detected based
on the inverse of the peak temporal spacing. At least two peaks are required for this
measurement.
Average Peak Width—Average peak width measurement in seconds from the 50% peak
amplitude from baseline.
Peak Width Standard Deviation—Standard deviation of average peak widths.
Average Peak Amplitude—The average peak amplitude relative to the Average Peak
Baselinemeasurement.
Peak Amplitude Standard Deviation—Standard deviation of peak amplitudes.
Average Peak Baseline—Average baseline amplitudemeasurement from the base of
each peak detected.
Average Peak Spacing—Average peak spacing in seconds. At least two peaks are
required for this measurement.
Peak Spacing Standard Deviation—Standard deviation of peak spacing.
Average Peak Rise Time—Average timemeasured on the rising edge for each peak.
Equal to the time between the 10% and 90% peak amplitudes.
Rise Time Standard Deviation—Standard deviation of rise times.
Average Peak Decay Time—Average timemeasured on the falling edge for each peak.
Equal to the time between the 90% and 10% peak amplitudes.
Peak Decay Time Standard Deviation—Standard deviation of decay times.
Average Peak Width at 10% Amplitude—Average peak width in seconds at the 10%
peak amplitude from baseline.
Irregular Spacing—Identifies wells that have irregular spacing between peaks. Wells with
regular peak temporal spacings aremarked as OK. Wells with missing peaks aremarked
asMISS. Wells with extra peaks aremarked as EXTRA. Wells with peak spacing
characteristics of both missing and extra aremarked as IRREG.

The Configure Peak Detection button activates when a Peak Pro measurement is selected
from the Reduction Type field (see Figure 3-7). The Configure Peak Detection dialog allows
the Peak Pro measurement settings to be adjusted and optimized (see Figure 3-8).

Figure 3-7: Configure Peak Detection Button Activation
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Tip: Start with default settings.

Configure Peak Detection dialog options include:
Smooth Width: Running average to reduce noise, set between 5 to 10.
Fit Width: Number of data points that are fit for each peak, set between 5 to 15.
Slope Threshold: Distinguishes between cardio beats and noise, set to 0.001.
Amplitude Threshold Dynamic: Value setting is relative to the data average.
Amplitude Threshold Fixed: Value setting is relative to zero.

Figure 3-8: Configure Peak Detection Dialog

Detail Graph

All the read modes for wells selected in themulti-well graph can be displayed enlarged in a
detail graph. You can select individual or multiple wells to view, or select by group.

Note: When the FLIPR Penta System is configured for two or more read modes, it
cycles through each mode alternating between them for each reading. Although
readings from each modewithin a cycle occur at different times, they are represented
as occurring simultaneously.

The data displayed in theDetail Graph have the same corrections applied as the data
displayed in theMulti-Well Graph. TheDetail Graph reports these settings at the top of the
graph window:

Subtract Bias
Spatial Uniformity Correction
Negative Control Correction
Positive Control Scaling
Response Over Baseline
Crosstalk Correction
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These correspond directly to options in the Correction dialog, opened from the Analysis
process page. To change these settings, change them in the Correction dialog. This changes
all data in theMulti-Well Graph and Detail Graph to reflect the new correction applied.
Detail Graph allows a number of data-selection options:

Buttons Name Description

Copy Graph Copies Graph in the Detail Graph to the clipboard so it
can be pasted in a different program such as
Microsoft Word.

Copy Graph Data Copies graph data in the Detail Graph to the clipboard
so it can be pasted in a different program such as
Microsoft Excel.

Zoom Mode Click to enable zoom capability in the graph. Once the
Zoom button is pressed, drag over a region in the
graph to view just that area enlarged to the full size of
the graph.

Alternatively, drag the cursor along a part of the x or y
axis to zoom in on just that axis.

Auto Scale Manual prompt to automatically scale the Detail
Graph and Multi-Well Graphs to include all data points
of the desired traces.

Auto Scale Always Automatically scales the Detail Graph and Multi-Well
Graph to include all data points of the desired traces
without manual prompting.

Undo Zoom Rescales a graph to the original settings.

Manual Scale Graph Opens the Manual Scale Graph dialog to set the
maximum and minimum values for the X- and Y-axis
of the Detail Graph and Multi-Well Graph.

Show/Hide Data Toggle button that shows or hides the relative light
units values for the selected traces at each read.

Show Point Labels Show Point Labels writes the value of each data point
(for example, relative light units value) beside the
point on the graph.

Show/Hide Legends A toggle button that displays or hides the Detail
Graph legend.

Table 3-17: Detail Graph Button Options
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Buttons Name Description

Average/Overlay Trace A toggle button that displays the average or overlay
traces for selected groups.

Average Group—Displays average time point values
for all wells in the selected group. A separate trace is
generated for each read mode.
Note: When Well Selection Mode selected in the
Multi-Well Graph, all traces displayed in the Detail
Graph are averaged regardless of the group they are
assigned.
Overlay Group—Displays traces for all the wells in
selected groups.
Note: Traces are color-coded by group.

Show/Hide Standard Deviation A toggle button that enables or hides the standard
deviation for the average group trace.
Note: Average Groupmust be enabled to access this
function.
WhenWell Selection Mode is selected in the Multi-
Well Graph, all traces displayed in the Detail Graph
are averaged regardless of the group they are
assigned, and the standard deviation for this average
is displayed.

Table 3-17: Detail Graph Button Options (continued)

Individual Well Selections

To view a single well in theDetail Graph, double-click or drag themouse cursor inside the
Multi-Well Graph over a well of interest.
To view the traces ofmultiple wells overlaid in theDetail Graph, drag the cursor inside the
Multi-Well Graph over themultiple wells of interest. Data from any rectangular block of wells
within the plate can be viewed in this way. Additional wells can be added to the overlay by
double-clicking or dragging themouse cursor over the wells of interest.

Group Selections

You can also select data to view in theDetail Graph using group membership (see Grouping
on page 86). Use Select Group or Group Selection Mode functions found in theMulti-Well
Graph.
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Analyzing Data
TheGrouping and Corrections dialogs are used to analyze data produced during an
experiment. Settingsmade in these dialogs in a protocol file affect the way that data, in data
files generated with the protocol, are displayed when first viewed in ScreenWorks Software.
They also affect data in the automatic output option Auto Export that occur when the
protocol is run. See Exporting Data on page 157. Data files created by ScreenWorks Software
retain all raw data readings, so the analysis options in theGrouping and Correction dialogs
apply to acquired data, modifying the display of these, irrespective of the analysis settings
configured in the original protocol. See Grouping on page 86 and Corrections on page 91.

Grouping

Groups are used to select data to be viewed in the detail graph, and the data itself can be
corrected relative to responses to positive and/or negative control groups, in the Correction
dialog.

Define groups in the Analysis > Configure Groups >Grouping dialog.

A group is a selection of wells with a common characteristic—usually in the type of
compound added to the wells. Three groups—background fluorescence correction, positive
controls and negative controls—are defined by default, but no wells are assigned to them.
You specify the well assignment for these groups.
You can create additional groups to represent wells with a specific ligand, or ligand
concentration, or any other characteristic you want to classify data by. Group definition
includes specific input for compound concentration, as this is commonly used for group
definition. Additionally, the Series option allows you to create a series of groups, where a
number of different concentrations are automatically assigned to each group. This can be
useful for creating groups for an IC50 or EC50 experiment.
TheGrouping dialog contains a grid representing the 96-well, 384-well or 1536-well read
plate, and above this a list box where groups are defined and selected. The basic mode of
operation is to select a group from the list box, then drag the cursor over the wells in the grid
that belong to that group. Additional groups can be defined to add to the list.
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Options Description

Groups Displays the list of defined groups, including group name (typically
compound name), concentration and notes associated with the group. Wells
assigned to a group in the grid below have the same color as the group in the
list.

Positive Controls—Use this group to assign positive control wells, typically
the maximum response to a concentration of an agonist.
Note: Positive Controlwells need to be defined in order to use the Positive
Control Scaling Correction.
Negative Controls—Use this group to assign negative control wells, typically
buffer addition controls.
Note: Negative control wells need to be defined in order to use the
Negative Control Correction feature.
BF Controls—Use this group to assign wells in which to measure background
fluorescence. Measurements for each time point from these wells are used
for Background Fluorescence Correction for ratiometric data. See
Ratiometric Options on page 93.
_add new group—Use this to define a new individual group or a series of
groups that are user-defined.

Add/Edit Group Opens the Edit Group dialog to edit the group selected in the Groups list. This
could be an existing group, or create a new group by selecting the Add New
Group row. See Adding a New Group on page 88.

Shortcut: Open the Edit Group dialog by double-clicking on a group in the
Groups list.

Delete Group Deletes the group selected in the Groups list. Any wells assigned to the group
lose their coloring, indicating that they no longer belong to any group.

Delete All Groups Deletes all user-defined groups.
Note: Positive, negative and background fluorescence control groups cannot
be deleted, however this command deletes all wells assigned to these
groups.

Clear All Selections Removes all group assignments from all wells. Group names in the top list
are not affected.

Undo Last Selection Removes group membership from the last wells that were assigned to a
group.

Table 3-18: Grouping Dialog Options
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Assigning Wells to Groups

To assign wells to a group:
1. Select the appropriate group from theGroups list, for example, Positive Controls.
2. Drag the cursor over the wells from the plate layout that you want to include in the

selected group. Alternatively, the row or column title can be selected to include all the
respective wells in the group.

Note: Wells in a group do not need to be contiguous. Multiple areas of the plate
can be selected.

You can deselect individual or neighboring wells by right clicking in one corner of a well to
be deselected, then dragging over the well or wells to deselect.

3. Repeat Steps 1–2 to assign other wells to different groups.

Adding a New Group

To add a new group:

1. Define groups in the Analysis > Configure Groups >Grouping dialog.
2. Select _add new group from theGroups list and click Add/Edit Group, or double-click on

the group name.
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3. When the Select Type of Group dialog opens, choose to configure a single group with
specific settings in theGroup tab, or to configure a series of groups, with incrementing
concentration values, in the Series tab.

Group Tab

To assign a single group concentration:
1. Click Group.
2. Type a name for the group (for example, compound name) in theGroup Name field.
3. In the Concentration field, select or type the concentration value.
4. In theUnits drop-down list, select nM, µM,mM,M, or Log concentration units.
5. In theNotes field, type in any notes that you want associated with the specified group

and data file.
6. Click OK to finish save the defined group.
Series Tab
When a series is created, assign wells to it. See Assigning Wells to Groups on page 88.
Successive rows or columns are assigned different concentrations and group color
automatically, as configured in the series.

Note: The Series option is typically used for assigning a dose-response curve with
regular increment steps.
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To assign a series of concentrations:
1. Click Series.
2. In theGroup Name field, type a name for the group, for example, compound name.
3. In the Starting Value field, select or type the value for the lowest or highest

concentration of the series.
4. In the Step Increment field, select or type the value for the change in concentration

between concentrations in the series.
5. In theUnits drop-down list, select nM, µM,mM orM concentration units.
6. Specify the Step Increment for the Starting Value to create the series.
7. In theOperation drop-down list, select Plus,Minus,Multiply or Divide.
8. If you have Replicates, select whether they are aligned in Row or Column format on the

plate.
If replicates align in both row and column formats, indicate the number of replicates,
for example, replicates in rows indicates all wells in the selected rows have the same
concentration.
If two rows are to include the same concentration, type 2.
If there are no replicates, select None.

9. Select the direction in which the series increments, either Left, Right, Top or Bottom.
10. In Notes, type details you want associated with the specified group and data file.
11. Click OK to finish save the defined group.
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Corrections

Use the Corrections dialog to apply data-correction algorithms and to view ratiometric data.

Changes affect:
Data displayed in theMulti-Well Graph and Detail Graph.
Data displayed in group statistic table and graphs.
Data in files are exported manually or automatically. See Exporting Data on page 157.
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Exported data cannot be changed, so settings made in this dialog in protocol files are
important for these output options. For viewing data in ScreenWorks Software, however,
since raw data are always kept, correction options selected in protocol files can be altered
when the data are viewed in resulting data files.

Options Description

Crosstalk Correction Only available with Aequorin, ICCD camera. Check this option to
correct all wells for crosstalk from neighboring wells. The crosstalk
function is based on well-to-well distance and the measured
percentage of crosstalk.

Positive Control Scaling Check to average each maximum relative light units value from the
positive control group and normalize all samples to this value (set
at 100%). This function is useful when graphing a dose-response
curve or when comparing data between experiments.

Negative Control Correction Check this option to have an average negative control well value
and ratio-to-well value calculated for each sample interval (time
point). This ratio is calculated for each sample interval and applied
to all wells. This function provides a good correction for signal drift
and artifacts.

Spatial Uniformity Correction Check this option to use the initial signal to normalize signal in each
well, removing fluctuations due to well-to-well variation in cell
density and dye loading. The processing algorithm averages the
initial signal from all wells together. It then scales each individual
well relative to the average. This correction is particularly
recommended when you want to normalize cell number, type and
dye-loading conditions throughout a plate.

Note: Spatial uniformity should only be used when all wells in a
plate are treated the same prior to an experiment (for example,
dye loading, cell numbers, etc.).

Subtract Bias Based On Sample Check this option to subtract the relative light units measured at a
selected read number from all other time points in each well. This
option enables you to set the Y-axis scale so that at the time point
specified, the Y-axis values for all data graphs is zero. Select the
read number to be subtracted in the field to the right of the check
box. The default is read number 1.

Table 3-19: Corrections Dialog Options
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Options Description

Response Over Baseline Check this option to display the trace as a ratio of the response to
the average of a set of predefined reads.

Baseline Start—First read to be included in the averaged baseline
value.
Baseline End—Last read to be included in the average baseline
value.
Show As Percentage—Displays response as a percent increase
over the average baseline value.

Table 3-19: Corrections Dialog Options (continued)

For more details, see Data Processing Algorithms on page 249.
Each of the correction options can be applied alone or in combination with the others. When
a combination is selected they are applied in the following order:
1. Crosstalk
2. Spatial Uniformity Correction or Response Over Baseline
3. Negative Control Correction
4. Positive Control Scaling
5. Subtract Bias

Note: Spatial uniformity correction and percent baseline cannot be applied at the
same time.

Ratiometric Options

Where two read modes are configured, you can view the data as a ratio of one read mode to
the other, for each data point.
When this option is enabled, traces of the calculated ratio can be displayed in the Detail
Graph pane.
Before calculating the ratio, ratiometric data is corrected for fluorescence background by
subtracting estimated background values from both numerator and denominator for each
time point. After the fluorescence background is subtracted, the ratio is then calculated.
Additional selected corrections are applied to the ratio, beginning with negative control
correction, positive control scaling, followed by subtract bias.

Note: Spatial uniformity correction and response over baseline are disabled when
Ratiometric Options are active.

Options Description

Ratiometric Options Enable ratiometric data viewing by selecting the check box.
Specify how the ratio is defined by selecting the read modes
to be used as numerator and denominator.

Table 3-20: Ratiometric Options
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Options Description

Background Fluorescence Correction Scale by BF Control Group—For each time point and read
mode in the ratio, the average value for that time point in the
background fluorescence control wells (BF Controls, in the
Grouping dialog) is subtracted. The ratio is calculated after
subtraction of the average value from both numerator and
denominator.

Scale by Constant Values—Constant values to subtract from
the numerator and denominator for each time-point ratio
are entered by the user.

You must enter these constant values in the numerator and
denominator fields when this option is selected.

Table 3-20: Ratiometric Options (continued)

Group Statistics

Below theMulti-Well and Detail Graphs on the Analysis process page, theGroup Statistics
Table is used to analyze data produced during an experiment. Only groups defined in the
Grouping dialog can be analyzed in this section. In addition, settings made in the Correction
dialog influence the group statistics that are reported. See Corrections on page 91.
To analyze data in theGroup Statistics Table, groups must first be defined in theGrouping
dialog. See Grouping on page 86. When defined, the Configure Kinetic Reduction button is
selected in Multi-Well Graph to define the reads and reduction type to be analyzed.

Buttons Name Description

Copy Table Data Copies data in the Group Statistic Table to the
clipboard so it can be pasted in a different program
such as Microsoft Excel.

Collapse All Groups Collapses the Group Statistics Table to only display
the group name and relative statistics.

This works as a toggle button with Expand All Groups
which displays the individual wells and kinetic
reduction values that comprise each group statistic.

Expand All Groups Expands the Group Statistics Table to display all the
individual wells and kinetic reduction values that
comprise each group statistic.

This works as a toggle button with Collapse All
Groups, which displays only the group name and
individual statistics.

Table 3-21: Group Statistics Table Button Options
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Buttons Name Description

Auto Fit All Columns This is used to collapse the column width so it is no
wider than the title of the column or largest data
point.

Select Statistics Opens the Choose Statistics dialog for defining
groups statistics, for example, Average, Standard
Deviation and Z-score, are displayed in the table.

Group statistics available include the following:
Concentration—Numerical concentration values
assigned to each group in the Grouping dialog.
Units—Concentration units (for example, uM)
assigned to each group in the Grouping dialog.
Notes—Comments assigned to each group in the
Grouping dialog.
Average—Numerical average of the kinetic reduction
values for a given group.
Maximum—Highest value (a single number) of all
kinetic reductions within a group.
Maximum-Minimum—Result of subtracting the
minimum kinetic reduction value from the maximum
count kinetic reduction value for a single group.
Minimum—Lowest kinetic reduction value within a
group.
Sum—Numerical sum of all kinetic reduction values
within a group.
Standard Deviation—Defines the numerical value
associated with one standard deviation from the
average.
Standard Deviation+1—Equals the average group
value plus one standard deviation.
Standard Deviation-1—Equals the average group
value minus one standard deviation.

Table 3-21: Group Statistics Table Button Options (continued)
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Buttons Name Description

Select Statistics (continued) Z Score—Used to evaluate quality or performance of
the assay and is dependent on the concentration
evaluated1.

Z-factor—Used to evaluate the quality or
performance of the assay at a given concentration.
This is typically used for all concentrations, not
including the positive control. Calculation used:

Z = 1 - [3*(std dev of GROUP + std dev of neg
ctrls)/abs(mean of GROUP - mean of neg ctrls)]

Z’-factor—A characteristic parameter for the quality
of the assay itself. This is typically performed using
data only from the positive control concentration.
Calculation used:

Z' = 1 - [3*(std dev of pos ctrls + std dev of neg
ctrls)/abs(mean of pos ctrls - mean of neg ctrls)].

1. Zhang, J., Chung, T. D. Y. and Oldenburg, K. R. (1997). A Simple Statistical Parameter for
Use in Evaluation and Validation of High Throughput Screening Assays. Journal of
Biomolecular Screening 4(2):67:73.

Table 3-21: Group Statistics Table Button Options (continued)

The statistics defined in theGroup Statistic Table can be plotted in theGroup Statistic
Graph, located behind theDetail Graph, to quickly view a dose-response curve. All groups
are included in the graph, unless the user right-clicks on the desired group and selects
Exclude Groups From Statistic Chart. Groups not used in the graph have a green line
through the entire row of the group. To include the group in the graph, right-click the group
and select Include Groups In Statistic Chart. Data displayed in theGroup Statistic Graph is
defined by selecting a specific group statistic from theGroup Statistic Table. For Example, if
the standard deviation is the needed data to be evaluated, select the Standard Deviation
column header to highlight this data in theGroup Statistic Table and it displays in the graph.

Buttons Name Description

Copy Graph Copies data in the Group Statistic Graph to the
clipboard so it can be pasted in a different program
such as Microsoft Word.

Copy Graph Data Copies Graph Data in the Group Statistic Graph to the
clipboard so it can be pasted in a different program
such as Microsoft Excel.

Table 3-22: Group Statistic Graph Options
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Buttons Name Description

Zoom Mode Press to enable zoom capability in the graph. Once
the Zoom button is pressed, drag over a region in the
graph to view just that area enlarged to the full size of
the graph.

Alternatively, drag the cursor along a part of the X- or
Y-axis to zoom in on just that axis.

Auto Scale Manual prompt to automatically scale the Group
Statistic Graph to include all data points of the
desired traces.

Auto Scale Always Automatically scales the Group Statistic Graph to
include all data points of the desired traces without
manual prompting.

Undo Zoom Rescales graph to the original settings.

Manual Scale Graph Opens the Manual Scale Graph dialog to set the
maximum and minimum values for the X- and Y-axis
graph.

Show/Hide Data Toggle button that shows or hides the data for the
selected traces at each read.

Show Point Labels Show Point Labelswrites the value of each data
point, such as relative light units value, next to the
point on the graph.

Show/Hide Legends A toggle button that displays or hides the detail graph
legend.

Show/Hide Smoothed Curve A toggle button that displays or hides the 4-
parameter curve fit.

This feature can be displayed at the same time as
Show/Hide Original Trace.

Show/Hide Original Trace A toggle button that displays or hides the trace of the
graph, which connects each data point.

This feature can be displayed at the same time as
Show/Hide Smooth Curve.

Table 3-22: Group Statistic Graph Options (continued)



FLIPR Penta High Throughput Cellular Screening System User Guide

98 5069582 B

Buttons Name Description

Show/Hide Real Data Points A toggle button that displays or hides the data points
to create the graph.

Note: When the data points are hidden, Molecular
Devices recommends to activate either the Original
Trace or Smoothed Curvefunction.

Display X-Axis in Log Scale A toggle button that converts the X-axis from a
concentration to a log concentration scale.

Show/Hide EC/ICXX Value A toggle button that displays or hides the
effective/inhibition concentration from being
displayed. When activated, you define the
percentage of activation/inhibition that the graph
plots.

Table 3-22: Group Statistic Graph Options (continued)

Exporting Data
You can export data the following two ways:

Automatic export when a protocol is run.
Export from already acquired data.

To configure the data export:

In protocol files, in the Analysis screen, click Configure Auto Export.
For data files, use File > Export, File or Batch Export.

Note: Auto-Export and Batch Export do not support the ScreenWorks Peak Pro
Software version 2.0.
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Data is exported as ASCII text format files with a separate file exported for each measurement
configuration specified. When you export data , you specify a folder in which to write the
output files.The default export folder is:
C:\Documents and Settings\[your_user_name]\My Documents\Molecular
Devices\ScreenWorks\MyData
The File Export dialog has the following tabs:

Files—Export directory setting or batch files selections.
Time Sequence—Exports time-point measurements for selected read modes. The
measurement values that are exported have any corrections configured in the
Correction dialog applied. If there are two read modes and Ratiometric Options is
selected in the Correction dialog, you can also export the ratio for each time point.
Files have a *.seqn extension, where n increments for each file generated in the export.
Statistics—Exports averages, maximums, and other kinetic reduction values for selected
numbers of reads for each well.
Files have a *.statn extension, where n increments for each file generated in the export.
Peak Pro 2.0 Statistics—You must run the Peak Pro 2.0 analysis before you can do the
export. After running the analysis, this export works the sameway as Statistics. See
Exporting Data With Peak Pro 2.0 Analysis on page 180.
Group Statistics—Exports the group statistical values for selected numbers of reads for
each group and are based on user-defined kinetic reduction settings.
Files have a *.gstatn extension, where n increments for each file generated in the export.
Peak Pro 2.0 Group Statistics—You must run the Peak Pro 2.0 analysis before you can
do the export. After running the analysis, this export works the sameway as Group
Statistics. See Exporting Data With Peak Pro 2.0 Analysis on page 180.
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CAUTION! Data created in ScreenWorks Software version 2.0 cannot be viewed or
exported by ScreenWorks Software version 5.0.

Exporting Time Sequence

Configure parameters for export of time-sequence data in the Export Time Sequence tab.
The exported files contain a value for every read interval for each well, for the read mode or
ratio selected. This contrasts with the Statistics file, which contains one kinetic reduction per
well.

Options Description

Enable Time Sequence Check this option to have a time sequence export file created.

File Name Options Choose a name for the exported time sequence file.

Use name of data file—Export files with the data or protocol file
name, with *.seqn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.seqn extension, where
n is an integer ≥ 1.

Data Format Format the output from this group of options:

Show Labels—Check to include information about the processing
options selected (for example, name of *.fmd file and well labels). Any
corrections prior to export (e.g., negative control correction) are
reported at the top of the exported ASCII file.
Order of Well Data—Order the data by column (for example, A1, B1,
C1) or by row (for example, A1, A2, A3). Set this option in accordance
to the way your spreadsheet or database handles well data.
Order Time Data—Select vertical or horizontal ordering of the data.

Misc. Parameters Select experimental parameters and group statistics to export with the
data.

Table 3-23: Export Time Sequence Options
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Options Description

Individual File Parameters Use the bottom section of the dialog to choose the number and type
of time sequence files to be created from the same data set.

Number of Files—Click the Add Statistic button to add to the number
of statistic files to be created from the same data set.
Read Mode—Enter the read mode (or ratiometric data) from which
you want to export data.
From Quadrant—You can choose a specific quadrant from which to
export, or export data from all quadrants. This enables you to export
data from one plate into four different spreadsheet files, if desired.

Note: This option is only available for data created in 384-well or
1536-well formats.

Table 3-23: Export Time Sequence Options (continued)

Exporting Statistics

Use the Export Statistics tab to configure kinetic reductions, for example, averages and
maximum and minimum values, for selected numbers of reads within each well. Multiple
kinetic reductions can be configured, each resulting in another export file. Within each file
only one value is reported per well.

Options Description

Enable Statistics Check this box to have a statistic file created.

File Name Options Choose a name for the exported statistic file.

Use name of data file—Export files with the data or protocol file
name, with *.statn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.statn extension, where
n is an integer ≥ 1.

Data Format Format the output from this group of options:

Show Labels—When checked, the output file contains information
about the processing options selected (for example, name of *.fmd
file and well labels). Any corrections done prior to exporting the data
(e.g., negative control correction) are indicated in text format at the
top of the exported ASCII file.
Order of Well Data—Order the data by column (for example, A1, B1,
C1) or by row (for example, A1, A2, A3). Set this option in accordance
to the way your spreadsheet or database handles well data.

Table 3-24: Export Statistics Options
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Options Description

Misc. Parameters Select experiment parameters and group statistics to export with the
data.

Individual File Parameters Use the bottom section of the dialog to designate the number and
type of statistic files to be created from the same data set.

Number of Files—Click the Add Statistic button to add to the number
of statistic files to be created from the same data set.
Compute—Select a kinetic reduction type. See Kinetic Reduction
Types on page 81
Start Read—Enter the first read number to be included in the kinetic
reduction.
End Read—Enter the last read number to be included in kinetic
reduction. This can equal the Start Read, if you want to extract values
from a single read.
Read Mode—Enter the read mode (or ratiometric data) from which
the data processes.
From Quadrant—You can choose a specific quadrant from which to
export, or export data from all quadrants. This enables you to export
data from one plate into four different spreadsheet files, if desired.

Note: This option is only available for data created in 384-well or
1536-well formats.

Table 3-24: Export Statistics Options (continued)

Exporting Group Statistics

Use the Export Group Statistics tab to configure a group statistics export report, for
example, average, standard deviation and z-scores, based on the kinetic reduction types
defined for a select number of reads as set up on the Analysis screen.

Note: If there are no groups defined on the Analysis screen, an empty report exports.

Options Description

Enable Group Statistics Check this box to have a group statistic file created.

File Name Options Choose a name for the exported group statistic file.

Use name of data file—Export files with the data or protocol file
name, with *.gstatn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.gstatn extension, where
n is an integer ≥ 1.

Table 3-25: Export Group Statistics Options
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Options Description

Kinetic Reduction Configures the parameters used to define the kinetic reduction.

Reduction Type—Defines the reduction to be applied to the kinetic
data traces exported. See Kinetic Reduction Types on page 81 for
details.
Start Read—Define the first read to be used to determine the kinetic
reduction.
End Read—Define the last read used to determine the kinetic
reduction.
Read Mode—Select the read mode to apply the kinetic reduction.

Misc. Parameters Select experiment parameters to export with the data.

Table 3-25: Export Group Statistics Options (continued)

Batch Exporting

Note: Batch Export does not support the separately licensed analysis module
ScreenWorks Peak Pro Software version 2.0.

Manual export of files is accessed through File > Export, File or Batch Export.Manual
Export allows the same files as defined above to be exported.

Options Description

Export Directory User defines where export files are to be sent. The default
export folder is:

C:\Documents and Settings\[your_user_name]\My
Documents\Molecular Devices\ScreenWorks\MyData

Batch Export Following Files Selecting Add opens the Open File dialog to choose data files
to be exported.

Note: Hold down the SHIFT or CTRL key to select data files.

Correction Options During export, either the existing or new corrections can be
applied.

Use corrections already applied in each data file—Applies
the existing corrections saved with each data file during
export.
Use same corrections for all files—Applies and saves new
corrections to all data files. Useful when exporting all data
files with same parameters or saving the same correction to
multiple data files. Details regarding available corrections
can be found under Corrections on page 91.

Table 3-26: Batch Export Options
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Options Description

If an error occurs while trying to
export a file, do the following

Put up an error message and let me decide what to do—
Enables the user to decide how to proceed when an error is
encountered.
Skip the file—Does not include the data in the export, but
continues to export data. The option to write the error to a
log file is available.

Table 3-26: Batch Export Options (continued)

When batch exporting data, the export files produced vary depending on the options you
select in the individual export statistic, time sequence and group statistic sections. If a single
export file is needed for each data file exported, select Use name of data file in the
respective section you want to export. Export files created using this method are labeled with
the name of the data file from which it was created. However, if a single export file is needed
that contains information for multiple data files, select Use user-defined name in the
respective section. In this instance, all exported information combines into one file labeled
with the desired user-defined name. When the file is open, the individual data file names
which the information was exported from are used as the header for each data set within the
export file.

Image Display
Use the Image Display dialog, opened from the Analysis process page, to view images saved
in data files when Save Images was enabled during a Read with TF step. This option stores a
total of 100 images per experiment; the number of images per dispense is user-defined. The
default is set to one image before and nineteen images after the fluid addition is initiated.
Saved *.tif files can be played back in sequence, frame-by-frame or as a video.
Image Display is useful for diagnosing problems. For example, if cells are blown off during a
fluid dispense, you see dark holes in themiddle of the cell layer after the fluid addition. If the
entire well decreases in relative light units, it is likely that extracellular dye has been diluted.

Notes
In protocol files, open the Protocol Notes dialog where you can enter comments that you
want kept with all data files generated with the protocol. The dialog contains a simple text
editor for you to format your comments.
In data files the same dialog shows the comments that were added in the protocol file, now
in read-only format, so they cannot be edited.

Transfer Fluid Process

This process enables you to program reagent or cell additions and to execute them in
conjunction with other processes.
The default protocol has one Transfer Fluid process.
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A blue Transfer Fluid icon indicates that the process occurs in series with other blue-colored
processes in the protocol. A purple icon indicates that the execution of the process is
synchronized to a Read orMix Fluid process, which also has a purple icon.
The Transfer Fluid process has different options for pin tools and standard pipettors. In each
case you must configure aspiration and dispense of compound separately.
For a standard pipettor you can configuremore than one aspiration or dispense (but not
both) within the process, with the appropriate ‘multiple’ Fluid Transfer Type.
With a standard pipettor selected, aspiration and dispense steps are configured by selecting
the appropriate row in the aspiration or dispense table and pressing the Edit button to open
a configuration dialog. With the Pin Tool, aspiration and dispense configuration is done
directly in the Transfer Fluid page.
To enable additional dispense steps with a standard pipettor, select themultiple dispense
option in the Fluid Transfer Type. Then configure the first dispense with a volume less than
the volume aspirated. An additional dispense is automatically enabled for the remaining
volume. Similarly, for multiple aspirates, configure the first aspirate with less volume than
the dispense.

Note: The entire volume of fluid aspirated is always dispensed.

Aspirate Configuration (Standard Pipettor)
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Option Description

Fluid
Transfer
Type

Select a type of fluid transfer:
Single Aspirate–Single Dispense—Aspirates one liquid volume and dispenses that
entire liquid volume in one action into a plate.
Single Aspirate–Multiple Dispense—Aspirates one liquid volume and dispenses up
to four distinct liquid volumes into four distinct quadrants or plates. Add additional
dispenses by making the dispense volume less than the aspirate volume.

Note: The last dispense expels all liquid remaining in the tip. Tips to improve Single
Aspirate–Multiple Dispense (by quadrature) pipetting precision include:
* When pipetting do not use hold and expel volumes. In addition use the slowest
removal speed (2 mm/s).
* Aspirate 5–10% more than is needed from the source plate (for example, aspirate
110 µL when dispensing 25 µL into four quadrants.
* Include a mix step with 3 strokes in the desired source plate to pre-wet tips. Mixing
of fluid in the source plate primes the internal walls of the tips, reducing surface
tension between the fluid and tip plastic.

Multiple Aspirate–Single Dispense—Aspirates up to four liquid volumes from up to
four aspirate plates and dispenses entire tip contents into a single plate. To add
additional aspirates, make the aspirate volume less than the dispense volume.

Read Check this box to link a Read process to the Transfer Fluid process.
This automatically adds a Read with TF step to the protocol, and opens the
configuration page for that step.

See Read Process on page 116 for more information about read process options.
Note: This option is required if you intend to read a plate while transferring liquid
during a kinetic cell-based assay (for example, calcium mobilization).

Aspirate Check the check box at the start of a row to activate an aspirate sequence.

IfMultiple Aspirate has been selected as Fluid Transfer Type, enter an aspirate
volume less than the dispense volume to add another aspirate step.
Note: Only checked aspirate sequences are active in the experimental protocol.

Table 3-27: Aspirate Configuration Options for Standard Pipettor Use



Chapter 3: ScreenWorks Software Overview

5069582 B 107

Option Description

Edit Aspirate Configure an aspirate step in the table by selecting it and pressing the Edit Aspirate
button, or double-click on the row. This opens the Edit Aspirate dialog.

Use this dialog to define aspiration parameters reported in the table.
Source Plate—Select the plate from which you want an aliquot of fluid removed.
Typically, this is a plate containing an agonist, antagonist or if the Cell Suspension
option is installed, cells in suspension.
Quadrant—Select quadrant from which volume is aspirated.
Note: Quadrant selection is only available when liquid is aspirated from a plate using
a pipettor head of lower density, for example, 384-well plate using a 96 pipettor
head.
Volume—Enter volume (in µL) to aspirate.
Speed—Enter speed at which to aspirate (in µL/s).
Fill Reservoir Speed—Select the speed with which fill the Cell Reservoir from the
spinner flask.
Drain Reservoir Speed1—Part of the Cell Suspension System. Select the speed with
which to drain the cells from Cell Reservoir to drain destination.
Drain Destination1—Select a destination where cells should be drained from Cell
Reservoir after pipettor aspiration.
Height—Enter distance (measured in µL) from the bottom of the well the tips should
start aspirating.
Note: Tips move downward full volume of aspiration, for example, aspirate 10 µL
with a start height of 35 µL moves the pipettor height to 25 µL after aspiration.
Pipettor head movement helps prevent well overflow when tips are submerged in
the well. If downward pipettor motion is not desired, set tip height to minimum
value. Tip movement downward halts when the tips reach 1/30th well volume.
Hold Volume—Enter size of air gap (in µL) following aspiration. Air gaps prevent
liquid from leaking out of the tip before dispensing.

Edit Aspirate
(continued)

Removal Speed—Enter rate (in mm/s) at which tips are pulled from well
immediately after aspiration. This value is adjusted depending on fluid viscosity or
volume of fluid in the well.
Note: For low volume transfers, a slow up-speed may improve precision.

Put Tips in
Well Before
Read

Check this option to place tips in the read plate prior to beginning read intervals.

This option is suggested for assays in which placing tips below the fluid surface can
prevent excessive turbulence.

Enabling this option helps ensure accurate timing of fluid dispense relative to reads.

1. These options are only available when Cell Reservoir is installed and selected in Source
Plate 3 settings.

Table 3-27: Aspirate Configuration Options for Standard Pipettor Use (continued)



FLIPR Penta High Throughput Cellular Screening System User Guide

108 5069582 B

Dispense Configuration (Standard Pipettor)

Options Description

Dispense Check the check box at the start of a row to activate a dispense
sequence.

IfMultiple Dispense has been selected as Fluid Transfer Type,
enter a dispense volume less than the aspirate volume to add
another dispense step.
Note: Only checked dispense sequences are active in the
experimental protocol.

Edit Dispense Configure a dispense step in the table by selecting it and clicking
Edit Dispense, or double-click on the row to open the Edit
Dispense dialog.

Use this dialog to define dispense parameters reported in the
table.
Target Plate—From the list, select the plate to receive the fluid
dispense. Typically, this is the Read Plate.
Quadrant—Select quadrant from which volume is dispensed.
Note: Quadrant selection is only available when liquid is
aspirated from a plate using a pipettor head of lower density for
example, 384-well plate using a 96-pipettor head.
Volume—Enter volume (in µL) to dispense.
Note: In the last dispense, the entire contents in the tip is
dispensed.

Table 3-28: Dispense Configuration Options for Standard Pipettor Use
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Options Description

Edit Dispense (continued) Height—Enter the distance (measured in µL) from the bottom of
the well the tips should be inserted prior to dispensing.
Note: Tips move upward the full volume of dispense during
dispense, for example, a 10 µL dispense with a start height of
35 µL moves the pipettor to a height of 45 µL after dispensing.
This movement helps prevent well overflow when tips are
submerged in the well. Tips do not move higher than the full
volume of the well.
Height value needsS to be adjusted when transferring from
previous FLIPR Tetra Systems.
Speed—Enter speed at which to dispense (in µL/s). Ideal
dispense speed takes into account the volume added, how fast
the signal increases in response to compounds and strength of
the attached cells at the bottom of the plate.
Expel Volume—Enter an additional volume (in µL) the pipettor
dispenses over the dispense volume. Typically, this value is equal
to the aspirate Hold Volume value.

In a multiple dispense, only the last dispense can have an Expel
Volume.
IfMix Fluid After Dispense is selected, Expel Volume
automatically changes to zero for the dispense associated with
the fluid transfer, to ensure that tips remain in the well prior to
the mix step. However, the expel volume designated in the
dispense is transferred to the Mix with TF step, to help ensure
liquid is properly expelled from the tips after mixing.
Removal Speed—Enter rate (in mm/s) at which tips are pulled
from well immediately after the dispense. This value is adjusted
for fluid viscosity, fluid volume in the well or if the transfer is
performed to a dry well.
Pause in Well—Enter time (in seconds) to pause with the tips in
the wells after dispensing and mixing (if specified) before the
next pipettor move.
Hold pipettor during dispense—Select this check box to hold the
pipettor at your specified dispense height.

Read intervals might occur simultaneously with this step.
Typically, the pipettor is paused during a read to prevent
disturbances in the imaging process.

Table 3-28: Dispense Configuration Options for Standard Pipettor Use (continued)
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Options Description

Mix Fluid After Dispense Check this box to link aMix Fluid process to the Transfer Fluid
process.

This automatically adds aMix with TF step to the protocol, and
opens the configuration page for that step.

See Mix Fluid Process on page 113 for more information about
mixing options.
Note: This option is only available when Fluid Transfer Type has
a single dispense.

Unload Tips after Fluid Transfer Instructs the instrument to unload tips after the Fluid Transfer
process. Typically, this is used when changing the tips during an
experiment or when reducing down-time between
experiments.
Note: This option is only available when Load Tips Position is
selected on the Settings process page. Using this feature also
requires that no source plate is placed in plate position 3 during
the experiment.

Table 3-28: Dispense Configuration Options for Standard Pipettor Use (continued)
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Aspirate Configuration (Pin Tool)

Options Description

Source Plate Select the plate from which you want an aliquot of fluid removed. Typically,
this is a plate containing an agonist or antagonist.

Height Enter distance (measured in µL) from the bottom of the well to place the
pins. The distance equivalent in millimeters is displayed as well.
Float pins—Moves the pipettor down to a position at which the pins should
be 1 mm below the bottom of the wells. As pins come to rest on the well
bottoms additional downward motion of the tip block is absorbed by the tips
moving into the block. This ensures that all pins are submerged in the same
volume of fluid across the plate. The Height is designated as -1.00 mm.

Quadrant Select the quadrant from which volume is aspirated.
Note: Quadrant selection is only available when liquid is aspirated from a
plate using a pipettor head of lower density, for example, 1536-well plate
using a 384 pin tool head.

Down Speed Enter the speed (in mm/s) at which the pin tool is inserted into the source
plate.

Removal Speed Enter the speed (in mm/s) at which the pin tool is removed from the source
plate. The speed of removal determines the volume of fluid remaining on the
pins.
Note: Increasing the removal speed increases the volume of compound on
the pin after aspiration. To decrease the fluid volume, slow down the removal
speed. It is recommended that assay development be done to determine the
volume transferred based on removal speed.

Table 3-29: Aspirate Configuration Options for Pin Tool Use
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Options Description

Pause in Well Enter a duration (in seconds) to hold the pin tool in the source plate after full
insertion and before removal.

Table 3-29: Aspirate Configuration Options for Pin Tool Use (continued)

Dispense Configuration (Pin Tool)

Options Description

Target Plate Select the plate to receive the fluid dispense; typically, the Read Plate.

Height Enter the distance (measured in µL) from the bottom of the well the tips should
be inserted. The distance equivalent in millimeters is displayed to the right of
the µL value.

Quadrant Select the quadrant of the target plate into which compound is to be dispensed.
Note: Quadrant selection is only available when liquid is aspirated from a plate
using a pipettor head of lower density, for example, 1536-well plate using a 384
pin tool head.

Down Speed Enter the speed (in mm/s) at which the pin tool is inserted into the target plate.

Removal Speed Enter the speed (in mm/s) at which the pin tool is removed from the target
plate. The speed of removal determines the volume of fluid remaining on the
pins.

Pause in Well Enter a duration (in seconds) to hold the pin tool in the dispense plate after full
insertion and before removal.

Table 3-30: Dispense Configuration Options for Pin Tool Use



Chapter 3: ScreenWorks Software Overview

5069582 B 113

Options Description

Read Check this box to link a Read process to the Transfer Fluid process.
This automatically adds a Read with TF step to the protocol, and opens the
configuration page for that step.

See Read Process on page 116 for more information about read process
options.
Note: This option is required if you intend to read a plate while transferring
liquid during a kinetic cell-based assay (for example, calcium mobilization).

Mix Fluid Check this box to link aMix Fluid process to the Transfer Fluid process.

This automatically adds aMix with TF step to the protocol, and opens the
configuration page for that step.

See Mix Fluid Process on page 113 for more information about mixing options.

Unload Pin Tool Automatically unload the pin tool after the dispense.

Table 3-30: Dispense Configuration Options for Pin Tool Use (continued)

Mix Fluid Process

Fluid mixing steps can be added to protocols as independent protocol steps,Mix Fluid or
linked to a Transfer Fluid step,Mix with TF. Independent Mix Fluid steps can be configured
to mix fluid in source or read plates, whileMix with TF steps immediately follow the Transfer
Fluid step they are linked to, mixing fluid in the read plate where compound was dispensed.
Different mix options are offered for standard pipettors and the pin tool, described in the
following sections.

Mix Fluid (Standard Pipettor)
Fluid mixing with a standard pipettor consists of a series of aspirations and dispenses in and
out of the tips.
The following table describes the options available on theMix Fluid process page:

Options Description

Mix Plate Select the plate that has the fluid to be mixed. Typically, it is a source plate
from which you transfer fluid.

Quadrant If appropriate, select a quadrant from which fluid is mixed.
Note: Quadrant selection is only available when liquid is dispensed to a
plate using a pipettor head of lower density, for example, 384-well plate
using a 96 pipettor head.

Volume Enter volume (in µL) to mix.

Speed Enter speed (in µL/s) to mix the fluid.
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Options Description

Height Enter distance (in µL) from the bottom of the well that the tips will be
inserted prior to mixing.
Note: Tips move up and down with aspirate and dispense commands.
These movements help to prevent well overflow when the tips are
submerged.

Expel Volume Enter an additional volume (in µL) the pipettor dispenses, beyond the
volume entered in the Volume field above. This helps to ensure that all
fluid is expelled from the tips after mixing.

Strokes Enter number of times to aspirate and dispense mix volume. One stroke is
equal to one aspiration and one dispense.

Removal Speed Enter rate (in mm/s) at which tips are pulled from well immediately after
the mix. This value is adjusted for fluid viscosity or fluid volume in the
well.

Pause In Well Enter time (in seconds) to pause with the tips in the well after mixing and
before the next pipettor head move.

Unload Tips After Mix Automatically unloads tips after the mix step.

Mix Fluid (Pin Tool)
Fluid mixing with a pin tool consists of a sequence of up and down motions of the pin block.

Options Description

Mix Plate Select the plate that has the fluid to be mixed. Typically, it is a source plate
from which you transfer fluid.

Top Height Enter the height (in µL) for the top of the stroke during mixing.

Quadrant If appropriate, select a quadrant in which fluid is mixed.
Note: Quadrant selection is only available when liquid is dispensed to a
plate using a pipettor head of lower density, for example, 1536-well plate
using a 384 pipettor head.

Bottom Height Enter the height (in µL) for the bottom of the stroke during mixing.

Strokes Enter the number of times the pins move within the mix step. One stroke
is equal to one up-stroke and one down-stroke.

Down Speed Enter the speed (in mm/s) of the down-stroke.

Removal Speed Enter rate (in mm/s) at which pins are pulled from the well immediately
after the mix. This value is adjusted for fluid viscosity or fluid volume in
the well. The speed of removal determines the volume of fluid remaining
on the pins.

Up Speed Enter the speed (in mm/s) of the up-stroke. This is not the rate which pins
remove from the well.
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Options Description

Pause in Well Enter a duration to hold the pin tool in the well plate once mixing is
completed, before withdrawal.

Unload Pin Tool Check to have the pin tool unloaded after mixing.

Mix With TF
Fluid can bemixed immediately after dispense to ensure proper mixing of agonists and
antagonists with the cell monolayer. Typically, this is necessary when transferring fluids
one-tenth or less of the total fluid volume of a well.
To add a mix after dispense, check theMix After Fluid Dispense (Mix Fluid for the Pin
Tool) option in the Transfer Fluid process dialog. This inserts a mix step and theMix Fluid
process icon turns purple, indicating that mixing occurs immediately after dispense and
concurrently with a Read process, if selected.

Note: Any Expel Volume configured in the dispense step prior to a mix is locked ifMix
Fluid After Dispense is selected. Tips are raised during Expel Volume, but this could
lead to inadequatemixing, so mixing occurs with the tips at the level they finish the
basic dispense at, and Expel Volume occurs after mixing is completed.

Mixing parameters for aMix with TF are similar to aMix Fluid process, howeverMix
Plate, Quadrant, Hold Volume and Tip Up Speed, are not configurable. These
options can only be accessed in the Transfer Fluid process to which themix is linked.

To remove aMix with TF process, deselect it in the Transfer Fluid process dialog.
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Read Process

Read steps can be added to protocols as independent protocol steps, Read or linked to a
Transfer Fluid step, Read with TF. Configuration options for the two types of step is similar,
except Read with TF allows you to time the read precisely with the time that compound is
dispensed, and it also gives you the option to save the images used to measure the
response.

Note: When using the HS EMCCD camera, depending on your Protocol > Settings >
Edit read mode > Camera Mode setting, when using a fast Read time interval value,
the platematrix panel updating might be delayed until the end of the data acquisition
rather than updating during the data acquisition.

Specifically, the following settings result in the platematrix panel updating at the end
of the data acquisition:
For Camera Mode > HighSpeed—a Read time interval(s) setting of 0.018 seconds or
shorter
For Camera Mode > Normal or Sensitivity—a Read time interval(s) setting of 0.029
or shorter

For Camera Mode setting details, see Edit Read Mode on page 73.

Read
To add a Read process to a protocol that is independent of a liquid transfer, drag the Read
process icon from the Process Explorer to the Experiment window. The Read process page
opens when the icon is released. When added to the protocol, the icon is orange, indicating
it is an optics function and occurs in parallel with fluid processes during the experiment.
A Read consists of a sequence of images taken at a predefined rate, from which relative light
values for each well aremeasured. A single Read process can be divided into two intervals
with different read rates. Typically this is used to take images at a high rate while compound
is being added, and shortly thereafter, to best capture kinetic effects, then images can be
taken at a less frequent rate as cells settle and less change occurs.

Note: The read rate you configure for the Read process is the same for all the read
modes you have enabled. For example, if you set the Read Interval at one second,
and have two read modes, two images are taken every second—one for each read
mode.
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The following table describes the setting options in the dialog:

Options Description

First Interval Configure the first series of reads taken during the Read process.

Read Interval—Enter time (in seconds) between reads. The same interval is used
for each read mode (for example, the instrument takes images twice as fast if a
second read mode is enabled).
Note: Time should be no less than exposure time plus read-out time (see Setup
Read Mode on page 73 for more information). If it is less, then the experiment
speed is determined by the capability of the computer.
Number of Reads—Enter the total number of reads to be taken in the first
interval.

Second Interval Configure the second series of reads taken during the Read process. To skip a
second series with a different read interval, make Number of Reads zero.

Read Interval—Enter time (in seconds) between reads. Must be a multiple of the
first read time (for example, if read interval 1 is 1 second, then read interval 2
should be 2 seconds or 3 seconds).
Note: Time should be no less than exposure time plus read-out time (see Setup
Read Mode on page 73 for more information). If it is less, then the experiment
speed is determined by the capability of the computer.
Number of Reads—Enter the total number of reads to be taken in the second
interval.

Table 3-31: Read Process Configuration Options Dialog
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Read With TF
Plate reading concurrent with fluid transfer is necessary to collect data for kinetic cell-based
assays as the response time is very rapid. To link a Read process to a Transfer Fluid process,
select Read in the Transfer Fluid page. Inserting a read this way turns the Read process icon
purple, indicating that the read occurs concurrently with liquid addition.
Read with TF configuration is similar to that of an independent Read process, but with the
addition ofmore options; Number of Reads Before Dispense and Save Images.

Note: To remove a Read With TF process, deselect the Read option in the Transfer
Fluid process dialog.
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The following table describes the setting options in the dialog:

Options Description

Number of Reads Before Dispense Enter the number of reads to be taken before fluid is added to
the plate. This provides a cellular response baseline before the
addition of agonist or antagonist. Number of Reads Before
Dispense is included in the total number of first interval reads
entered in the Number of Reads field, for example, if the
Number of Reads is 60 and the number of Reads Before
Dispense is five, there are 55 reads after the dispense is
initiated.

Number of Reads After Dispense Enter the number of reads to be taken after fluid is added to
the plate. This captures the cellular response after the addition
of agonist or antagonist. Number of Reads After Dispense is
included in the total number of first interval reads entered in
the Number of Reads field

Save Images When checked, up to 100 images are saved in an image file
(*.tif) associated with an experiment. These images can be
used for more than one dispense as long as the total images
saved do not exceed 100 for the experiment.

Number of Images Before Dispense—Enter the total number
of images to be saved prior to initiating the dispense.
Number of Images After Dispense—Enter the total number of
images to be saved after initiating the dispense.

By default one image prior to and nineteen after dispense are
saved for review in Image Display on page 104.
Note: Images may be useful to troubleshoot problems with
your cell plate such as cells detaching during fluid dispense.

Wash Tips or Pins Process

This process is normally used to eliminate unwanted agonist or antagonists prior to another
addition within an experiment or between experiments. In many cases, it reduces
consumable costs and downtime associated with replacing tips.
For standard pipettors, tips are inserted into the wash location and wash fluid aspirated and
dispensed. This can be done a number of times (strokes) in the samewash fluid, then the
whole process repeated up to five times (wash cycle) with fresh wash fluid.
For the pin tool, up and down motion is used to force fluid in and out of the capillary slot of
the pins. A typical wash protocol uses an initial solvent to remove compound from the pins,
followed by a second solvent to remove the first solvent. It is recommended that pins are
blotted at a blotting station to remove excess liquid from the pins between washes.
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Wash Tips (Standard Pipettor)

Options Description

Fluid Type Select the fluid in the wash reservoir during tip washing, from
wash fluid container A or B.

Pump Speed Select the speed (slow or fast) you want the pump to fill and
empty the wash reservoir.
Note: Molecular Devices recommends you use Fast except
with volatile solvents.

Wash Cycles From the list, select the number of times that fluid cycles
through the wash reservoir. For each cycle, the pipettor
executes the number in the Strokes field.

Strokes From the list, select the number of times to aspirate and
dispense wash fluid.

Volume/Stroke Enter the volume (in µL) of fluid to be aspirated and then
expelled for each stroke.

Hold Time Enter the length of time (in seconds) to pause between
aspirating and expelling fluid.

Aspirate Speed From the list, select the speed (in µL/s) to aspirate fluid.

Table 3-32: Wash Tips Configuration Options for Standard Pipettor Use
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Options Description

Dispense Speed From the list, select the speed (in µL/s) to dispense fluid.

Unload Tips After Washing Check this option to have tips removed from the pipettor head
after washing is complete.

Table 3-32: Wash Tips Configuration Options for Standard Pipettor Use (continued)

Wash Pins (Pin Tool)

Options Description

Fluid Type Select the fluid in the wash reservoir during tip washing, from wash fluid container
A or B.

Pump Speed Select the speed (slow or fast) you want the pump to fill and empty the wash
reservoir.
Note: Molecular Devices recommends you use Fast except with volatile solvents.

Wash Cycles From the list, select the number of times that fluid cycles through the wash
reservoir (up to 5). For each cycle, the pipettor executes the number in the Strokes
field.

Strokes From the list, select the number of times to raise and lower the pins. One stroke is
equal to one upstroke and one down-stroke.

Down Speed Set the speed of the pin tool during the downstroke.

Table 3-33: Wash Pins Configuration Option for Pin Tool User
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Options Description

Stroke
Distance

Set the height of one stroke that the pin tool travels.

Up Speed Set the speed of the pin tool during the up-stroke.

Removal
Speed

Set the speed that the pin tool is withdrawn from the wash location. The faster the
withdrawal speed the more fluid remains on the pins.

Pause in Well Set a time to hold the pin tool at the bottom of the wells in the wash solution after
the wash is completed.

Unload Pin
Tool After
Wash

Check to have the pin tool removed after washing is complete.

Table 3-33: Wash Pins Configuration Option for Pin Tool User (continued)

Blot Pins Process

The Blot Pins process is only available for the pin tool. This function is used to dry the pins
between transfers or washes, to prevent carry-over.
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Options Description

Target Plate Select the plate.

Height Enter distance (measured in μL) from the bottom of the well to
place the pins. The distance equivalent in millimeters is displayed
as well.

Float pins—Moves the pipettor down to a position at which the
pins would be 1 mm below the bottom of the wells. As pins come
to rest on the blotting surface additional downward motion of the
tip block is absorbed by the tips moving into the block. This
ensures that all pins are in contact with the blotting surface. The
Height is designated as -1.00 mm.

Pause in Well Enter a duration during which the pin tool is held motionless at
the set height.

Unload Pin Tool After Blot Automatically unload the pin tool once blotting is complete.

Table 3-34: Blot Pins Configuration Options

Pause Pipettor Process

Pause Pipettor steps are included in a protocol to prevent future pipettor motion until the
pause is complete. Read processes can continue to execute, unless stopped by the linked
action “read with transfer”. This can be useful to stop the pipettor from picking up
compound if it sits for an extended period in the air. Also, it can be used to provide time for
solvents (such as EtOH) to evaporate off the pins after a wash.
This process has only one configurable setting, the duration of the pause, entered in
seconds.



FLIPR Penta High Throughput Cellular Screening System User Guide

124 5069582 B

Wash Cell Reservoir Process

This process is only available when the Cell Reservoir is installed and is recommended for use
before and after using cells in suspension.
This process can be used as a way of priming the reservoir with cells prior to an assay or for
cleaning purposes.
No pipetting is associated with this step.
The following table describes the options available in theWash Cell Reservoir process page.

Options Description

Pre-coat Tubes Select to pump the fluid up to the sensor before filling the reservoir.

Fluid Source Select which fluid to use for the wash process. All Fluid 1–4 bottles
are available as well as the Cell Flask.

Drain Reservoir Destination1 Select a drain destination for the fluid left in the reservoir after the
wash. Waste bottles, Cell Flask, or any of the Fluid bottles are
available.

Fill Reservoir Speed1 Select a pump rate for filling the Cell Reservoir; the range is 1–10.

Drain Reservoir Speed1 Select a pump rate for draining the Cell Reservoir; the range is 1–10.

Wash Cycles Set how many wash cycles with the above settings should be done.

Hold Time This option soaks the reservoir in the pumped fluid by leaving the
fluid in the reservoir for a specified time; the range is 0–300 seconds
(0–5 minutes).

1. This option is only available when the Cell Reservoir is installed and selected as the
source plate for aspiration.

Finish With Source Process

In Remote Mode, the Finish with Source process instructs the instrument to notify the
robot controller to remove the desired source plate. This option is required when using
multiple plates in a single source location.

Note: This process is not active inManual Mode or for the read plate position.

Creating New Protocols

In the ScreenWorks Software, creating a protocol involves combining processes represented
in the protocol builder as colored block icons at the top of the Experiment window. The
available processes depend on your instrument configuration. See Instrument Configuration
Tab on page 69. The color of the process icon depend on the function in the protocol. See
Protocol Process Icon Colors on page 71.
A red box around the process in the protocol list indicates the process selection and indicates
which configuration settings dialog is open.
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Figure 3-9: Example New Protocol Build
Protocols contain combinations of the following processes. Available options depend on the
components installed in your instrument.

Settings—required for every protocol, automatically included at the beginning of every
new protocol file, and cannot be removed.
Analysis—required for every protocol, automatically included at the beginning of every
new protocol file, and cannot be removed.
Transfer Fluid—automatically included in new protocols and have the following
selectable linked processes:

Read with TF—automatically included in new protocols after Transfer Fluid, and
timed precisely to coincide with compound addition to the read plate. This setting
can be deselected from within the Transfer Fluid configuration settings dialog.
Mix with TF—optional selection within the Transfer Fluid configuration settings
dialog.

Mix Fluid
Wash Reservoir—only available when the Cell Suspension option is installed.
Wash Tips—available only with pipettor configuration.
Wash Pins—available only with pintool configuration.
Blot Pins—available only with pintool configuration.
Pause Pipettor
Finish with Source
Read

To create a new protocol:
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1. Open the Process tab panel. See Process Tab on page 70.
2. In the Process tab panel, add the assays steps. Do one of the following:

To place the new process at the end of your developing protocol list, drag and drop
the process anywhere in the Experiment window.
To place the new process somewhere specific in your developing protocol list, drag
and drop the process where you want it. You are notified when the position is
invalid.

3. When the configuration screen opens for the added process, adjust settings as needed.
See Understanding Processes on page 72.

4. Repeat steps 2 and 3 until you are finished building your protocol.
5. Define the Analysis parameters.

Click the Analysis process, and then click Grouping, Correction, and Export to specify
the analysis parameters for the experiment data. See Analysis Process on page 78.

6. Click on any other process icon to open its configuration screen and make changes as
needed.

Note: When using the HS EMCCD camera, depending on your Protocol > Settings
> Edit read mode > Camera Mode setting, when using a fast Read time interval
value, the platematrix panel updating might be delayed until the end of the data
acquisition rather than updating during the data acquisition.

Specifically, the following settings result in the platematrix panel updating at the
end of the data acquisition:
For Camera Mode > HighSpeed—a Read time interval(s) setting of 0.018 seconds
or shorter
For Camera Mode > Normal or Sensitivity—a Read time interval(s) setting of
0.029 or shorter

7. Select File > Save.
8. In the Save As dialog, in the File name field, type a name for your protocol, and then

click Save.

Tip: Protocol files are saved as an *.fmp file. Unless you change the Save in
location for your protocols, the default save location is C:\Documents\Molecular
Devices\ScreenWorks\MyProtocols.

9. Run your experiment.
Refer to the FLIPR Penta High-Throughput Cellular Screening System Protocol Guide for
specific protocol settings.
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Deleting Processes from the Protocol

Protocol processes are either linked to the Transfer Fluid process or not linked.
To delete processes that are not linked:

In the protocol list, select a non-purple process icon, and then on your keyboard, press
DELETE.

To delete a Transfer Fluid linked process:
1. In the protocol list, select the purple Transfer Fluid icon.
2. In the configuration settings dialog, deselect the linked process you want deleted, either

Read orMix Fluid.

Figure 3-10: Transfer Fluid Configuration Settings Dialog With Linked Processes

Opening Protocols

If you have saved protocol files to use, you can open an existing protocol file, rather than
create a new one in the ScreenWorks Software.
To open a protocol file:
1. Select File > Open > Protocol File.
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2. In theOpen dialog, select your protocol file name, then click Open.

Deleting Protocols

You cannot delete a protocol from within ScreenWorks Software.
To delete a protocol:
1. In yourWindows File Explorer navigate to where the protocols are saved.

Tip: During the creation process, unless you changed the Save in location for your
protocols, the default location for all of your protocol files is
C:\Documents\Molecular Devices\ScreenWorks\MyProtocols.

2. Select the *.fmp file you want removed, and then on your keyboard, press DELETE.

Saving Data Files as Protocol Files

Protocol information stored in data files (*.fmd) cannot be edited, nor used to run a new
experiment; however, you can extract this information to a new protocol file. Experiments
run using this new protocol file have exactly the same protocol steps as used to create the
data file.

Tip: When using a protocol file (*.fmp), you can add, remove, or change processes in
the file, then save the amended protocol and run it.

To store a data file as a protocol file:
1. Select File > Save As.
2. In the File name field, type a protocol name.
3. In the Save as type field, select Protocol Files (*.fmp) option and click Save.

The stored file is stripped of all data and only associated protocol information is stored in
the protocol file.
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Note: Saved changes only affect the protocol. The data file from which the protocol
was derived remains intact.
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Chapter 4: Calibrating and Signal Testing

The following procedures and information are required to calibrate the optics and run a
signal test of the FLIPR Penta System:

Calibrating Optics
Running Signal Tests on page 135

Calibrating Optics
Calibrating the optics of your FLIPR Penta System requires taking an image of the 96-well,
384-well, or 1536-well plate and using it as a mask to locate the wells. Typically, calibrations
are run with the following procedures:

After exchanging LED banks. See Exchanging LEDModules on page 198.
After exchanging the pipettor or pin tool head. See Installing the Pipettor or Pin Tool
Head on page 190
After a new plate is added to the plate library. See Adding a Read Plate to Plate Library.
After a new filter is added to the system. See Exchanging Filters on page 201.

Adding a Read Plate to Plate Library

The FLIPR Penta System has default platemasks for 96-well, 384-well, and 1536-well read
plate types. If you want to use a plate type that varies significantly from the default formats,
you must create new dimensions and mask for that plate type. Use the description of the
Plate Library menu item, see Plate Process Definition on page 59, as a reference guide for
options and parameters available when adding a plate to the software.
To add a plate and mask to the software:
1. Prepare a 1 x 10-8M fluorescein solution.
2. Ensure themicroplate bottom is clean and free of scratches and dust.
3. Dispense enough fluorescein solution into each well so as to cover the bottom.

Dispensing half of the total well volume is typically a safe volumewith which to work. Use
the FLIPR Penta System pipettor.

4. Place themicroplate containing fluorescein in the read position and select Plate Library
from the Toolsmenu.

5. From the Plate Process Definition list, select a plate with a similar well format.
6. Click Copy Plate.
7. Enter the Plate Specifications:

Enter a Plate Name.
Select Read Plate as the Plate Type.
Type in the plate dimensions.

8. Click Finish to create a new read plate with mask.
The platemask definition is complete when the green Assay Finished (Unlocked) light
illuminates on the instrument door.

4
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Calibrating the Optics

FLIPR Penta System identifies the serial number, wavelength range and position of each LED
bank present in the instrument. This information, in addition to the wavelength range for
the emission filters, is stored with the system calibration files. Any time you change LEDs or
emission filters in the FLIPR Penta System, you must recalibrate the Flat-Field Calibration files
for the new LED/Filter pairs. The following procedure steps you through the process of
calibrating the system optics.

Tip: Due to the improved light tightness of the new FLIPR Penta System, the
background correction calibration available in the previous versions of this software
used with black bottom plates is no longer required.

If you have any questions or concerns regarding the calibration procedure, contact
Molecular Devices Technical Support. See Obtaining Support on page 226.

Excitation LED

The Excitation LED Calibration is needed only if the LED Calibration Status shows NotDone
when you select to use the 335–345 nm/475–535 nm (340 LEDModule).
To run an Excitation LED Calibration:
1. Select Instrument > Calibration, or click on the Calibration icon.

The Calibration dialog displays a list of the Excitation/Emission Wavelength (LED/Filter)
combinations for the installed modules, and corresponding status, LED Calibration
either Done orNotDone, and Flat-Field Calibration either Done orNotDone.

2. Select 335–345 nm/475–535 nm.
3. Click Excitation LED Calibration.
4. When the progress bar dialog closes, continue with Flat-Field Calibration. See Flat-Field

Calibration on page 132.

Flat-Field Calibration

Before adjusting your exposure settings, you first need to have an accurate flat-field
calibration. This calibration is used to correct for light falloff at the corners of the camera lens,
and to correct for any gradients or falloff in the coverage of the light module. When an
accurate flat-field correction is applied, the well values for all wells give the same count value
for the same stimulus.

Tip: When testing for HS EMCCD saturation in the Signal Test dialog, keep this flat-
field correction in mind, because the central values hit saturation first, while the outer
values continue to get larger as the exposure increases to beyond themaximum
camera sensor limit, because they are being multiplied by the correction factor.
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During a fluorescence assay, microplate illumination results in imperfect, non-uniform
excitation distribution on themicroplate surface. In the FLIPR Penta System, light
distribution is more intense in themiddle of themicroplate than the edges, therefore a
flat-fielding algorithm is applied to themicroplate image to compensate for variations in light
intensity across themicroplate.
During luminescence assays, LEDs are not used. Flat-field corrections are preset during
installation and do not require any adjustment.
To run Flat-Field Calibration:
1. Select the Instrument > Calibration, or click on the Calibration icon.

The Calibration dialog displays a list of the Excitation/Emission Wavelength (LED/Filter)
combinations for the installed modules, and corresponding calibration status for Flat-
Field Calibration, either Done orNotDone, and LED Calibration of the selected Plate
Format.

Note: None indicates either no LEDs are illuminated or the instrument used a
blank emission filter position to create the calibration file.

2. Select a Plate Format (96, 384, or 1536).
3. Select the Excitation/Emission Wavelength pair with theNotDone status from the

Calibration Status list.
4. Place the Flat-Field Calibration Plate into the Read Position.

The provided Yellow Plate can be used to Flat-Field calibrate the following
Excitation/Emission Wavelength pairs:

335–345 nm/475–535 nm
380–390 nm/475–535 nm
390–420 nm/565–625 nm
420–455 nm/475–505 nm
420–455 nm/515–575 nm
470–495 nm/515–575 nm
470–495 nm/565–625 nm
495–505 nm/526–586 nm
510–545 nm/565–625 nm
610–626 nm/646–706 nm

The following dye should be used to calibrate the respective Excitation/Emission
Wavelength (LED/Filter) pair:

360–380 nm/400–460 nm with MQAE. SeeMQAE on page 134.
390–420 nm/440–480 nm with Coumarin. See Coumarin on page 134.

5. Click Flat-Field Calibration.
6. After the Assay Finished (Unlock) light illuminates on the instrument, and the

Excitation/Emission Wavelength status shows Done in the Flat-Field Calibration
column, click Close to exit.

7. Place your yellow signal test plate of the appropriate well format into your instrument.



FLIPR Penta High Throughput Cellular Screening System User Guide

134 5069582 B

8. Run a signal test by selecting Instrument >Manual Operation > Yellow Plate Signal

Test, or using the corresponding button. The yellow plate standard deviation should
be 5% or less. See Running the Yellow Plate Signal Test on page 136.

Coumarin

Required material:
Black clear-bottom plate of needed format and brand for assay (96, 384, or 1536)
Coumarin (7-diethylaminocoumarin-3-carboxylic acid)
Catalog # 36799-100MG-F, Sigma-Aldrich

To run a Coumarin calibration:
1. Make a 0.02M stock solution of Coumarin in Dimethyl Sulfoxide (DMSO). Mix by

vortexing tube.
2. Store small aliquots at -20°C ( -4°F).
3. Within one hour of calibration, thaw an aliquot and make 20 mL 10-5M solution in the

same buffer to be used for dye loading. Adjust pH to 7.4. Mix by vortexing.
4. Pipette a uniform quantity of the Coumarin solution into each well of themicroplate. The

volumemust be adequate to cover the bottom of the well uniformly. The following
quantities are recommended:

96-well plate, 100 μL/well
384-well plate, 40 μL/well
1536-well plate, 6 μL/well

5. Check the plate visually to make sure there are no bubbles or unfilled wells. Shake or tap
themicroplate to dislodge any bubbles. Keep the Coumarin plate covered and in the
dark until used.

6. Use the Coumarin plate as the Flat Field Calibration Plate in Flat-Field Calibration on
page 132.

MQAE

Required material:
Black clear-bottom plate of desired format and brand for assay (96, 384, or 1536)
MQAE (N-(ethoxycarbonylmethyl)-6-methoxyquinolinium bromide)
Catalog # 46123-100MG-F, Sigma Aldrich

To run a MQAE calibration:
1. Make a 0.02M stock solution ofMQAE in distilled water. Mix by vortexing tube.
2. Store small aliquots at -20°C ( -4°F).
3. Within one hour of calibration, thaw an aliquot and make 20mL 10-5M solution in water

or in a chloride-free buffer to be used for dye loading. Adjust pH to 7.4. Mix by vortexing.
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4. Pipette a uniform quantity of theMQAE solution into each well of themicroplate. The
volumemust be adequate to cover the bottom of the well uniformly. The following
quantities are recommended:

96-well plate, 100 μL/well
384-well plate, 40 μL/well
1536-well plate, 6 μL/well

Note: Check the plate visually to make sure there are no bubbles or unfilled wells.
Shake or tap themicroplate to dislodge any bubbles. Keep theMQAE plate
covered and in the dark until used.

5. Use theMQAE plate as the Flat Field Calibration Plate in Flat-Field Calibration on page
132.

Running Signal Tests
Run the following signal tests, as specified:

Once a day, to check the system optics calibration, run the Yellow Plate Test. See
Running the Yellow Plate Signal Test.
Before running an experiment, to verify your protocol setting performance, run the
Protocol Signal Test. See Running a Protocol Signal Test on page 138.

Tip: For the HS EMCCD camera using the HighSpeed or the Sensitivity camera
mode, run a Protocol Signal Test to determine your saturation level for your
biology and adjust your exposure settings accordingly. This is important because,
after a 4 times overexposure increase, there are no oversaturation warning
messages from this camera.
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Running the Yellow Plate Signal Test

Use the Yellow Plate Signal Test once a day to verify that the system optics are calibrated.
Additionally use the Yellow Plate Signal Test after you recalibrate or change the optics.
To run a Yellow Plate Signal Test:
1. Place the yellow signal test plate on the stage in the read position.
2. In the ScreenWorks Software, select Instrument > Manual Operation > Yellow Plate

Signal Test or click Yellow Plate Signal Test.

Figure 4-1: Yellow Plate Signal Test Dialog
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3. Set the following parameters:
a. Select the correct plate from the Select Plate list.
b. Select Reading Mode > Fluorescence only.

CAUTION! Although both Fluorescence and Luminescence are available
options in the test dialog, currently there is no easy way of testing signal
strength in Reading Mode > Luminescence.
Do not run any Reading Mode > Luminescence signal tests.

c. Select the appropriate Excitation/Emission Wavelengths.
d. Set the Excitation Intensity to 50.
e. Set the Exposure Time to 0.1 seconds.
f. Adjust the following variable camera settings:

For the EMCCD camera, set the Camera Gain to 80.
For the ICCD camera, set theGate Factor to 6%.
For the HS EMCCD camera:

In Camera Mode > Normal, set the Camera Gain to 1.5 and the Exposure
Time to 0.005 seconds.
In Camera Mode > HighSpeed, set the Camera Gain to 20 and the Exposure
Time to 0.001 seconds.

4. Take a picture by clicking Test Signal.
When the instrument is calibrated with the yellow test plate for the appropriate plate
format and optics, normal test plate results are a relative standard deviation less than
5%.
If the test results are abnormal values, look at the Image Display for any anomalies on
the plate. For additional information see, Troubleshooting on page 209.

5. Print the results and keep them in a “Maintenance” folder by the instrument to track the
standard deviation of the yellow signal test plate over time.

Note: The Yellow Plate Signal Test and Image Display results are not saved
within a data file.

Alternatively, you can save the files on the hard drive in the signal test directory
(C:\Documents and Settings\[your_user_name]\My Documents\Molecular
Devices\ScreenWorks\MySignalTests) as a *.sig file, which can be opened in third-party
spreadsheet software.

Note: The relative standard deviation should be less than 5% if the flat-field calibration
was performed using the Flat Field Calibration Plate of the respective plate format
(96-wells, 384-wells, or 1536-wells). See Flat-Field Calibration on page 132.
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Running a Protocol Signal Test

Use the Protocol Signal Test to optimize the camera settings used in your florescence assay
protocols. Adjustments made to the settings in this test can be saved within your protocol.
Refer as needed to the fluorescence signal recommendations in Optimizing Optics Hardware
on page 151.

CAUTION! Although both Fluorescence and Luminescence are available options in the
test dialog, currently there is no easy way of testing signal strength in
Reading Mode > Luminescence.
Do not run any Reading Mode > Luminescence signal tests.

To run a fluorescence protocol signal test:
1. Place your cell plate on the stage in the read position.
2. In the ScreenWorks Software, open a fluorescence assay protocol you want to test.

3. Click Protocol Signal Test.
4. Click Test Signal.
5. Review the results and change settings as needed in the Protocol Signal Test dialog.

Depending on the installed camera and the read mode, different parameters are
available for adjusting the signal strength. See Signal Test Dialog Options on page 55 for
more details.

Figure 4-2: Example Protocol Signal Test Dialog
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6. Depending on the range of values acquired in your results, decide either to run the
experiment or change the Excitation Intensity, Exposure Time, Camera Gain, or Camera
Gate settings.

Tip: For a calcium mobilization assay, Molecular Devices recommends starting
between 200 to 1,500 counts.

CAUTION! When using the HS EMCCD camera, after a 4 times overexposure
increase, there are no warning messages.

7. Click Update to apply the new settings, and click Test Signal to recheck them.
8. To keep the new settings as part of your open protocol, click Save.

Determining Protocol Saturation Levels for the HS EMCCD Camera

When using the HS EMCCD camera HighSpeed camera mode and Sensitivity camera mode,
after about a 4x overexposure level increase, no saturation warning appears. This is a
problem for detecting when the imagemeasurements are saturated, and the system cannot
give a reliable saturation warning for grossly overexposed well signals. For more details, see
Understanding HS EMCCD Camera Protocol Saturation on page 38.
While you create a protocol that uses the HS EMCCD camera HighSpeed camera mode or
Sensitivity camera mode, run a Protocol Signal Test using a cells test plate to determine your
optimal exposure levels.
To determine the optimal exposures for your biology using HighSpeed and Sensitivity
camera mode:
1. Prepare a test plate to check for saturation of your maximum signals with the Protocol

Signal Test. See Running a Protocol Signal Test on page 138.
2. Start with an initial estimated exposure setting, based on experience or as recommended

in the FLIPR Penta High-Throughput Cellular Screening System Protocol Guide, then
adjust your exposure to keep your maximum signals below saturation.

Tip: The gain factors are approximately linear, so reducing the gain by half is
similar to reducing exposure time by half.

3. Click Test Signal to see the exposure setting results.
4. If the test gives you a saturation warning, reduce your exposure by a factor of 4x and test

again.
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5. If the test does not give a saturation warning, click Image Display, and do the following:
See if the image is not showing bright wells, which confirms that you are below
saturation.

Tip: If you are not sure, reduce your exposure by 2x and test again to verify.

See if the image is blooming. If yes, reduce your exposure by a factor of 8x and test
again.

Figure 4-3: HighSpeed Camera Mode Blooming Image Display
See if the image is reversing, showing wells with dark centers and bright outlines. If
yes, reduce your exposure by a factor of 4x and test again.

Figure 4-4: HighSpeed Camera Mode Reversing Image Display
6. When you have a test which is below the saturation level, adjust your exposure linearly

to give an average value that matches your target exposure. Keep themaximum signal
below 43,000 counts.

Tip: If your experiment could have brightness that exceeds your signal test
sample plate, then reduce the exposure accordingly so that your brightest signal
does not exceed 43,000 counts.
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7. Leave enough room above the starting levels so that you can measure your experiment
without camera saturation.

Tip: If you do not expect your signal to drop during the experiment, start as low
as you can to give enough room for the signal to rise without saturation.

8. To keep the new settings as part of an open protocol, click Save.
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Chapter 5: Running an Experiment

The following provides a starting point for setting up and running a kinetic cell-based assay
on the FLIPR Penta System. Refer to the FLIPR Penta High Throughput Cellular Screening
System Protocol Guide for specific assay protocols.
To run your experiment, use the following workflow processes:
1. Preparing Cells
2. Starting the System on page 145
3. Checking the System on page 146
4. Dye-Loading the Cells for Fluorescence Assays on page 146
5. Preparing a Source and Compound Plate on page 147
6. Setting Up an Assay Protocol on page 149
7. Optimizing the Optics and Fluid Dispensing on page 150
8. Starting the Assay Run on page 155

Preparing Cells
Prepare your cells according to the following assay you need to run:

Preparing Cells for Adherent Assays
Preparing Cells for Suspension Assays on page 144

Preparing Cells for Adherent Assays

Location of Cells in the Plate

The excellent signal-to-background noise ratio of the FLIPR Penta System is made possible by
the instrument’s bottom illumination and detection system. The read plate is illuminated by
the LED modules at an angle approximately 45. It is recommended to have cells located at
the bottom of the wells during an experiment. Adherent cells are typically grown overnight in
the cell plate, whereas non-adherent cells are seeded either the night before, on a coated
plate, or the day of an experiment and then centrifuged.

Cell Densities

Cell densities used in fluorescence assays vary because each cell type has different
requirements. Cell densities range from 1,500 to 5,000 cells per well for 1536-well plates,
5,000 to 20,000 for 384-well plates and 20,000 to 80,000 cells per well for 96-well plates.
Non-adherent assays require higher cell densities.
It is necessary to optimize the cell seeding density so that a uniform, 80–90% confluent
monolayer is formed on the day of the experiment. Over- or under-confluent cell monolayer
may result in reduced cellular response to the test compounds.

5
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Cells that are normally maintained in culture at subconfluent levels should be seeded at
relatively low densities. Depending on the individual cell line, attachment matrix-coated
plates (such as the poly D-lysine coated plate)might be required to improve adherence and
minimize cellular “blow-off” during compound addition. Assay development needs to be
performed to determine the optimal seeding density and plate environment for each cell
line.

Cell Seeding

Cells can be seeded in plates using a multi-channel pipettor or a liquid dispensing system. We
recommend seeding a 1536-well or 384-well cell plate using an automatic instrument rather
than seeding manually. Thin needles used in automatic liquid-dispensing instruments
prevent air bubble formation in well bottoms—a problem commonly encountered when
cells are seeded with a manual pipettor. 96-well plates can be seeded by either manual or
automatic methods. Refer to your specific instrument user guide for instructions on how to
dispense cell suspension into wells.
Cells are seeded in clear, flat-bottom, black-wall 1536-well, 384-well, or 96-well tissue culture
treated plates. A flat plate bottom ensures that cellular fluorescence is localized to a single
horizontal plane. Adherent cells typically are seeded one day before an experiment.
Non-adherent cells are either plated one day before on a coated plate or the day of an
experiment. All steps are carried out in the same black-wall 96-well, 384-well, or 1536-well
plate.

Note: Flat-bottom, clear-wall tissue culture plates may also be used with the FLIPR®
Calcium Assay Kit and Membrane Potential Assay Kit. Depending on signal intensity,
either black-wall or white-wall plates can be used when running aequorin assays.

Preparing Cells for Suspension Assays

Location of Cells in the Plate

Suspension cells can be used for luminescence experiments. In this case, cells are kept in
uniform suspension by the Cell Suspension option, which consists of a cell suspension
module and reservoir system. Suspended cells are first pumped to the reservoir and then
delivered to the read plate by the FLIPR Penta System pipettor head.
These assay methods are also described in the literature, for example, in Boie et al., Eur. J.
Pharmacol., 340(2-3):227-241 (1997), and in United States Patent 6,872,536 and European
Patent 1,145,002. Users interested in the patented methods may wish to consult legal
counsel in evaluating these patents.
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Cell Densities

Cell densities in luminescence suspension assays vary. Depending on the bioluminescence
signal from the cells, the density can be adjusted to reach appropriate signal window. Bright
cells can be diluted, while dim cells might require a higher concentration. The suggested cell
densities are 1,000–5,000 cells per well for 1536-well plates, 2,500–10,000 cells per well for
384-well plates, and 5,000–40,000 cells per well for 96-well plates.

Cell Seeding

The size of the experiment dictates the number of cells required. A typical CHO-based
100-plate suspension cell assay requires approximately 250–300 × 106 cells in the suspension
cell flask. This can be accomplished by culturing cells in multiple layer flasks. Cells should be
split 2–3 days prior to the assay and not bemore than 80–90% confluent prior to antibiotic
removal. All flasks should be incubated at 37°C (98.6°F) and 5% CO2. One day prior to testing,
spent media from each flask should be replaced with growth media that does not contain
selection antibiotics.

Starting the System
To ensure proper system function, power the instrument well before you begin an
experiment. The camera requires about fiveminutes to reach operating temperature, and if
you are heating the plate stage , Instrument > Manual Operation > Temperature Control,
allow 15minutes for complete temperature equilibration. View the Instrument Status panel
for the stage temperature.
To start the system:
1. Verify that the appropriate pipettor head, wash reservoir, LED banks and filters are in

place before powering on the instrument.
2. Follow the procedure in Powering On the System on page 18.
3. If incorrect components are installed, see the appropriate section in Exchanging

Hardware Components on page 186 for installation instructions.

CAUTION! Do not attempt to change pipettor heads, wash reservoirs, LED banks
and filters while the instrument is running. All features must be exchanged in the
appropriate instrument mode. When the instrument is started for the first time
after a re-configuration of LEDs or emission filters, optics calibration is required.
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Checking the System
Once a day, before running your first assay plate, do the following system checks:
1. Make sure that the system is turned on and the camera is cooled to proper operating

temperature.
EMCCD camera: -70°C (-94°F) ± 2°C
HS EMCCD camera: -70°C (-94°F) ± 2°C
ICCD camera: - 20°C (-4°F) ± 5°C

2. Run a Yellow Plate Signal Test to ensure the system is operating according to
specifications. See Running the Yellow Plate Signal Test on page 136.
A yellow signal test plate is provided with each corresponding pipettor head supplied
with the system.
A signal test plate only needs to be run once a day unless system components such as
pipettor heads or LEDs are changed.

CAUTION! To avoid damaging the yellow signal test plates:
Avoid scratching the plate bottom because scratches can affect the standard
deviation.
Store the plates in a safe place away from bright light on an even surface.

Dye-Loading the Cells for Fluorescence Assays
Many cell-based responses require fluorescent dye loaded in cells to bind or change
conformation in the presence of a ligand. These changes aremonitored through a shift in
emission wavelengths and captured by a CCD camera. Calcium sensitive dyes, such as the
ones used in Molecular Devices FLIPR Calcium Assay kits, monitor intracellular calcium flux
assays, or environmentally sensitive for membrane potential assays. Depending on the
application evaluated, dye-loading typically lasts from 30minutes to 2 hours, at either room
temperature or 37°C ( 98.6°F).

Dye-Loading Duration and Temperature

Optimal dye-loading time depends on the cell type and presence of an anion exchange
inhibitor. For most cell lines, especially for calcium mobilization assay development, start
with a 60minute to 120minute loading time at 37°C ( 98.6°F).

CAUTION! Avoid exceeding the optimal loading time. If anion exchange inhibition
does not enhance dye-loading conditions, it should not be used.

Tip: If loading for 30minutes yields an acceptable fluorescence signal, as has been
observed for some cell lines, use a shorter loading time.
In some cases, incubation at room temperature can work as well or better than 37°C
( 98.6°F).
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Preparing a Source and Compound Plate

Preparation Time for the Source Plate

Depending on assay complexity, source plate preparation timemay vary. To avoid conflicts,
plan your experiment carefully to ensure source plates are ready before dye loading is
complete.

Recommended Source Plates

Compound conservation can be achieved by reducing dead volumes and minimizing source
plate adherence. Reducing source plate adherence help to ensure proper compound
concentrations are delivered to a read plate. Polypropylene plates aremost commonly used
for this purpose because they are solvent-resistant, can withstand repeated freeze-thaws,
and have a low retention. In addition, proteins are less likely to adhere to polypropylene
plates rather then polystyrene surface.
Manufacturers offer a wide selection of plate bottom shapes (U-, V- or flat bottom) to lessen
dead volumes. Dead volumes decrease as you move from a flat to U- to V-bottom plates.
Contact the platemanufacturer for the dead volume in the plates you are using.

Concentration of Compounds in the Source Plate

Compound concentrations are prepared based on ratio of addition to initial well volume of
the read plate. Common concentrations are 3X, 4X or 5X because ratio of addition to read
plate volumes are 1:3, 1:4 or 1:5, respectively. Volume of addition is dependent on
compound mixing efficiency, cell adherence, and kinetics of cellular response. Assay
development should always be performed to determine optimal addition volume and
concentrations prior to screening.

Addition and Mixing of Compounds to the Cell Plate

Prompt mixing is required to initiate robust cellular kinetics associated with signal
transduction assays. Proper addition parameters (for example, dispense speed, height, and
volume) initiate a rapid response upon addition. Slow signal increases or variation in signal
between wells may be signs that mixing is too slow or not uniform. Optimal addition
parameters typically consist of a fast dispense speed, low pipettor height, and large addition
volume. Assay optimization is always recommended to determine the proper assay
conditions prior to running a screen.
If addition parameters are not optimized, artifacts occur affecting data quality. One common
problem is adding compounds too rapidly. Weakly adherent cells may dislodge from the
monolayer, causing a decrease in fluorescence upon addition. Cell displacement can be
reduced by slowing dispense speed while decreasing addition volume and increasing height.
Larger dispense volumes mix rapidly because they encounter less surface tension as
compared to smaller volumes. However, small sample volumes are less disruptive to a cell
monolayer and reduce compound consumption. To avoid dislodging weakly adherent cells,
compounds should be added in small volumes and at relatively low dispense speeds.
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Tip: Mixing is not typically used during addition in calcium or membrane potential
assays. Signal artifacts, such as additional noise in the fluorescent trace, can be
attributed to cell disruption induced by rapid pipettor movement. However, it is not
uncommon to usemixing before aspirating, to resuspend reagents that have fallen
out of solution in the source plate.

For temperature-controlled assays, cell and source plates should be brought to temperature
outside of the instrument. It takes approximately 45 to 60minutes in a 95% humid, CO2

incubator (15minutes in a heating block) to warm plates to equilibrium at 37°C ( 98.6°F).

Compound Plates for Suspension Assays

Unlike adherent assays, suspension cell assays require cell addition directly to the compound
in the read plates. Compounds are suggested to be prepared at 2X concentration in the
same diluent as used for cells, since equal volumes of cells are added to the read plate
containing the compound.
In 384-well assay 25 μL cells are added to 25 μL 2X compound; in a 1536-well assay 2 μL cells
are added to 2 μL compound. Plates should be stored covered to prevent evaporation.
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Setting Up an Assay Protocol

Tip: Refer to the FLIPR Penta High Throughput Cellular Screening System Protocol
Guide for specific assay protocols.

An effective way to reduce time and ensure consistent screening parameters is to
pre-configure the protocol (*.fmp) files. You can define and save protocol files for each cell
line, project, or user. Saved protocol files are opened from File > Open > Protocol File. In
addition, the last 10 files (6 data and 4 protocol) opened in ScreenWorks Software are listed
in the bottom portion of the Filemenu.
A protocol file defines the following experiment parameters:

Instrument conditions, for example, read mode, plate positions, file names and file
storage
Assay steps, for example, fluid transfer and reads
Analysis options, for example, groups, corrections and export parameters

To create a new protocol:
1. Open the Process tab panel. See Process Tab on page 70.
2. In the Process tab panel, add the assays steps. Do one of the following:

To place the new process at the end of your developing protocol list, drag and drop
the process anywhere in the Experiment window.
To place the new process somewhere specific in your developing protocol list, drag
and drop the process where you want it. You are notified when the position is
invalid.

3. When the configuration screen opens for the added process, adjust settings as needed.
See Understanding Processes on page 72.

4. Repeat steps 2 and 3 until you are finished building your protocol.
5. Define the Analysis parameters.

Click the Analysis process, and then click Grouping, Correction, and Export to specify
the analysis parameters for the experiment data. See Analysis Process on page 78.
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6. Click on any other process icon to open its configuration screen and make changes as
needed.

Note: When using the HS EMCCD camera, depending on your Protocol > Settings
> Edit read mode > Camera Mode setting, when using a fast Read time interval
value, the platematrix panel updating might be delayed until the end of the data
acquisition rather than updating during the data acquisition.

Specifically, the following settings result in the platematrix panel updating at the
end of the data acquisition:
For Camera Mode > HighSpeed—a Read time interval(s) setting of 0.018 seconds
or shorter
For Camera Mode > Normal or Sensitivity—a Read time interval(s) setting of
0.029 or shorter

7. Select File > Save.
8. In the Save As dialog, in the File name field, type a name for your protocol, and then

click Save.

Tip: Protocol files are saved as an *.fmp file. Unless you change the Save in
location for your protocols, the default save location is C:\Documents\Molecular
Devices\ScreenWorks\MyProtocols.

9. Run your experiment.
Refer to the FLIPR Penta High-Throughput Cellular Screening System Protocol Guide for
specific protocol settings.

Optimizing the Optics and Fluid Dispensing

Optimizing the Hardware Settings

Prior to screening, the following hardware components should be optimized for signal
output and detection:

Excitation intensity
Exposure time
Number of reads
Camera gain for EMCCD cameras
Gate Open for ICCD camera
Pipettor height
Dispense speed
Dispense volume
Cell parameters for suspension assays
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Optimizing Optics Hardware

Optimization is available to help amplify weak signals or reduce saturation. Modifying read
settings might not alter the quality of your data because it only regulates the amount of light
emitted or detected by the system. For instance, doubling the excitation intensity doubles
the RLUs detected by the system, but your signal-to-noise ratio and Z-factor can remain the
same.
To optimize the fluorescence signal:
1. Place the cell plates on the read positions.
2. With the Camera Mode >Normal setting, start with the excitation intensity, camera gain

and exposure time settings shown below. These settings are themost frequently used to
measure basal fluorescence signal.

Camera
Type

Calcium Assay Membrane Potential Assay

EMCCD HS EMCCD ICCD EMCCD HS EMCCD ICCD

Excitation
wavelength
(nm)

470–495 470–495 470–495 510–545 510–545 510–545

Emission
Wavelength
(nm)

515–575 515–575 515–575 565–625 565–625 565–625

Excitation
Intensity
(%)

50 40 50 50 50 50

Exposure
Time (s)

0.4 0.05 0.533 0.4 0.005 0.533

Camera
Gain

130 6.5 2000 50 1.5 2000

Gate Open — — 6% — — 6%

3. Run a Protocol Signal Test to evaluate the basal fluorescence signal.

The fluorescence signal for intracellular calcium assays vary depending on the installed
camera and settings. Look for the following fluorescence counts:

EMCCD camera: 200–1,200
ICCD camera: 500–5,000
HS EMCCD camera: 4,000–6,0000

4. If the basal fluorescence signal is substantially out of these ranges, adjust the excitation
intensity, exposure time, gain, or gate. Use the following suggestions to adjust the basal
fluorescence:
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Basal fluorescence too low:
Increase the Excitation Intensity. During the assay, the Excitation Intensity ranges
between 20% and 100%.
Increase the Exposure Time. When you increase the Exposure Time, the read interval
must be increased to a minimum of exposure time + 0.1 s. It takes 0.1 s to integrate the
data.
Increase the Camera Gain.

EMCCD camera: The gain varies between 1, extremely bright fluorescence, to 240,
luminescence.
HS EMCCD camera: The gain varies between 1 and 128.

Increase theGate Open.
ICCD camera: The gate varies between 0.06%, extremely bright fluorescence, to 35%,
very dim fluorescence.

Basal fluorescence too high:
Decrease the Excitation Intensity.
Decrease the Exposure Time.
Decrease the Camera Gain (EMCCD and HS EMCCD camera).
Decrease theGate Open (ICCD camera).

Adjusting the Pipettor Height

To ensure prompt compound delivery, the pipettor height can be adjusted. It is based on
pipettor mechanics and the physics of liquid. for Fluorescence an air gap, called theHold
Volume, is drawn into the tips after fluid aspiration from the source plate. This air gap
ensures fluid doesn’t leak out during pipettor movement. The hold volume is the first item
to leave the pipette tip during dispense and enters the target well as a bubble. These bubbles
can cause random light reflections and spurious signals. To avoid bubbles, dispense fluid
with tips just above, but touching the initial well fluid level. This leaves the tips touching the
meniscus after the addition has been completed to ensure complete sample dispensing.

Note: For Luminescence suspension assays, no Hold Volume is recommended along
with low and fast addition.

If pipette tips are in the air at the end of fluid delivery, a drop can form on the tip end due to
surface tension resulting in reproducibility problems. Therefore, the pipettor height should
be set just above, but touching the starting fluid volume in the wells.
The fluid surface in a 384-well or 1536-well plate is a deeply curved meniscus. Set the pipettor
height somewhere below the starting fluid volume for the 384-pipettor. There is no air gap
used with the 1536-pipettor.
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Adjusting the Fluid Dispensing Speed

Default dispense speed is 50 μL/s, 20 μL/s and 2 μL/s when dispensing to 96-well, 384-well,
and 1536-well plates respectively. The table below provides recommended fluid dispense
speeds for all three plate formats.

Cell Conditions 96-Well Plate
(μL/s)

384-Well Plate
(μL/s)

1536-Well
Plate (μL/s)

Slow dispensing speed for weakly adherent cells
or non-adherent cells.

10–50 5–20 1–6

Fast dispensing speed for strongly adherent cells. 100–200 25–50 5–10

These values must be experimentally determined for each cell type, but it is generally
preferable to dispense as fast as possible to enhancemixing of the compounds in the wells.
The trade-off is that the pipetting speed must not be so forceful as to dislodge cells from the
well.

Optimizing Fluid Volume

The fluid volume parameters have the following range:
96-well plate = 5–200 μL
384-well plate = 1–25 μL
1536-well plate = 0.5–3 μL

Large volumes mixmore rapidly into the wells than smaller ones. However, smaller sample
volumes cause less disruption to the cell layer and allow the same source plate to be used for
multiple cell plates. To avoid dislodging weakly adherent cells, smaller compound volumes
should be added to the cell plate, and the pipettor should dispense the compounds at a
relatively low speed.

Optimizing Pin Tool Delivery

To ensure proper transfer of compound using a pin tool to your target plate, evaluate the
following factors during assay development. Controlling and standardizing the following
factors for a given application helps you deliver reproducible volumes:

Pin diameter
Surface tension of the liquid being transferred
Surface tension of the pin
Speed of removal from source liquid
Speed of pin striking recipient plate
Depth to which the pin is submerged in the source plate
Depth to which the pin is submerged in the target plate
Volume of slot in pin
Surface tensions of plate and dwell time
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Note: The FLIPR Penta instrument and the FLIPR Tetra instrument use the same pin
tools.

For more information regarding optimization of pin tools, refer to http://vp-
scientific.com/molecular_devices.htm or contact:
V&P SCIENTIFIC, INC.
9823 Pacific Heights Boulevard, Suite T
San Diego, CA 92121
Toll Free: +1-800.455.0644
Phone: +1-858.455.0643
Fax: +1-858.455.0703
Email: sales@vp-scientific.com

Optimizing Cell Delivery

During suspension assays, cells are pumped from the external Cell Flask to the Cell Reservoir
and pipetted to the read plate. There are several user adjustable settings for suspension cell
optimization. These parameters need to be optimized for each cell line as each cell line is
different. The settings include:

Stir speed in the Cell Flask
Fill pump speed
Drain pump speed
FLIPR Penta System aspirating/dispensing parameters

http://vp-scientific.com/molecular_devices.htm
http://vp-scientific.com/molecular_devices.htm
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Starting the Assay Run
To start the assay:
1. Check the Experiment screen to verify that the Experiment Summary is accurate and

that the appropriate Protocol *.fmp file is being used.
2. Verify the plates and tips are loaded in the instrument.
3. Save the protocol.

4. To start, click Run on the toolbar.

CAUTION! The upper and lower doors automatically lock before any part in the
FLIPR Penta System moves. These doors must remain closed until the end of the
run, including through the duration of the pipettor tip wash.
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Chapter 6: Exporting Data

You can export data the following two ways:
Automatic export when a protocol is run.
Export from already acquired data.

To configure the data export:

In protocol files, in the Analysis screen, click Configure Auto Export.
For data files, use File > Export, File or Batch Export.

Note: Auto-Export and Batch Export do not support the ScreenWorks Peak Pro
Software version 2.0.

Data is exported as ASCII text format files with a separate file exported for each measurement
configuration specified. When you export data , you specify a folder in which to write the
output files.The default export folder is:
C:\Documents and Settings\[your_user_name]\My Documents\Molecular
Devices\ScreenWorks\MyData

6
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The File Export dialog has the following tabs:
Files—Export directory setting or batch files selections.
Time Sequence—Exports time-point measurements for selected read modes. The
measurement values that are exported have any corrections configured in the
Correction dialog applied. If there are two read modes and Ratiometric Options is
selected in the Correction dialog, you can also export the ratio for each time point.
Files have a *.seqn extension, where n increments for each file generated in the export.
Statistics—Exports averages, maximums, and other kinetic reduction values for selected
numbers of reads for each well.
Files have a *.statn extension, where n increments for each file generated in the export.
Peak Pro 2.0 Statistics—You must run the Peak Pro 2.0 analysis before you can do the
export. After running the analysis, this export works the sameway as Statistics. See
Exporting Data With Peak Pro 2.0 Analysis on page 180.
Group Statistics—Exports the group statistical values for selected numbers of reads for
each group and are based on user-defined kinetic reduction settings.
Files have a *.gstatn extension, where n increments for each file generated in the export.
Peak Pro 2.0 Group Statistics—You must run the Peak Pro 2.0 analysis before you can
do the export. After running the analysis, this export works the sameway as Group
Statistics. See Exporting Data With Peak Pro 2.0 Analysis on page 180.

CAUTION! Data created in ScreenWorks Software version 2.0 cannot be viewed or
exported by ScreenWorks Software version 5.0.
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Exporting Time Sequence
Configure parameters for export of time-sequence data in the Export Time Sequence tab.
The exported files contain a value for every read interval for each well, for the read mode or
ratio selected. This contrasts with the Statistics file, which contains one kinetic reduction per
well.

Options Description

Enable Time Sequence Check this option to have a time sequence export file created.

File Name Options Choose a name for the exported time sequence file.

Use name of data file—Export files with the data or protocol file
name, with *.seqn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.seqn extension, where
n is an integer ≥ 1.

Data Format Format the output from this group of options:

Show Labels—Check to include information about the processing
options selected (for example, name of *.fmd file and well labels). Any
corrections prior to export (e.g., negative control correction) are
reported at the top of the exported ASCII file.
Order of Well Data—Order the data by column (for example, A1, B1,
C1) or by row (for example, A1, A2, A3). Set this option in accordance
to the way your spreadsheet or database handles well data.
Order Time Data—Select vertical or horizontal ordering of the data.

Misc. Parameters Select experimental parameters and group statistics to export with the
data.

Individual File Parameters Use the bottom section of the dialog to choose the number and type
of time sequence files to be created from the same data set.

Number of Files—Click the Add Statistic button to add to the number
of statistic files to be created from the same data set.
Read Mode—Enter the read mode (or ratiometric data) from which
you want to export data.
From Quadrant—You can choose a specific quadrant from which to
export, or export data from all quadrants. This enables you to export
data from one plate into four different spreadsheet files, if desired.

Note: This option is only available for data created in 384-well or
1536-well formats.

Table 6-1: Export Time Sequence Options
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Exporting Statistics
Use the Export Statistics tab to configure kinetic reductions, for example, averages and
maximum and minimum values, for selected numbers of reads within each well. Multiple
kinetic reductions can be configured, each resulting in another export file. Within each file
only one value is reported per well.

Options Description

Enable Statistics Check this box to have a statistic file created.

File Name Options Choose a name for the exported statistic file.

Use name of data file—Export files with the data or protocol file
name, with *.statn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.statn extension, where
n is an integer ≥ 1.

Data Format Format the output from this group of options:

Show Labels—When checked, the output file contains information
about the processing options selected (for example, name of *.fmd
file and well labels). Any corrections done prior to exporting the data
(e.g., negative control correction) are indicated in text format at the
top of the exported ASCII file.
Order of Well Data—Order the data by column (for example, A1, B1,
C1) or by row (for example, A1, A2, A3). Set this option in accordance
to the way your spreadsheet or database handles well data.

Misc. Parameters Select experiment parameters and group statistics to export with the
data.

Table 6-2: Export Statistics Options
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Options Description

Individual File Parameters Use the bottom section of the dialog to designate the number and
type of statistic files to be created from the same data set.

Number of Files—Click the Add Statistic button to add to the number
of statistic files to be created from the same data set.
Compute—Select a kinetic reduction type. See Kinetic Reduction
Types on page 81
Start Read—Enter the first read number to be included in the kinetic
reduction.
End Read—Enter the last read number to be included in kinetic
reduction. This can equal the Start Read, if you want to extract values
from a single read.
Read Mode—Enter the read mode (or ratiometric data) from which
the data processes.
From Quadrant—You can choose a specific quadrant from which to
export, or export data from all quadrants. This enables you to export
data from one plate into four different spreadsheet files, if desired.

Note: This option is only available for data created in 384-well or
1536-well formats.

Table 6-2: Export Statistics Options (continued)

Exporting Group Statistics
Use the Export Group Statistics tab to configure a group statistics export report, for
example, average, standard deviation and z-scores, based on the kinetic reduction types
defined for a select number of reads as set up on the Analysis screen.

Note: If there are no groups defined on the Analysis screen, an empty report exports.

Options Description

Enable Group Statistics Check this box to have a group statistic file created.

File Name Options Choose a name for the exported group statistic file.

Use name of data file—Export files with the data or protocol file
name, with *.gstatn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.gstatn extension, where
n is an integer ≥ 1.

Table 6-3: Export Group Statistics Options
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Options Description

Kinetic Reduction Configures the parameters used to define the kinetic reduction.

Reduction Type—Defines the reduction to be applied to the kinetic
data traces exported. See Kinetic Reduction Types on page 81 for
details.
Start Read—Define the first read to be used to determine the kinetic
reduction.
End Read—Define the last read used to determine the kinetic
reduction.
Read Mode—Select the read mode to apply the kinetic reduction.

Misc. Parameters Select experiment parameters to export with the data.

Table 6-3: Export Group Statistics Options (continued)

Batch Exporting

Note: Batch Export does not support the separately licensed analysis module
ScreenWorks Peak Pro Software version 2.0.

Manual export of files is accessed through File > Export, File or Batch Export.Manual
Export allows the same files as defined above to be exported.

Options Description

Export Directory User defines where export files are to be sent. The default
export folder is:

C:\Documents and Settings\[your_user_name]\My
Documents\Molecular Devices\ScreenWorks\MyData

Batch Export Following Files Selecting Add opens the Open File dialog to choose data files
to be exported.

Note: Hold down the SHIFT or CTRL key to select data files.

Correction Options During export, either the existing or new corrections can be
applied.

Use corrections already applied in each data file—Applies
the existing corrections saved with each data file during
export.
Use same corrections for all files—Applies and saves new
corrections to all data files. Useful when exporting all data
files with same parameters or saving the same correction to
multiple data files. Details regarding available corrections
can be found under Corrections on page 91.

Table 6-4: Batch Export Options
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Options Description

If an error occurs while trying to
export a file, do the following

Put up an error message and let me decide what to do—
Enables the user to decide how to proceed when an error is
encountered.
Skip the file—Does not include the data in the export, but
continues to export data. The option to write the error to a
log file is available.

Table 6-4: Batch Export Options (continued)

When batch exporting data, the export files produced vary depending on the options you
select in the individual export statistic, time sequence and group statistic sections. If a single
export file is needed for each data file exported, select Use name of data file in the
respective section you want to export. Export files created using this method are labeled with
the name of the data file from which it was created. However, if a single export file is needed
that contains information for multiple data files, select Use user-defined name in the
respective section. In this instance, all exported information combines into one file labeled
with the desired user-defined name. When the file is open, the individual data file names
which the information was exported from are used as the header for each data set within the
export file.
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Using ScreenWorks Peak Pro Software Version 2.0

The ScreenWorks® Peak Pro™ Software Version 2.0 requires the purchase of a separate
module license after a 14-day trial, which adds advanced peak detection and event
characterization measurements and analysis functionality. This data analysis capability is
especially useful with cardiomyocyte and neuronal protocols. Contact your Molecular
Devices Sales Representative for purchasing. Detect and measure the activity of biological
events that exhibit several components of interest, for example, multiple excitations, regular
or irregular anomalous events such as early afterdepolarization-like events (EAD), irregular
amplitudes or frequencies, and migrating threshold levels.

Note: For relatively fast events that have been acquired with long sampling intervals,
use ScreenWorks Peak Pro Software version 1.0. See Kinetic Reduction Types on page
81.

The Peak Pro 2.0 analysis algorithm reduces false detections without the need to condition
the raw data. Using search vectors, you optimize the lengths of these vectors for specific
data sets. They are generated with themidpoint of the vector at each point in the data set
and are fitted by linear regression such that the slope at each point is known and the ups
and downs of the adjacent noise events are dampened, which reduces the contribution of
random noise to the overall movement of the vector.
For example, as shown in Figure 7-1 and Figure 7-2, adjusting the search vector length and
specifying theminimum noise and amplitude values, very few false events appear.
In the following example, using a moderately noisy data set, using a search vector length
setting of 3 results in a lot of false peaks:

Figure 7-1: Search Vector Length of 3 is Noisy
Each marker represents a peak. The first peak of each event is a blue dot and the subsequent
peaks are green diamonds.

7
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Changing the search vector length setting to 11, and running the analysis again results in
more precise data:

Figure 7-2: Search Vector Length of 11 Reduces Noise
The vector length did not need to be increased by much to see a substantial noise reduction
improvement. Themajor peaks and minor peaks now appear to be real biological events.
The following sections explain how to use the Peak Pro 2.0 analysis softwaremodule in more
detail. Topics include:

Interface Overview on page 167
Running Peak Pro 2.0 Analysis on page 174
Exporting Data With Peak Pro 2.0 Analysis on page 180
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Interface Overview
When you start the ScreenWorks Peak Pro Software version 2.0, a dialog appears with the
open data file name in the title bar.
The Peak Pro 2.0 Analysis dialog has three tabs:

Options Tab Settings
Measurements Tab Settings on page 171
Configuration Tab Settings on page 174

To open the Peak Pro 2.0 Analysis dialog:
1. Select File >Open >Data File(s).
2. In theOpen dialog, select your data file name, then click Open.
3. In theMulti-Well Graph, select individual wells, rows, or columns to analyze.

4. Click to open the Peak Pro 2.0 Analysis dialog.

For more analysis procedures, see Running Peak Pro 2.0 Analysis on page 174.

Options Tab Settings

The Options tab provides the peak detection search settings and data range settings.

The Options settings are organized into the following sections:
Data on page 169
Event Rejection on page 170
Noise Rejection on page 170
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Event polarity—specifies the direction of the signal for detection, either Positive or
Negative. Set by default for Positive.

Tip: Negative-going polarity is rarely needed.

Set Default Levels—resets the threshold, trigger, and baseline values to their default
positions.
Search vector length—determines the sensitivity of the peak detection. Longer vector
lengths automatically filter out noise and short events, while shorter vector lengths
detect lower amplitude transitions.
The search vector is generated from a linear regression across forward and backward
points, centered on themid-point of the vector, and computed for each data point. This
vector slides along the data, checking the slope at each point, and determines peaks and
valleys by noting the direction of the slope.

Tip: This is themost important variable for good peak detection.
Some experimentation with this setting might be necessary.
You can specify a different vector length for each well.

Auto-assigned—uses the sampling rate and an estimate of the noise amplitude to
compute a vector length for each data point. By default, this check box is selected
because it automatically determines the vector length suitable for most data sets.

Tip: If needed for fine adjustment, deselect the Auto check box and manually
enter Search vector length Points.

Same for all wells—specifies onemanually set vector length for the analysis of all
the selected wells.
Well-by-well—allows you to specify multiple manually set vector lengths for the
analysis of wells. Each well can use a different vector length setting.

Dynamic threshold—sets a lower limit for peak detection, rejecting all events below this
threshold. Amplitude is relative to the baseline.

Apply to all wells—applies the specified threshold to all wells. When deselected, the
value for an individual well is used.
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Trigger level—specifies when detection starts, with the first crossing of the level, and
when the event ends, with the level re-crossing. By default, the level is positioned at 10%
above the baseline, relative to the data range. Events that peak below the trigger level
are ignored. Adjust as needed. This level can be set individually for each well. The signal
values are relative fluorescence units (RFU).

L—specifies the left end of the trigger level line.
R—specifies the right end of the trigger level line.
Lock L/R—locks the left and right ends such that the level linemoves as a unit when
either the left or right values change.

Note: An event is the signal crossing the trigger level in both directions. The
amplitude of the event, is measured relative to the baseline. The detection of the
left and right antipeaks of the event is not limited by the trigger level and these
measurements can extend as far as the baseline. The event duration is measured
as the distance between the two antipeak positions.

Baseline level—specifies the absolute end of the detection range. All amplitudes are
measured relative to the baseline level and not the antipeak value. Adjust as needed.
The signal values are relative fluorescence units (RFU). The algorithm automatically
adapts to sloping baselines.

L—specifies the left end of the baseline level line.
R—specifies the right end of the baseline level line.
Lock L/R—locks the left and right ends such that the level linemoves as a unit when
either the left or right values change.

Data
Well—individually lists all the selected wells from the platematrix used to open the
analysis dialog. This field also selects the graph that displays in the Detail Graph pane.
Process all selected wells—includes in the process all of the selected wells in theWell
list. When this check box is deselected, only the well visible in theWell field is processed.

Tip: You can select specific wells from theWell list and click Exclude for exceptions
before analyzing all of the selected wells.

Full—automatically selects the whole available data range.
From—specifies the beginning point of your data range to be analyzed. Adjust as
needed.
To—specifies the end point of your data range to be analyzed. Adjust as needed.
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Event Rejection
When you use Event Rejection, the amplitudes relative to the baseline that are lower than
specified are rejected. Events with trough to trough times shorter than the specified
duration are rejected.

Apply to all wells—applies the specified amplitude and duration values to the data from
all wells. When deselected, the value for each individual well is used.
Min amplitude—specifies the lowest amplitude RFU value, measured from the baseline,
for the acceptance of an event.
Min duration—specifies the shortest duration ms value, duration, as measured
between the left and right antipeak values, that is accepted.

Noise Rejection
When you use Noise Rejection, the amplitude is relative to the right trough on the rising
phase and the left trough on the decay phase. Events with amplitudes lower than this are
rejected. Events with right to left trough times that are less than the noise duration are
rejected.

Auto—Peak Pro 2.0 analysis measures the approximate noise level of the data averaging
the difference between sequential amplitude values of all amplitudes within a distance of
10% of the baseline. Outliers are rejected using interquartile ranges. The noise estimate is
then used to determine an approximate default noise level.
Apply to all wells—applies the specified amplitude and duration values to the data from
all wells. When deselected, the value for each individual well is used.
Min amplitude—specifies the lowest amplitude RFU value before rejecting an event as
noise. Themeasurement is taken between the lowest antipeak amplitude and the peak
amplitude.
Min duration—specifies the lowest duration time value before rejecting an event as
noise. Themeasurement is taken between the antipeak time at the lowest antipeak and
the time at the equivalent amplitude opposite the peak.
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Measurements Tab Settings

TheMeasurements tab provides the properties of an event that can be selected for display
in the Peak Pro 2.0 Statistics pane.

Figure 7-3: Peak Pro 2.0 Statistics Pane After Analysis With Expanded Group Data
When you run an analysis, all of the following measurements are calculated:

Mean peak amplitude—average amplitude of themain peaks of the events detected in
the well data, measured from the peak to the baseline and expressed in relative
fluorescence units (RFU).
Number of peaks—total number of peaks.
Mean peak rate—the numbers of peaks per minute (PpM). For cardiac data, this is
equivalent to beats per minute (BPM).
EAD-like count—reports the early afterdepolarization-like event (EAD-like) in an event.
Includes Number of EAD-like events, Mean Number of EAD-like events, and Number of
EAD-like events S.D..
Mean EAD-like rate—average rate of early afterdepolarization-like event of the events
detected in the well data, expressed in peaks per minute (PpM).
10-90% CTD—Calcium Transient Duration. The width of a peak in seconds at various
peak heights between 10% at the top and 90% at the bottom.
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10-90% CTDP—Calcium Transient Duration from peak position measured as a straight
line from the peak to a percentage of the distance from the peak.

Area—below the event measured from the baseline to the start and end of the event as
defined by the left and right antipeaks, expressed in relative fluorescence unit seconds.

Peak Spacing—approximates the regularity of the peak spacing, expressed in seconds.
Themeasurement reports either uniform spacing of peaks (OK), or irregular spacing
(IRREG).
Rise slope—rate of rise over the specified range. Expressed in relative fluorescence units
per second.
Decay slope—rate of decay over the specified range. Expressed in relative fluorescence
units per second. Computed on if there is no early afterdepolarization-like event.
Rise time—time to rising phase over the specified range.
Decay time—time to decay over the specified range.
Linear run decay slope—slope of a straight line from the peak to a specified percentage
of the peak. Expressed in relative fluorescence units per second.
Linear run slope time—from the peak. Expressed in seconds.
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The following illustrates themeasurement options and terminology:

Item Description

A Main peak amplitude

B Linear decay slope

C Main peak interval used to calculate the peak rate, expressed in peaks per minute
(PpM)

D Early afterdepolarization-like event (EAD-like) intervals used to calculate the EAD-like
event rate, expressed in peaks per minute (PpM)

E Rise slope

F EAD-like event amplitude

G Decay slope

H Calcium transient duration (CTD)

I Calcium transient duration from peak position (CTDP90)

J Start of an event

K End of an event

L Main peak

M Early afterdepolarization-like event (EAD-like)

Table 7-1: Measurement Terminology Illustrated
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Configuration Tab Settings

The Configuration tab provides the ability to display one kinetic reduction value in theMulti-
Well Graph for your selected wells.

Running Peak Pro 2.0 Analysis
After you have saved experiment data files, you can run an analysis with the ScreenWorks
Peak Pro Software Version 2.0 license. The Peak Pro 2.0 analysis functionality is best suited
for cardiomyocyte, neuronal, and similarly fluxing assay data.
To run a Peak Pro 2.0 analysis:
1. Select File >Open >Data File(s).
2. In theOpen dialog, select your data file name, then click Open.
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3. In theMulti-Well Graph, select the individual wells, rows, or columns to analyze.

4. Click to open the Peak Pro 2.0 Analysis dialog and collate the selected data,
compute automatic baselines, thresholds, optimal search vector length, and format the
results for subsequent analysis, sorting and recording.

Tip: If needed, you can change your well selections.

5. In theOptions tab, either run the default settings or manually adjust. See Options Tab
Settings on page 167.

6. In theMeasurements tab, if needed, adjust ranges. SeeMeasurements Tab Settings on
page 171.

Note: All the listed measurements generate during the analysis.
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7. (Optional) In the Configurations tab, select one statistic type to Display kinetic
reduction value in theMulti-Well Graph for your selected wells, for example, display
Number of peaks.

8. To start the analysis, click Analyze.
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9. Review the results in theDetail Graph pane.
Each major peak is marked with a blue dot. The green diamond markers are secondary
peaks.

Tip: When there are a lot displayed, the secondary markers are questionably
significant. Adjust the settings so that there is only onemajor peak and few
secondary peaks per event.
Themajor peak is the first peak in an event above the trigger level.
An event is that portion of a signal that crosses the trigger level in both directions.

Using the Peak Pro 2.0 Analysis dialog arrow keys, you can scroll through each well
graph to examine the result individually. Alternatively, you can select wells directly in the
Options tab, in theData >Well list.
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10. If the first event marked is a partial signal that you want to skip in your analysis, adjust
the analysis data time range.
To adjust the analysis data time range:
a. Do one of the following:

In the graph, you can manually move the vertical start time range line.
In theOptions tab, in theData section, deselect Full, and type a From starting
value.

b. In theOptions tab, click Analyze.

11. To reduce the number of secondary peaks, which are likely noise and not biologically
significant, adjust settings in theOptions tab, click Analyze, and review the results again
in theDetail Graph pane.
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12. After you reduce all of the possible noise and have clearly identified the real biological
events, you are finished with the analysis and can close the floating dialog.

Tip: To reopen the Peak Pro 2.0 Analysis dialog, click . Your last settings are
retained in the dialog.

13. View the results in the Peak Pro 2.0 Statistics pane.

In the statistics pane, the results are sorted by Group Name. For help creating groups,
see Grouping on page 86.

Note: Group Statistics Graph functionality is not supported in ScreenWorks
Software version 5.0.

14. Expand theGroup rows and theMean rows to see the Event rows of data.

Each main row contains the average ofmeasurements of each event as selected, and
each event row contains the individual metrics of the individual peaks and related
measurements.

15. To specify which of the data results display in the statistics pane, click Select
Statistics.
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16. In the Select Statistics dialog, choose which statistics display and in which order.

17. When finished making changes, click OK.

Note: The Peak Pro 2.0 Statistics pane data never saves with the open data file
used for analysis.

18. To save your analysis data, do either of the following:

In theMulti-Well Graph pane, click Export. See Exporting Data With Peak Pro
2.0 Analysis.

In the Statistics pane, click Copy Table Data to Clipboard and then paste the
delimited data into third-party software of your choice.

Externally, the saved data can be converted into graphs and reports.

Exporting Data With Peak Pro 2.0 Analysis
Exporting data for Peak Pro 2.0 is similar to the standard ScreenWorks Software exporting
process, except that you must manually run a Peak Pro 2.0 analysis before you can export
any Peak Pro 2.0 analysis data. For the standard exporting process, see Exporting Data on
page 157.

Note: An error message appears if you click Export before running your Peak Pro 2.0
analysis.

CAUTION! Because Peak Pro 2.0 analysis is a manually run process, Auto-Export and
Batch Export functionality are not supported.

To export data with Peak Pro 2.0 analysis:
1. Run your Peak Pro 2.0 analysis. See Running Peak Pro 2.0 Analysis on page 174.

2. Click to open the File Export dialog.
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3. Click the tab for type of Peak Pro 2.0 analysis data export you want to do, Peak Pro 2.0
Statistics or Peak Pro 2.0 Group Statistics.

4. Select Enable.

Note: After the 14-day trial expires, if you have not installed a ScreenWorks Peak
Pro Software version 2.0 license, the Peak Pro 2.0 Statistics and Peak Pro 2.0
Group Statistics tab contents are disabled.

5. Configure the data export in the selected tab. See Exporting Peak Pro 2.0 Statistics on
page 181 or Exporting Peak Pro 2.0 Group Statistics on page 183.

6. If you want to export data from the other tabs, repeat steps 3 through 5.
7. Click Export to generate the data files from all of the enabled tabs.

Exporting Peak Pro 2.0 Statistics

After you run your Peak Pro 2.0 analysis, in the File Export dialog, use the Peak Pro 2.0
Statistics tab to configure kinetic reductions, for example, averages and maximum and
minimum values, for selected numbers of reads within each well. Multiple kinetic reductions
can be configured, each resulting in another export file, unless you select Export all statistics
to one file. Within each file only one value is reported per well.

Options Description

Enable Statistics Select this box to have a statistic file created.

Table 7-2: Peak Pro 2.0 Statistics File Export Options



FLIPR Penta High Throughput Cellular Screening System User Guide

182 5069582 B

Options Description

File Name Options Choose a name for the exported statistic file.

Use name of data file—Export files with the data or protocol file
name, with *.statn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.statn extension, where
n is an integer ≥ 1.

Data Format Format the output from this group of options:

Show Labels—When checked, the output file contains information
about the processing options selected (for example, name of *.fmd
file and well labels). Any corrections done prior to exporting the data
(e.g., negative control correction) are indicated in text format at the
top of the exported ASCII file.
Order of Well Data—Order the data by column (e.g., A1, B1, C1) or by
row (for example, A1, A2, A3) . Set this option in accordance to the
way your spreadsheet or database handles well data.

Misc. Parameters Select experiment parameters and group statistics to export with the
data.

Individual File Parameters Use the bottom section of the dialog to designate the number and
type of statistic files to be created from the same data set.

Number of Files—Click the Add Statistic button to add to the number
of statistic files to be created from the same data set.
Compute—Select a kinetic reduction type. See Measurements Tab
Settings on page 171.
Start Read—Enter the first read number to be included in the kinetic
reduction.
End Read—Enter the last read number to be included in kinetic
reduction. This can equal the Start Read, if you want to extract values
from a single read.
Read Mode—Enter the read mode (or ratiometric data) from which
the data processes.
From Quadrant—You can choose a specific quadrant from which to
export, or export data from all quadrants. This enables you to export
data from one plate into four different spreadsheet files, if desired.

Note: This option is only available for data created in 384-well or
1536-well formats.

Table 7-2: Peak Pro 2.0 Statistics File Export Options (continued)
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Exporting Peak Pro 2.0 Group Statistics

After you run your Peak Pro 2.0 analysis, in the File Export dialog, use the Peak Pro 2.0
Group Statistics tab to configure group statistics, for example, average and standard
deviation, based on the kinetic reduction defined for a select number of reads.

Options Description

Enable Group Statistics Select this box to have a group statistic file created.

File Name Options Choose a name for the exported group statistic file.

Use name of data file—Export files with the data or protocol file
name, with *.gstatn extension, where n is an integer ≥ 1.
Use user-defined name—Enter your own name for the export files
(maximum of 25 characters). Files are given *.gstatn extension, where
n is an integer ≥ 1.

Table 7-3: Peak Pro 2.0 Group Statistics File Export Options
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Options Description

Kinetic Reduction Configures the parameters used to define the kinetic reduction.

Kinetic Reduction—Defines the reduction to be applied to the kinetic
data traces exported. See Measurements Tab Settings on page 171 for
details.
Start Read—Define the first read to be used to determine the kinetic
reduction.
End Read—Define the last read used to determine the kinetic
reduction.
Read Mode—Select the read mode to apply the kinetic reduction.

Misc. Parameters Select experiment parameters to export with the data.

Table 7-3: Peak Pro 2.0 Group Statistics File Export Options (continued)
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Chapter 8: Maintaining the Instrument

Do only themaintenance tasks described in this guide. Maintenance procedures other than
those specified in this guidemust be done by Molecular Devices. See Obtaining Support on
page 226.
Before operating the instrument or following maintenance procedures, make sure you are
familiar with the safety information in this guide. See Safety Information on page 7.
The following aremaintenance procedures that you can do as needed:

Washing Pipettor Tips and Pin Tools
Exchanging Hardware Components on page 186

Washing Pipettor Tips and Pin Tools
Pipettor tip and pin tool washing is controlled with theWash Tips or Wash Pins process in
ScreenWorks Software protocols and can be performed between fluid transfers within an
experiment, or after the last fluid transfer, to prepare tips for the next experiment.
Disposable tips, as well as the 1536-tip head, and 384- and 1536-pin tools, can be washed.
The washer consists of a reservoir top of the selected pipettor format, mounted over a wash
basin. Detailed instructions for exchanging the reservoir top are located in Uninstalling Wash
Reservoir Top on page 192. The wash basin is connected to two solvent-supply carboys and
two waste carboys located on the floor beneath the computer monitor. A basin beneath the
tip washer base drains to a waste carboy, to safely remove any solvent that overflows from
the reservoir.
Wash solution fills the reservoir for a calibrated amount of time. Solvent is then drained from
the reservoir after each wash cycle. Up to five wash cycles can be configured within a single
wash process. For tips, a user-set volume of solvent is drawn up, optionally held for a time,
and then expelled, up to 20 times. For pins, vertical motion of the tip block is used to agitate
the wash solvent around the pins. The option is available to wash tips or pins in up to two
solutions before reusing the tip washer. When additional wash solutions are required, tips or
pins can be washed in a boat or reservoir, located in one of the source plate positions, using
theMix Fluid process.

WARNING! High volumes of volatile, flammable solvents in the reading
chamber may cause explosive conditions. Use of 100% isopropanol, etc., in the tip
washer is particularly discouraged without additional ventilation. Consult your
facilities expert to determine the appropriate ventilation to avoid explosive
conditions.

Pin tools are supplied with blotting stations that can be loaded into one of the plate
positions. Blot pin steps can be configured in the protocol to remove fluid from the pins, for
example, following pin washing.

8



FLIPR Penta High Throughput Cellular Screening System User Guide

186 5069582 B

Note: Awaste bottle sensor override (P/N 0700-0827) is available in the
FLIPR Penta System accessory kit to bypass the waste sensor and dispose waste in
containers other than the dedicated waste carboys.

Exchanging Hardware Components
Use the following procedures to exchange hardware components on your
FLIPR Penta System:

Pipettor or Pin Tool Head—See Exchanging Pipettor or Pin Tool Head
Pipettor Tips—See Exchanging Pipettor Tips on page 194
Pin Tools—See Exchanging Pin Tools on page 195
Alternating Position 1 Use—See Alternating Position 1 Use on page 196
1536Microplate Tip Gasket—See Exchanging the 1536Microplate Tip Gasket on page 196
LEDModules—See Exchanging LEDModules on page 198
Filters—See Exchanging Filters on page 201
Plates or Tip Racks Hold-Down Devices—See Exchanging the Plate Hold-Down Devices on
page 205
Cell Reservoir—See Exchanging the Cell Reservoir on page 204

Exchanging Pipettor or Pin Tool Head

All pipettor and pin tool heads must be installed and calibrated on their intended instrument
for the first time by a certified Molecular Devices Field Service Engineer. When calibrated,
each head can be easily exchanged but only on the instrument for which they were
calibrated.

Note: If you have any questions or concerns regarding the procedures, contact
Molecular Devices Technical Support www.moleculardevices.com/service-support.

Exchanging the head type involves the following procedures:
1. Uninstalling a Pipettor or Pin Tool Head on page 186
2. Installing the Pipettor or Pin Tool Head on page 190
3. Exchanging Pipettor Tips and Pin ToolWash Reservoir Top on page 191
4. Resetting the System After Exchanging a Pipettor or Pin Tool Head on page 193

Uninstalling a Pipettor or Pin Tool Head

The following procedure uninstalls a 384 pipettor head as an example.
To uninstall a 384 pipettor head:
1. In the ScreenWorks Software, unload all tips on the pipettor head by selecting

Instrument > Manual Operation > Unload Tips.

http://www.moleculardevices.com/service-support
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2. Select Instrument > Manual Operation > Change Head. This command instructs the
pipettor head to move over the Read Plate position.

CAUTION! DO NOT select DONE in the dialog that opens until you have
completed work on the pipettor.

3. Open the upper front door to access the pipettor head.
4. Turn theD-Axis Knurled Nut counter-clockwise until it loosens and can be lifted.

For 1536 pipettor heads only: After loosening theD-Axis Knurled Nut, install the
Pipettor Head Guard, which seats over the 1536-pipettor head plungers, by tightening
the two thumb screws. This guard protects the plungers from being damaged while the
pipettor head is being handled outside the instrument.
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5. Turn theHead Clamp Knob counter-clockwise until the head is loose and can be lifted off
its mounting position.
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6. To remove pipettor head, grasp the pipettor head silver Guide Shaft, lift upward (to
unseat from Alignment Pins and to lower plunger pins allowing a lift gap) and then slide
to the left off the pipettor mount.

Note: If the pipettor head does not easily slide off, try grabbing the D-axis knurled
nut receiver and pressing it downward to give the pipettor head additional
clearance from the D-axis knurled nut prior to trying again.

7. Store the pipettor head in a safe location. A recommended safe location should include
placing the pipettor head in its plastic storage bag to guard for particulates.

CAUTION! Do not place pipettor heads on nose cone surfaces because this can
damage the nose cones. Store pipettor heads inverted, resting on the pipettor
head top that seats on the pipettor mount position.
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Installing the Pipettor or Pin Tool Head

The following procedure installs a 1536-pipettor head as an example.

CAUTION! Only install a head that has been calibrated for your instrument by a
Molecular Devices Field Service Engineer.

To install a 1536-pipettor head:
1. Hold the pipettor head by its silver Guide Shafts and slide it to the right over the

Pipettor Mount.
When the pipettor head is in position, it should be seated on the Alignment Pins and
should not slide off the pipettor mount without lifting upwards.

2. Tighten theHead Clamp knob by turning it clockwise.
3. For 1536-pipettor heads only: Remove the guard covering the 1536-pipettor head

plungers by loosening the two thumb screws.
This allows the D-axis to move freely so it can be attached to the D-axis knurled nut in the
next step.

CAUTION! If the guard is not removed before resetting the instrument, the
1536-pipettor head can be damaged.
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4. Tighten theD-Axis Knurled Nut by turning it clockwise until tight.
If the nut does not reach its receiver threads, lift the D-axis receiver to engage the
threads and tighten the nut.

5. After the head is fastened, exchange the tip wash reservoir top to match the head
format. See Exchanging Pipettor Tips and Pin ToolWash Reservoir Top.

Exchanging Pipettor Tips and Pin Tool Wash Reservoir Top

After exchanging the pipettor tips or pin tool head, exchange the wash reservoir to match
the new head format.

CAUTION! Failure to match head format and wash reservoir top causes damage
during instrument operation.

Exchanging the wash reservoir top involves the following procedures:
1. Uninstalling Wash Reservoir Top on page 192
2. Installing Wash Reservoir Top on page 193
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Uninstalling Wash Reservoir Top
The following procedure uninstalls a 384wash reservoir top as an example.
To uninstall a wash reservoir top:
1. Loosen both Captive Thumb Screws on reservoir top.

2. Lift reservoir top off of the washer base.
3. Ensure the Blue O-Ring on the washer base remains properly seated. If not, reinstall the

o-ring into its o-ring groove.
4. Store the reservoir top in a safe location.
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Installing Wash Reservoir Top
The following procedure installs a 384wash reservoir top as an example.
To install a wash reservoir top:
1. Align the appropriate format reservoir top so the Connectormatches the washer base

connector. When aligned correctly, the reservoir top name (96, 384 or 1536) is located
towards the front of the instrument.

2. When aligned, using the Alignment Pins to guide the placement of the top, press the
top into position.

3. Tighten both Captive Thumb Screws to ensure the reservoir top is fastened to the base.
4. Go to Resetting the System After Exchanging a Pipettor or Pin Tool Head to reset the

instrument.

Resetting the System After Exchanging a Pipettor or Pin Tool Head

To reset the FLIPR Penta System after exchanging a head and a wash reservoir top:
1. Make sure the head and tip wash reservoir top formats match before continuing.

CAUTION! If there is a head and wash reservoir top format mismatch, the
instrument faults and prevents all experiment runs until corrected.

2. To finish the exchanges, click DONE in the software dialog that opens when you begin
the head exchange. The instrument resets itself.

3. When the reset cycle is complete, the green Assay Finished (Unlock) light is the only
indicator light illuminated on the front of the instrument.
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Exchanging Pipettor Tips

The 96-pipettor head and the 384-pipettor head both use disposable plastic tips to transfer
fluid.

Figure 8-1: 384-Well Tip Rack Example
The 1536-pipettor head uses a stainless steel tip block with a disposable 1536-tip gasket to
transfer fluid. See Exchanging the 1536Microplate Tip Gasket on page 196.
Each pipettor head is compatible only with the tip racks ofmatching format. The pipettor
head can only pick up a matching tip rack. For example, the 384-well pipettor head should
not try to pick up pipettor tips from a 96-well tip rack.

CAUTION! Verify that there is a matching tip rack in the Tip Load position on the
instrument deck before running your experiment. Amismatched pipettor head and
tip rack causes a fatal error and can damage your equipment.

CAUTION! The FLIPR Penta System is only validated for use with theMolecular
Devices tips. Instrument performance and troubleshooting is not guarantee with any
other tips.

To automate pipettor tips loading:
In your protocol configuration, select Settings > Assign Plate to Position > Load Tips
Position. See Settings Process on page 72 and Creating New Protocols on page 124.

To load pipettor tips:
In the ScreenWorks Software, select Instrument > Manual Operation > Load Tip and
Unload Tip.
The pipettor tips attach to the pipettor head and the pipettor tips rack stays on the
stage in Position 1.

To unload pipettor tips:
In the ScreenWorks Software, select Instrument > Manual Operation > Unload Tip.
The pipettor tips are removed from the pipettor head in to the pipettor tip rack on the
stage in Position 1.

For 1536-tip exchange procedures, see Exchanging the 1536Microplate Tip Gasket on page
196.
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Exchanging Pin Tools

Pin tools are blocks of pins that are loaded onto a pin tool head to transfer fluid.

Figure 8-2: 1536-Well Pin Tool Block illustration
Two pin tool heads, 1536-well and 384-well formats, are available for the FLIPR Penta System.
Each pin tool head is compatible only with the pin tool blocks ofmatching format. The pin
tool head only picks up a matching pin tool block according to the attached magnetic ID. For
example, the 384-well pin tool head does not pick up a 1536-well pin tool block. This is
designed for the component safety.
To automate pipettor tips or a pin tool block loading:

In your protocol configuration, select Settings > Assign Plate to Position > Load Tips
Position. See Settings Process on page 72 and Creating New Protocols on page 124.

To load a pin tool block:
In the ScreenWorks Software, select Instrument > Manual Operation > Load Tip and
Unload Tip.
The pin tool block is picked up and clamped to the head using pin tool block grippers.

To unload a pin tool block:
In the ScreenWorks Software, select Instrument > Manual Operation > Unload Tip.
The pin tool block is placed in Position 1 of the stage and unclamped from the pin tool
head grippers.
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Alternating Position 1 Use

Stage Position 1 is primarily for tip loading and unloading, but this position can also be used
as a source plate position after tips are removed.

Note: Sensors indicate only the presence of an object in plate position and do not
indicate whether it is a source plate or tip rack.

Use the following procedure in both manual and robotic modes.
To use a source well plate in the stage Position 1:
1. Load tips or pins manually.
2. Remove the tip rack before starting an experiment, and place a source plate in Source 1.

Exchanging the 1536 Microplate Tip Gasket

Gaskets should be replaced approximately every 200 cycles (1 cycle = 1 stroke down + 1
stroke up). Gasket lifetime should bemonitored. It varies on the number of aspirate and
dispense steps you run in your experiment.

Installing the Gasket

To install the 1536 tip gasket:
1. Remove the gasket from its package and discard the gasket backing.
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2. Place the lubricated side of the gasket down on the tip block, using the gasket recess to
guide the frame position.
When aligned, the tip block and gasket are sandwiched together until the tip block
grippers clamp into place.

Removing the Tip Block and Gasket

During the unloading, the tip block grippers unclamp and release the gasket and tip block
into the rack assembly. When unloaded, dispose the gasket and use a new one the next time
the block is loaded. Ordering information for disposable gaskets can be found in
Consumables and Accessories on page 231.
To load from Position 1 for a source well plate:

Load tip block manually and then remove the tip block before starting an experiment.
When loaded, a source plate can be placed in Source 1 in both manual and robotic
modes.

Note: Sensors indicate only the presence of an object in plate position and do not
indicate whether it is a source plate or tip block.
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Exchanging LED Modules

WARNING! During the LED exchange procedure, you have access to precision
optical components. Do not touch the surfaces of the LED filters with your bare
fingers or other objects because you can damage them.

Uninstalling LED Modules

To uninstall LED modules:
1. Open the lower front door of the instrument.

When the lower door is open, power to the LEDs is disabled.
2. Loosen the two silver Latching Clamps securing the excitation optics module to the left

light pipe.
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3. Pull the excitation optics module down and away from light pipe to disengage the Power
Connectors on the LED modules from the light pipe. Be careful not to scratch the
bandpass filters when pulling LED modules out of the instrument.
Remove the Foam Insert found on the rear side of the excitation optics module.

4. Loosen the two Captive Thumb Screws holding the LED modules together, and then pull
themodules apart so they can be exchanged for newwavelengths.

5. Repeat for the LED modulemounted to the right light pipe.
6. When separated, LED modules can be exchanged using the Installing LEDModules

procedure.

Installing LED Modules

To install LED modules:
1. To create an Excitation Optics Module, you combine two LED banks of different

wavelengths. Align theMating Pins to their respectiveMating Hole in the LED module
that you are securing to each other.
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2. When aligned, push the two LED banks of different wavelengths together and tighten
the two Captive Thumb Screws with firm finger pressure.

3. Place the Foam Insert on the rear end of the excitation optics module.

Note: Make sure that the foam piece fits inside the LED Frame.

4. Open the lower front instrument door and slide the left Excitation Optics Module into
place. Each module is coarsely self-aligning, but observe engagement of the two Power
Connectors and confirm they are aligned before applying mating pressure.

5. After the connectors aremated, engage and tighten the two Latching Clamps that
secure each module to the Light Pipe.
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6. Repeat the above procedure for the right Excitation Optics Module, being sure the
samewavelength modules occupy the corresponding position (upper/lower) on each
side.

7. If also changing filters, continue to Exchanging Filters. If you are finished, close the lower
front door.

8. When the lower front door closes, and themessage displays The lower door has been
opened, do you want to update optics? Click Yes.

Filters and LEDs are identified.
LEDs are tested.
ScreenWorks Software Instrument Status Configuration is updated.
The process finishes when the progress dialog closes.

Exchanging Filters

Filters aremechanically sensed and the filter configuration can be viewed in the instrument
configuration window of the FLIPR Penta System ScreenWorks Software.
If the needed filter is not available, three custom filter holders are available for purchase to
use filters from an outside vendor. See Consumables and Accessories on page 231. When
installed, these filters appear as 1_1, 2_2, and 3_3 in the software protocol.

Uninstalling a Filter

To uninstall a filter:
1. Open the lower front door of the instrument.

Note: When the lower front door is open, system power is disengaged.
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2. Remove the Filter Cover, located below the left LED module.

3. Using the filter tab that protrudes slightly from the filter tray, push the filter up out of its
position and remove it from the instrument. Only to grasp the filter by the tab.

CAUTION! DO NOT touch the filter surface.

4. Repeat Step 3 for the remaining emission filters you want to remove.
5. After needed emission filters are removed, replace the Filter Cover.
6. To install new emission filters into the system, continue to Installing an Emission Filter.
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Installing an Emission Filter

The emission filter wavelengths are automatically identified by the system and can be
selected from the ScreenWorks Softwaremenu.
To install an emission filter:
1. If needed, open the lower front door of the instrument, and remove the Filter Cover,

located below the left LED module.
2. To install emission filters, grasp the filter you wish to install by its Tab, located where the

filter table is, and place it into the appropriate filter position. Typically, this is the
rightmost Position 1 in the slider. Insert the rear of the filter first, making sure it fits into
the specific filter position. Push the tab down, so that the Filter Indexer clicks into the
position. A notch on front of the tab should align with one of the lines on the Filter Tray.

CAUTION! DO NOT touch the filter surface.

3. Subsequent filters can be installed by repeating step 2 in Positions 2 and 3.

Note: If a needed filter is not available, three custom filter cassettes are available
for purchase (see Optics Consumables on page 232 to use filters created by an
outside vendor). When installed, these filters appear as 1_1, 2_2, 3_3 in the
software protocol.

4. The emission filter wavelengths are identified by the system and passed to the
ScreenWorks Software where they can be selected from menus.

CAUTION! When using all 3 filter positions, do not duplicate wavelengths,
because this causes a fault in the software.

5. After desired emission filters are installed, replace the Filter Cover.
6. When you are finished, close the lower front door.
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7. When the lower front door closes, and themessage displays The lower door has been
opened, do you want to update optics? Click Yes.

Filters and LEDs are identified.
LEDs are tested.
ScreenWorks Software Instrument Status Configuration is updated.
The process finishes when the progress dialog closes.

Exchanging the Cell Reservoir

The first installation of the cell reservoir is done by a Molecular Devices certified field service
engineer.

Uninstalling the Cell Reservoir

When the Cell Reservoir is configured and detected by the instrument, it is the only available
choice as the Source Plate 3 selection. ScreenWorks Software displays Cell Reservoir: OK in
the Instrument Status tab.
To use the Source 3 position for a different source plate, the Cell Reservoir must be
uninstalled.
To uninstall the Cell Reservoir:
1. Remove the Reservoir Connector by loosening both Captive Thumb Screws.

2. Place the Reservoir Connector by the Tip Washer.
3. Remove the Cell Reservoir.

Tip: You can now autoclave the Cell Reservoir.

4. Click Instrument > Refresh Configuration.
The Instrument Status tab displays Cell Reservoir: NOT_OK.

5. Select another plate for the Source Plate 3 position.

Installing the Cell Reservoir

To install the cell reservoir:
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1. Ensure the tubing connection to the connector is tight.
2. Align the Reservoir Connector to the Cell Reservoir and tighten the two Captive Thumb

Screws.

3. Insert the Cell Reservoir into the Source Plate 3 position.
4. Go to the Instrumentmenu and select Refresh Configuration. The Instrument Status

tab displays Cell Reservoir: OK.
This status indicates that only the Cell Reservoir can be selected for the Source Plate 3
position.

5. Run aManual Wash and inspect the cell reservoir area to ensure that there is no fluid
leakage. SeeWash Cell Reservoir Process on page 124.

Exchanging the Plate Hold-Down Devices

The plate hold-down devices, part numbers 2300-1631 and 2300-1633, keep plates or tip
racks from lifting after aspirating, dispensing and tip loading. Each device has an overhang
that extends over the skirt of a plate to prevent upward movement when the pipettor is
removed from the plate. The provided devices fit three different plate hold-down gap sizes,
2 mm, 2.5 mm, and 6 mm, which correspond to three identified plate skirt thicknesses.
The 2.0 mm and 2.5 mm are incorporated in one device that rotates 90 degrees.

Figure 8-3: Example 2.5 mm Plate Hold-Down Device on Instrument Stage
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A second plate hold-down device provided in the accessory kit, has a 6.0 mm gap. Numbers
corresponding to the plate skirt thicknesses aremarked on the top of the devices. The device
is properly oriented for a particular flange thickness when the digits can be read as upright
from the service door of the instrument.

Selecting a Plate Hold-Down Device

Most plates and tip racks use the 2.5mm device setting. Exceptions among approved plates
are the Corning/Costar plates that have a very thick 6.0mm plate skirt and the thin 2.0mm
plate skirt of thee Greiner 1536-well plates. To determine which hold-down device is most
appropriate for your plate, use the lowest hold-down device that allows the plate skirt to
slide under the overhanging feature freely. It is important the overhanging feature is clearly
above the skirts on all plates and tip racks that are used in a particular plate position or a
misalignment with the pipette tips can occur.
Test the configuration after installation.

Removing a Plate Hold-Down Device

To remove the existing plate hold-down:
1. Clear the system of plate or tips that can interfere with the position from which you are

removing the plate hold-down device.
2. Use a Phillips #2 or #3 screwdriver to loosen and remove the screws from the center of

the devices.
3. Remove the plate hold-down device.

Installating a Plate Hold-Down Device

To install or reposition the plate hold-down:
1. Place the device in its proper orientation so that the numbers appear upright when

viewed looking through themain user access door.
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2. Insert one of the flat head screws that was originally securing the device or one included
in the accessory kit through the hole in the device and into the screw threads on the left
side of the plate-retaining pockets. Tighten the screw firmly. The device is self locating,
therefore no additional alignment is necessary.

3. If plates or tip blocks with different flange heights are to be used in the same position,
use the device specified for the largest flange thickness.

4. Test the plates or tip blocks to be used by inserting them into the plate pockets at the
location in which they are used.

5. Observe that when the plate is released it is pushed to the left under the retaining
device. It should come to rest against the edge locating surfaces on the left and nearest
the door.

6. Pull up on the plate gently.

Tip: A definite retaining force should be felt. A sideways movement during lifting
can cause the plate to slide out from under the retaining device and be lifted
upward without retention. This does not happen during instrument operation
but might require attention to be avoid when lifting a plate by hand.
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Chapter 9: Troubleshooting

This chapter contains tables of symptoms and solutions to help you diagnose and repair
problems with the FLIPR Penta System. In some cases, you need to contact Molecular
Devices Technical Support. See Obtaining Support on page 226.

Instrument Status Colors
ScreenWorks Software is designed to handlemost errors that occur when running the
FLIPR Penta System. The status of the system is reported in the Instrument Status panel. For
details, see Software Status Tabs on page 21.

Depending on the state of the instrument, a color icon displays at the bottom right of the
Instrument Status window.

If the Instrument Status
Color is...

Then there is...

Green Proper and open communication.

Yellow Minor communication error. Clear error by selecting Clear Error from
the Instrument menu.

Red Instrument failure. Instrument must be reset by selecting Reset from
the Instrument menu.

Black No instrument communication available. This is typically shown when
working in Offline mode.

Troubleshooting Start-Up

Symptom or Error Message Possible Causes Solutions

“Connecting to the instrument, please wait. Will enter
offline if the instrument is not connected or if this
dialog is closed. Dialog may not close immediately on
pressing the close button while connection is being
attempted.”

ScreenWorks Software is
waiting for the
FLIPR Penta System to
complete initialization
prior to connecting.

Wait until Assay Finished
(Unlocked) light is the only light
illuminated on the front
instrument panel before the
software and instrument connect.

"Camera chiller subsystem not functional. Please
contact Technical Support. Can't communicate with
chiller."

Instrument is not
communicating with the
chiller.

Make sure the chiller is turned ON.
Contact Technical Support. See
Obtaining Support on page 226.

Table 9-1: Start-Up Error Messages

9
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Symptom or Error Message Possible Causes Solutions

409:“Initialization halted because tips are loaded.
Please verify that the appropriate tip rack (96 or 384
tip rack, 1536 tip block, or 384, 1536 pin tool holder)
is loaded and select RESET”.

Tips are on the pipettor
head and need to be
unloaded during
instrument
initialization/reset.

Place tip rack in source 1/tip
loading position to unload tips and
select Reset from the Instrument
menu.

410: “Initialization halted. Either the upper or lower
door is open. Please shut both doors and select
RESET”.

The door is open during
instrument
initialization/reset.

Close the upper and lower doors
and select Reset from the
Instrument menu.

411: “Front Panel Interrupt button was pushed while
initializing. Initializing was not completed. Select Reset
when ready to continue.”

The front panel interrupt
button was pushed,
stopping instrument
initialization.

Select Reset from the Instrument
menu.

“Disconnected” is displayed in the bottom of the
Instrument Status Window.

ScreenWorks Software is
in Offline Mode.

Select Go Online from the
Instrument drop-down menu.

Multiple software copies
are open.

Close all versions of ScreenWorks
Software before starting software.

Instrument timed-out. Select Go Online from the
Instrument drop-down menu.

Instrument Configuration does not show desired
components installed on instrument.

Instrument does not
have proper
components installed.

Install proper components and
restart system.

ScreenWorks Software is
in Offline Mode.

Select Go Online from the
Instrument drop-down menu.

“Camera Temp” not in its operating temperature
range
EMCCD camera: -70°C (-94°F) ± 2°C
HS EMCCD camera: -70°C (-94°F) ± 2°C
ICCD camera: -20°C (-4°F) ± 5°C

Camera is not cooled
down to temperature.

Allow 10 minutes for camera
temperature to cool. Make sure
the chiller is working properly.

Contact Technical Support. See
Obtaining Support on page 226.

“Chamber Temp” not at desired temperature. Heated stage is not
warming to desired
temperature.

Allow 15 minutes for the chamber
to warm to the desired
temperature.

Contact Technical Support. See
Obtaining Support on page 226.

Temperature control is
not ON.

Turn on heated stage by selecting
Temperature Control ON from
the Instrument > Manual
Operation drop-down menu.

Table 9-1: Start-Up Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

Pipettor head is in the plate after the instrument
initializes.

Instrument did not
initialize properly.

Select Reset from the Instrument
drop-down menu.

Contact Technical Support. See
Obtaining Support on page 226.

Table 9-1: Start-Up Error Messages (continued)

General Troubleshooting

Symptom or Error Message Possible Causes Solutions

201: “Upper door open”. Upper door (outer) is
not closed.

Close outer (upper) door.

202: “Both upper and lower
doors open”.

Both upper (outer) and
lower doors are not
closed.

Close outer (upper) and lower doors.

203: “Lower door open”. Lower door (outer) is
not closed.

Close lower door.

204: “Read plate position
empty”.

No plate is present in
the Read position.

Place appropriate plate in the Read position.

205: “Source 1 plate position
empty”.

No plate is present in
the Source 1 position.

Place appropriate plate in the Source 1 position.

206: “Source 2 plate position
empty”.

No plate is present in
the Source 2 position.

Place appropriate plate in the Source 2 position.

207: “Source 3 plate position
empty”.

No plate is present in
the Source position.

Place appropriate plate in the Source 3.

229: “Attempting to read a
source only plate. Please assign a
read plate to the read position, or
if it is a read plate, go to TOOLS,
PLATE LIBRARY and define the
mask positions using the
appropriate yellow plate.”

The plate selected for
the read position
cannot be read
because no mask has
been identified.

Convert from a source only to a read plate using the plate
library.

100: “Command not found.” Input command is not
valid. See appended
string on the error
message for details.

Contact Technical Support. See Obtaining Support on
page 226.

101: “Invalid argument.” Input argument is not
valid. See appended
string on the error
message for details.

Contact Technical Support. See Obtaining Support on
page 226.

Table 9-2: General System Error Messages
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Symptom or Error Message Possible Causes Solutions

102: “Invalid number of
arguments.”

Number of input
arguments is not valid.
See appended string
on the error message
for details.

Contact Technical Support. See Obtaining Support on
page 226.

103: “Invalid start of command.” Start of command is
not valid. See
appended string on
the error message for
details.

Contact Technical Support. See Obtaining Support on
page 226.

104: “Command invalid, system
busy.”

The system cannot act
upon the command, as
the system is busy. See
appended string on
the error message for
details.

Contact Technical Support. See Obtaining Support on
page 226.

“Data buffer full”. The data buffer is full.
See appended string
on the error message
for details.

Contact Technical Support. See Obtaining Support on
page 226.

106: “Option not installed,
command unavailable”.

Pipettor head, LED,
Emission Filter or
FLIPR Cycler is not
installed.

Install option you want to use.

Change protocol to use available instrument options.

107: “Command failed”. General failure. Contact Technical Support. See Obtaining Support on
page 226.

108: “Command failed, system in
an error state".

Minor communication
error occurred.

Select Clear Error command from Instrument drop-
down menu.

109: “Command failed, system
not initialized “

Communication failed
between software and
instrument.

Select Reset from the Instrument drop-down menu.

Turn the instrument power switch OFF then ON to cycle
power.

“Password does not match”. User password is
incorrect.

Contact your instrument administrator for the
appropriate user name and password.

“Input not accepted”. Input value is not valid
(e.g., select greater
than 16 time sequence
files in the Export
menu). See appended
string on the error
message for details.

Change the input value so it is within the specified range.

Table 9-2: General System Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

302: “Temperature system not
functional. Please contact
Technical Support. You will not
be able to run protocols with
temperature control until it is
repaired.”

Can’t read the
temperature sensors
for the heated stage.

Select Reset command from the Instrument drop-down
menu to reset instrument to see if communication can be
reconnected.

Contact Technical Support. See Obtaining Support on
page 226.

Data files cannot be found Use Windows’ Find utility to search for file names and
determine where files were saved. Default location for
ScreenWorks files is C:\Program Files\Molecular
Devices\ScreenWorks\ Data.

Hard drive fills up with data files. Files unnecessarily
saved with *.tif file.

Discard unwanted *.tif files.

Data not archived. Create free space in the hard drive.

“Image” option in Experiment
window is grayed out.

Save images not
selected in Read with
TF process.

Save subsequent data with Save images selected in
protocol.

*.tif files not found
(deleted or moved) in
data folder.

*.tif files must be saved in same folder as data to retain
Image button option.

309: “Unable to modify or delete
selected plate. It does not exist.”

Plate does not exist. Contact Technical Support. See Obtaining Support on
page 226.

401: “Input/Output PCB not
functional. Please contact
Technical Support. You will not
be able to run protocols until it is
repaired.”

Input/Output PCB not
functional.

Contact Technical Support. See Obtaining Support on
page 226.

402: “Motion reports a fatal
error. Please select Reset. If this
error repeats, please contact
Technical Support.”

Motion reports a fatal
error.

Contact Technical Support. See Obtaining Support on
page 226.

403: “Motion timeout waiting for
done. Please select Reset. If this
error repeats, please contact
Technical Support.”

Instrument motion
timed out prior to
receiving “done”
command from
instrument.

Select Reset from the Instrument menu.

Contact Technical Support. See Obtaining Support on
page 226.

404: “Motion timeout waiting for
echo. Please select Reset. If this
error repeats, please contact
Technical Support.”

Instrument motion
timed out while
waiting for an echo.

Select Reset from the Instrument menu.

Contact Technical Support. See Obtaining Support on
page 226.

Table 9-2: General System Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

405: “Motion communication
fault. Please select Reset. If this
error repeats, please contact
Technical Support.”

Motion
communication fault.

Select Reset from the Instrument menu.

Contact Technical Support. See Obtaining Support on
page 226.

406: “Invalid DONE response
from motion. Please select Reset.
If this error repeats, please
contact Technical Support.”

Invalid DONE response
from motion.

Turn the instrument off. Wait 15 seconds. Turn
instrument on.

Contact Technical Support. See Obtaining Support on
page 226.

407: “LCB read/write test failed.
Please select Reset. If this error
repeats, please contact Technical
Support.”

LCB read/write test
failed.

Select Reset from the Instrument menu.

Contact Technical Support. See Obtaining Support on
page 226.

408: “Plate format file fault.
Please contact Technical Support.
You will be unable to use this
plate until repaired.”

Plate format file fault. Select Reset from the Instrument menu.

Contact Technical Support. See Obtaining Support on
page 226.

ScreenWorks indicates the user-
defined name of the data file is
invalid.

Illegal characters were
used in the file name.

Eliminate illegal characters from userdefined name (for
example, “ , ’ : ? ; ) .

User-defined name
includes too many
characters.

Use 25 characters or less in the user-defined name.

Saturation detected. One or more wells in
the microplate
saturated the camera.

A saturation warning in either the signal test dialog or on
a plate prevent you from reading the plate. It is at the
discretion of the user to decide whether to address the
saturation warning or proceed forward. If multiple wells
within a plate are saturating the camera, decrease the
Excitation Intensity, Exposure Time, or Camera Gain to
prevent saturation.

Table 9-2: General System Error Messages (continued)

Troubleshooting the Pipettor

Symptom or Error Message Possible Causes Solutions

Cannot uninstall pipettor head. The D-Axis Knurled Nut is caught
on the D-Axis receiver.

Grasp the D-Axis Knurled Nut receiver and press
downward to give the pipettor head additional
clearance from the D-Axis Knurled Nut.

Pipettor head is caught on the
alignment pins.

Lift the pipettor head up prior to moving left to lift
the pipettor head off of the pipettor mount
alignment pins.

Table 9-3: Pipettor Error Messages
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Symptom or Error Message Possible Causes Solutions

Cannot install pipettor head. The Head Clamp Knob is not
tightening all the way down.

Slide the pipettor head all the way to the right
over the pipettor mount. When installed properly
on the alignment pins, the pipettor head should
not slide left without lifting.

D-Axis Knurled Nut does not
reach receiver threads.

Lift D-axis receiver to engage threads and then
tighten the D-Axis Knurled Nut.

231: “Pipettor head not
detected. Please verify proper
installation and select Reset.”

No pipettor head is present on
pipettor mount.

Install appropriate pipettor onto instrument.

Pipettor head is not installed
properly.

Head clamp knob may not be secured tightly for
instrument to identify pipettor head. Reinstall
pipettor head.

The open protocol may not use
the pipettor on the instrument.

Install appropriate pipettor onto instrument.

Change plate format used in the software to
match the pipettor head.

208: “Unable to load tips. Tips
are already on pipettor.”

Tips are already present on
pipettor.

If you would like to change tips, selectUnload
Tips from the Instrument > Manual Operation
drop-down menu. Once tips are exchanged,
select Load Tips from the same drop-down menu.

If want to keep the present tips on, clear error
and proceed with your experiment.

209: “Unable to unload tips.
There are no tips loaded on the
pipettor.”

No tips are present on the
pipettor head.

Clear error.

233: Unable to dispense. No
tips loaded on pipettor.”

No tips are present on the
pipettor head.

Load tips manually on the pipettor head using the
Load Tips command which is found in the
Instrument > Manual Operation drop-down
menu.

Change protocol to include loading of tips at the
beginning of the experiment.

234: “Unable to aspirate. No
tips loaded on pipettor.”

No tips are present on the
pipettor head.

Load tips manually on the pipettor head using the
Load Tips command which is found in the
Instrument > Manual Operation drop-down
menu.

Change protocol to include loading of tips at the
beginning of the experiment

Table 9-3: Pipettor Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

235: “Unable to place tips in
well. No tips loaded on
pipettor.”

No tips are present on the
pipettor head.

Load tips manually on the pipettor head using the
Load Tips command which is found in the
Instrument > Manual Operation drop-down
menu.

Change protocol to include loading of tips at the
beginning of the experiment

236: “Unable to mix. No tips
loaded on pipettor.”

No tips are present on the
pipettor head.

Load tips manually on the pipettor head using the
Load Tips command which is found in the
Instrument > Manual Operation drop-down
menu.

Change protocol to include loading of tips at the
beginning of the experiment

237: “Unable to wash. No tips
loaded on pipettor.”

No tips are present on the
pipettor head.

Load tips manually on the pipettor head using the
Load Tips command which is found in the
Instrument > Manual Operation drop-down
menu.

Change protocol to include loading of tips at the
beginning of the experiment

246: “Unable to change head.
Please unload tips and select
Change Head again.”

“Change Head” action cannot be
performed unless tips are
removed.

Unload tips manually from the pipettor head using
the Unload Tips command which is found in the
Instrument > Manual Operation drop-down
menu.

Some tips are left in the tip
rack after loading the tips.

Pipettor calibration failure. Contact Technical Support. See Obtaining Support
on page 226.

Some tips are left on the
pipettor after unloading.

Pipettor calibration failure. Contact Technical Support. See Obtaining Support
on page 226.

The tip rack is attached to the
tips.

Tip box failure. Remove tip box from tips. Choose Instrument >
Manual Operation > Unload Tips to unload tips to
tip loading position.

Contact Technical Support. See Obtaining Support
on page 226.

242: “The selected read plate
has fewer wells than the
pipettor head. Please select a
plate with a matching format.”

The pipettor head and read plate
format is incompatible (e.g.,
1536 pipettor head with 96-well
plate).

Load the appropriate pipettor head type.

Change protocol to include read plate format that
is compatible with pipettor head.

243: “The selected source 1
plate has fewer wells than the
pipettor head. Please select a
plate with a matching format.”

The pipettor head and Source 1
plate format is incompatible
(e.g., 1536 pipettor head with
96-well plate).

Load the appropriate pipettor head type.

Change protocol to include Source 1 plate format
that is compatible with pipettor head.

Table 9-3: Pipettor Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

244: “The selected source 2
plate has fewer wells than the
pipettor head. Please select a
plate with a matching format.”

The pipettor head and Source 2
plate format is incompatible
(e.g., 1536 pipettor head with
96-well plate).

Load the appropriate pipettor head type.

Change protocol to include Source 2 plate format
that is compatible with pipettor head.

245: “The selected source 3
plate has fewer wells than the
pipettor head. Please select a
plate with a matching format.”

The pipettor head and Source 3
plate format is incompatible
(e.g., 1536 pipettor head with
96-well plate).

Load the appropriate pipettor head type.

Change protocol to include Source 3 plate format
that is compatible with pipettor head.

“Volume is too large.” Volume is too large for the
pipettor head or plate format
you are using. See appended
string on the error message for
details.

Reduce the volume that you are
aspirating/dispensing so it is within the specified
range.

“Volume is too small.” Volume is too small for the
pipettor head or plate format
you are using. See appended
string on the error message for
details.

Increase the volume that you are
aspirating/dispensing so it is within the specified
range.

“Speed is too large.” Speed is too large for the
pipettor head or plate format
you are using. See appended
string on the error message for
details.

Reduce the speed that you are
aspirating/dispensing so it is within the specified
range.

“Speed is too small.” Speed is too small for the
pipettor head or plate format
you are using. See appended
string on the error message for
details.

Increase the speed that you are
aspirating/dispensing so it is within the specified
range.

“Height is too large.” Height is too large for the
pipettor head or plate format
you are using. See appended
string on the error message for
details.

Reduce the height that you are
aspirating/dispensing so it is within the specified
range.

“Height is too small.” Height is too small for the
pipettor head or plate format
you are using. See appended
string on the error message for
details.

Increase the height that you are
aspirating/dispensing so it is within the specified
range.

“Done with plate after
aspiration” is not present.

FLIPR Cycler is not present on
instrument.

Must install FLIPR Cycler on instrument for
command to be available.

Table 9-3: Pipettor Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

“Done with plate after
dispense” is not present.

FLIPR Cycler is not present on
instrument.

Must install FLIPR Cycler on instrument for
command to be available.

Dialog does not appear because
you are dispensing to the Read
plate position.

Read plate is automatically changed at the end of
an experiment when in Remote Mode.

“Mix Fluid After Dispense” is
not present.

Command is not available when
“Single aspirate – Multiple
dispense” fluid transfer type is
selected.

Select either Single aspirate – Single dispense or
Multiple aspirate – Single dispense fluid transfer
types.

Table 9-3: Pipettor Error Messages (continued)

Troubleshooting the Optics

Symptom or Error Message Possible Causes Solutions

240: “Attempting to use a LED module
that is not installed. Please install the
desired LED banks.”

Specified LED module in protocol is not
installed.

Install the appropriate
LED banks.

Select the appropriate
LED module that is
already installed on the
instrument.

241: “Attempting to use an emission filter
that is not installed. Please install the
desired emission filter.”

Specified emission filter in the protocol is not
installed.

Install the appropriate
emission filter.

Select the appropriate
emission filter that is
already installed on the
instrument.

210: “Unable to read plate. Calibration not
valid for emission/excitation pair.”

A calibration file is not available for the
LED/emission filter combination selected.

Calibrate instrument for
desired LED/emission
filter pair.

214: “The 2 upper LED banks are not
identical wavelengths. Please install
identical wavelengths to both upper
positions.”

The upper pair of LED banks has mismatched
LED module wavelengths.

Make sure LEDs of the
same wavelength are
located in the upper LED
bank position on either
side of the read plate.

215: “The 2 lower LED banks are not
identical wavelengths. Please install
identical wavelengths to both lower
positions.”

The lower pair of LED banks has mismatched
LED module wavelengths.

Make sure LEDs of the
same wavelength are
located in the lower LED
bank position on either
side of the read plate.

Table 9-4: Optics System Error Messages
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Symptom or Error Message Possible Causes Solutions

217: “One or more LED banks not
detected. Please verify all four banks
firmly installed.”

Cannot detect one of the LED modules. Make sure LED module is
properly connected.

Contact Technical
Support. See Obtaining
Support on page 226.

216: “LED module configuration/position
has changes. Please recalibrate.”

LED module position changed from where it
was flat-field calibrated.

Calibrate instrument for
current LED
configuration.

Place LEDs in previous
calibrated position.

303: “LED modules not calibrated.” None of the installed LED banks have been
flat-field calibrated.

Calibrate instrument
with installed LED banks.

A LED inside the LED bank burned out. Calibrate instrument
with installed LED banks.

Replace LED bank if you
are unable to recalibrate
LED bank.

Contact Technical
Support. See Obtaining
Support on page 226.

306: “Flat field calibration failed. Please
verify that the correct plate is loaded.
Please repeat flat field calibration.”

Flat Field calibration failed; see appended
string on the error message for details.

Calibrate using the
correct Flat Field
calibration plate in the
Read position.

Contact Technical
Support. See Obtaining
Support on page 226.

218: “Unable to define plate mask. Please
install 515–575 nm emission filter.”

The 515–575 nm emission filter is not
installed. Thus, mask alignment cannot be
performed.

Install the 515–575 nm
emission filter to match
the calibration file.

Calibrate instrument
with new emission filter.

219: “Unable to define plate mask. Please
install 470–495 nm LED banks.”

The 470–495 LED banks are not installed.
Thus, mask alignment cannot be performed.

Install the 470–495 nm
LED banks to match the
calibration file.

Calibrate instrument
with new LED bank.

Table 9-4: Optics System Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

307: “Unable to complete plate mask
definition. Incorrect number of wells
found. Please verify that the correct plate
is loaded and repeat.”

Mask alignment failed because it didn’t find
the correct number of wells (e.g., must find
384 wells for a 384 well plate).

Correct read plate
format must be in Read
position.

308: “Unable to complete plate mask
definition. Found overlapping wells. Please
contact Technical Support. You will not be
able to run protocols using this plate until
the instrument is repaired.”

Plate is tilted/popped out of position. Make sure read plate is
properly aligned in Read
position.

310: “Unable to perform gain curve.
Please insert 515–575 nm emission filter.”

515–575 nm emission filter is not installed on
system.

Install the 515–575 nm
emission filter prior to
performing gain curve.

Contact Technical
Support. See Obtaining
Support on page 226.

311: “Unable to perform gain curve.
Please insert 470–495 nm LED banks.”

470–495 nm LED banks are not installed on
system.

Install the 470–495 nm
LED banks prior to
performing gain curve.

Contact Technical
Support. See Obtaining
Support on page 226.

304: “Gain calibration failed. Please
contact Technical Support.”

Contact Technical
Support. See Obtaining
Support on page 226.

Excitation/Emission wavelength is not
available in the “edit read mode” dialog.

Instrument was not calibrated for the
excitation/emission pair for which you are
looking.

Calibrate instrument for
the Excitation/Emission
pair for which you are
looking.

“Exposure time is too large.” The exposure time for the camera is too large.
See appended string on the error message
for details.

Decrease the exposure
time so it is within the
specified range.

“Exposure time is too small.” The exposure time for the camera is too
small. See appended string on the error
message for details.

Increase the exposure
time so it is within the
specified range.

200: “Read interval too short.” Read interval is shorter than the sum of
exposure lengths for each read interval in
addition to the camera processing time.

Set a longer read
interval.

Table 9-4: Optics System Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

“First interval is too small.” The time for the first interval is too short.
Interval time must always be longer than the
sum of all selected read modes plus the
computer processing time. See appended
string on the error message for details.

Increase the read
interval so it is within the
specified range.

“First interval is too large.” The time for the first interval is too large. See
appended string on the error message for
details.

Decrease the read
interval so it is within the
specified range.

“First interval number of reads is too
large.”

The number of reads in the first interval is too
large. See appended string on the error
message for details.

Decrease the number of
reads so it is within the
specified range.

“Number of reads before dispense are too
large.”

Number of reads prior to dispense are larger
than the number of reads in the first interval.
See appended string on the error message for
details.

Decrease the number of
reads before dispense so
it is within the specified
range.

238: “Protocol requests greater than 800
reads. This is not permitted.”

Sum of all reads for all read actions and
configurations must not exceed 800.

Reduce the number of
reads in the experiment
to less than 800 for all
combined read modes.

239: “Protocol requests greater than 50
images. This is not permitted.”

Sum of all raw images for all read actions and
configurations must not exceed 50.

Reduce the number of
raw images in the
experiment to less than
50 for all combined
dispenses.

400: “Camera is not functional. Please
contact Technical Support. You will not be
able to run protocols until it is repaired.”

Camera is not functional. Contact Technical
Support. See Obtaining
Support on page 226.

Table 9-4: Optics System Error Messages (continued)
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Troubleshooting the Yellow Plate

Symptom or Error Message Possible Causes Solutions

“Saturation detected, data may be invalid.” Incorrect settings. Set excitation intensity to 80%, exposure length to
0.1 s and for EMCCD gain to 80, for ICCD gate to 3%. If
condition repeats, lower excitation intensity.

Incorrect LED
and/or emission
filter choice.

Check to make sure the appropriate LED and
emission filters are selected.

Emission optics
are dirty.

Make sure no dust is on emission filters.

Bottom of Read
plate is dirty.

Make sure no dust or fluorescent compounds are on
the bottom of the Read plate.

Wells are cut off in Image Viewer. Plate not
properly placed
in Read position

Make sure plate is properly placed and indexed in
the Read position.

Dirty/misaligned
optics.

Contact Technical Support. See Obtaining Support on
page 226.

Fluorescence counts are 0. LED power is off. Increase excitation intensity of LEDs.

Make sure Excitation/Emission Wavelength in the
read mode does not have NONE for the excitation
wavelength.

Camera failure. Contact Technical Support. See Obtaining Support on
page 226.

Signal test was
not initiated.

Select Test Signal in the Signal Test dialog.

Table 9-5: Yellow Plate Testing Error Messages
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Symptom or Error Message Possible Causes Solutions

Standard deviation for the signal test is
greater than 5% and fluorescence counts
may or may not be in the correct range.

Instrument was
calibrated with
yellow boat.

If instrument was calibrated using the yellow boat,
the standard deviation can be 5% or less.

Camera not fully
cooled down.

Wait approximately 10 minutes for the camera
temperature to cool down.

Optical
correction out of
specifications

Perform Flat-Field calibration.

Plate is not
aligned properly
in Read position.

Make sure plate is properly aligned and indexed in
the Read position.

Optics is dirty or
failing.

Contact Technical Support. See Obtaining Support on
page 226.

Calibration plate
failure— plate is
dirty or
scratched.

Clean calibration plate with lens paper. DO NOT use
lab wipes. If cleaning does not work, replace the
calibration plate.

Table 9-5: Yellow Plate Testing Error Messages (continued)

Troubleshooting the Tip Washer

Symptom or Error Message Possible Causes Solutions

221: “Tip wash reservoir format
(96/384/1536) does not match pipettor
head. Please install matching reservoir and
select Reset.”

Pipettor head and tip washer
reservoir top do not match (e.g.,
a 384 Pipettor head with a 96-
well reservoir top).

Install appropriate pipettor head to
match tip wash reservoir top.

Install appropriate tip wash reservoir
top to match pipettor head.

222: “Tip wash reservoir top not detected.
Please install matching reservoir and select
Reset.”

No reservoir top is installed. Install appropriate tip wash reservoir
top.

Tip wash reservoir top is not
properly installed.

Tip wash reservoir top connectors
may not be properly connected.

223: “Check Waste Bottle A - sensor
indicates full.”

Waste bottle A is full with tip
wash solvent.

Empty tip wash solvent from waste
bottle A.

224: "Check Waste Bottle B - sensor
indicates full."

Waste bottle B is full with tip
wash solvent.

Empty tip wash solvent from waste
bottle B.

225: "Check TipWasher - sensor indicates
overflow."

Waste bottles are full. Empty tip wash solvent from waste
bottles A and B and select Reset.

Fluid level sensor malfunction. Contact Technical Support. See
Obtaining Support on page 226.

Table 9-6: Tip Washer System Error Messages
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Symptom or Error Message Possible Causes Solutions

226: "TipWasher: Check Wash Fluid Bottle
A - fill sensor dry."

Fill Bottle A is empty. Place tip wash solvent into Fill Bottle
A.

227: "TipWasher: Check Wash Fluid Bottle
B - fill sensor dry."

Fill Bottle B is empty. Place tip wash solvent into Fill Bottle
B.

250: "TipWasher: Check Wash fluid. Fill
sensor dry during fill after prime."

The selected wash bottle might
be running low on fluid.

Check the wash bottles.

251: "TipWasher: Check Wash fluid. Fill
sensor dry after fill."

The selected wash bottle might
be running low on fluid.

Check the wash bottles.

252: "TipWasher: Check Wash Fluid Bottles
A and B - sensor indicates empty."

Both of the wash bottles are
detected empty.

Add fluid to both wash bottles.

254: "TipWasher: Check tubing at Fill Pump
- fill sensor wet after draining line."

Fluid sensor is detecting fluid
when it should not.

Check for any unconnected tubing.
Contact Technical Support. See
Obtaining Support on page 226.

301: “Tip wash module not functional.
Please contact Technical Support. You will
not be able to run protocols with tip
washing until it is repaired.”

Can’t communicate with the Tip
Washer.

Select Reset command from the
Instrument drop-down menu to reset
instrument to see if communication
can be reconnected.

Table 9-6: Tip Washer System Error Messages (continued)

Troubleshooting the Cell Reservoir

Symptom or Error Message Possible Causes Solutions

255 “CellReservoir: Reservoir not detected. Please install it
at Source 3 position and select Refresh Configuration from
Instrument menu bar.”

Instrument cannot detect
the cell reservoir.

Check to make sure the Cell
Reservoir is installed.

Check the connection of the
reservoir sensor inside the
instrument.

256 “CellReservoir: prime sensor dry during prime/fill.
Please check Fluid Bottle 1”.

Fluid sensor is not
detecting fluid when
pumping from Fluid 1.

Check to make sure that
Fluid 1 bottle is not empty.

257 “CellReservoir: prime sensor dry during prime/fill.
Please check Fluid Bottle 2”.

Fluid sensor is not
detecting fluid when
pumping from Fluid 2.

Check to make sure that
Fluid 2 bottle is not empty.

258 “CellReservoir: prime sensor dry during prime/fill.
Please check Fluid Bottle 3”.

Fluid sensor is not
detecting fluid when
pumping from Fluid 3.

Check to make sure that
Fluid 3 bottle is not empty.

Table 9-7: Cell Reservoir System Error Messages
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Symptom or Error Message Possible Causes Solutions

259 “CellReservoir: prime sensor dry during prime/fill.
Please check Fluid Bottle 4”.

Fluid sensor is not
detecting fluid when
pumping from Fluid 4.

Check to make sure that
Fluid 4 bottle is not empty.

Table 9-7: Cell Reservoir System Error Messages (continued)

Troubleshooting Data

Symptom or Error Message Possible Causes Solutions

Negative control wells show a response. Wash buffer components
are different from the
compound buffer.

Make sure wash buffer and compound
buffer are the same. Check for a DMSO
stimulation, if present.

Statistical results do not conform to the
expected results.

Data analysis has not been
optimally set up.

Refer to Data Processing Algorithms on
page 249.

Data parameters need to be reset (subtract bias,
spatial uniformity correction, positive control,
etc.) for each experiment.

*.vamp file parameters
not set up correctly.

Select the Grouping or Correction
buttons to adjust the parameters as
necessary.

False negative wells. Pipettor adjustment
problem.

See Optimizing an Assay.

Tip problem. Contact Technical Support. See
Obtaining Support on page 226.

Table 9-8: Data Processing Error Messages

Troubleshooting Robotic Integration

Symptom or Error Message Possible Causes Solutions

220: “Unable to load plate. No
plate on landing pad.”

Plate present on plate
landing pad, but plate
presence was not detected.

Contact Technical Support. See Obtaining Support on
page 226.

If plate not positioned properly by robot, contact
Technical Support for robot manufacturer.

No plate was delivered to
landing pad by 3rd party
robot.

Contact Technical Support for robot manufacturer.

221: “Unable to load plate.
Plate already detected at
requested location.”

Plate already at requested
position.

Unload plate currently in the desired position prior to
delivering new plate.

If robot is attempting to load multiple plates to one
position without retrieving plates, contact Technical
Support for robot manufacturer.

Table 9-9: Robotic Integration System Error Messages



FLIPR Penta High Throughput Cellular Screening System User Guide

226 5069582 B

Symptom or Error Message Possible Causes Solutions

222: “Unable to unload plate.
Plate already detected at
landing pad

Plate already present on
landing pad.

Remove plate on landing pad prior to unloading a new
plate.

223: “Unable to unload plate.
No plate detected at
requested position.”

No plate present in position. Clear error and proceed with experiment.

Plate may have popped out
of position.

Clear plate that is out of position prior to resuming
experiment.

Bar code reader misreads the
bar code and file name reads
“Bad_bar_code”.

Misplacement of bar code
or incorrect type of bar
code.

Bar code must be on the side of the plate where the
bar code is reading. Place label as low as possible. Use
labels with numbers on top.

Table 9-9: Robotic Integration System Error Messages (continued)

Obtaining Support
Molecular Devices is a leading worldwidemanufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products
and to fully supporting our customers with the highest level of technical service.
Our Support website, www.moleculardevices.com/service-support, has a link to the
Knowledge Base, which contains technical notes, software upgrades, safety data sheets, and
other resources. If you still need assistance after consulting the Knowledge Base, you can
submit a request to Molecular Devices Technical Support.
You can contact your local representative or Molecular Devices Technical Support at
800-635-5577 (North America only) or +1 408-747-1700. In Europe, call +44 (0) 118 944 8000.
Please have your instrument serial number or Work Order number, and your software
version number available when you call.

WARNING! BIOHAZARD. It is your responsibility to decontaminate
components of the instrument before you return parts to Molecular Devices for
repair. Molecular Devices does not accept items that have not been
decontaminated where it is applicable to do so. If parts are returned, they must be
enclosed in a sealed plastic bag stating that the contents are safe to handle and
are not contaminated.

http://www.moleculardevices.com/service-support
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Appendix A: Technical Specifications

The following table lists the technical specifications for the FLIPR Penta High-Throughput
Cellular Screening System.

Item Description

Instrument Dimensions

Size Inches—39 (W) x 70.25 (H) x 27 (D)
Centimeters—99 (W) x 178.44 (H) x 69 (D)

Weight (approx.) 850 lbs. (386 kg)

Throughput

Temperature control Ambient, +25°C to 40°C

Throughput 20 plates/hour (2-minute read time)

96-well 1,920 data points/hour

384-well 7,680 data points/hour

1536-well 30,720 data points/hour

Bar code manual mode 1 Keyboard entry

Bar code manual mode 2 Short or long side

EMCCD Camera Option

Camera type EMCCD

Detection Fluorescence

Mode Cooled CCD camera

Fluorescence sensitivity with Z' ≥ 0.5 (whole plate) 1.25 nM Fluorescein

Data acquisition rate 7 Hz

Ratiometrics Up to 4 EX/EM pairs per experiment

Data acquisition rate for ratiometric emission 2 Hz (2EX/EM pairs)

HS EMCCD Camera Option

Camera type HS EMCCD

Detection Luminescence and Fluorescence

Mode High-Speed, High-Sensitivity CCD Camera

Fluorescence sensitivity with Z' ≥ 0.5 (whole plate) 0.625 nM Fluorescein

Table A-1: FLIPR Penta High-Throughput Cellular Screening System Technical
Specifications

A
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Item Description

Luminescence sensitivity 4.1 nM ATP (Promega Cell Titer Glow Assay)

Data acquisition rate 100 Hz

Ratiometrics Up to 4 EX/EM pairs per experiment

Data acquisition rate for ratiometric emission 2 Hz (2EX/EM pairs)

ICCD Camera Option

Camera type ICCD

Detection Luminescence and Fluorescence

Mode Intensified CCD camera

Fluorescence sensitivity with Z' ≥ 0.5 (whole plate) 5 nM

Luminescence sensitivity 5,000 M5 AequoZen FroZen cells in 384-well
format with Z' ≥ 0.5

Dynamic range 4.8 log (1 measurement) 6.9 log (2
measurements)

Data acquisition rate 8 Hz

Ratiometrics Up to 4 EX/EM pairs per experiment

Data acquisition rate for ratiometric emission 2 Hz (2EX/EM pairs)

Excitation LEDs and Emission Filters

Wavelength range 335-626 nm 400-750 nm

Calcium (default) 470-495 nm 515-575 nm

Membrane potential 510-545 nm 565-625 nm

Voltage sensor probes
390-420 nm

440-480 nm
565-625 nm

Fura-2 335-345 nm
380-390 nm

475-535 nm

Instrument holds 2 pairs of LEDS, one for each side to cross-illuminate the bottom of the plate

Instrument has a 3 position filter slider that identifies the filter to the instrument

Custom filter holders are available

Fluidics

Simultaneous transfer 96, 384 and 1536

Range-96 pipettor head 5-200 μL

Precision @75 μL 3% CV

Table A-1: FLIPR Penta High-Throughput Cellular Screening System Technical
Specifications (continued)
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Item Description

Pipetting increments-96 pipettor head 1 μL

Range - 384-Well pipettor 1-25 μL

Precision @ 25 μL 4% CV

Pipetting increments - 384-Well pipettor 0.5 μL

Range - 1536-Well pipettor 0.5-3 μL

Precision @ 3 μL 6% CV

Precision @ 1 μL 10% CV

Pipetting increments - 1536-Well pipettor 0.1 μL

96 pipettor head - Quadrant transfer 384-well plate

384 pipettor head - Quadrant transfer 1536-well plate

Cell Suspension System

Cell reservoir Autoclavable

Compatible formats 96, 384, and 1536

Stir flasks available 250 mL, 0.5 L, 1 L, 3 L

Table A-1: FLIPR Penta High-Throughput Cellular Screening System Technical
Specifications (continued)



FLIPR Penta High Throughput Cellular Screening System User Guide

230 5069582 B



5069582 B 231

Appendix B: Consumables and Accessories

This following catalogs consumables used with the FLIPR Penta System, including:
System Accessories
Plates on page 234
Assays on page 237
Recommended Assay Equipment and Supplies on page 240

System Accessories

Field Installations

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® Camera Conversion Kit, ICCD or EMCCD to
HS EMCCD

5069580

FLIPR® Cell Suspension, Field Installation Kit 0310-5339

Windows 10 Host PC with ScreenWorks® Software
Version 5.0

5075062

Windows 10 Host PC with ScreenWorks® Software
Version 4.2

5074979

FLIPR® FLIPR® Cycler 5074848

Table B-1: Field Installations Kits

Pipetting Tips and 1536 Pipetting Accessories

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® pipette tips, black, non-sterile, 96-well, 50
racks/case

9000-0762

FLIPR® pipette tips, clear, non-sterile, 96-well, 50
racks/case

9000-0761

FLIPR® non-sterile, black, 384-well, 50 racks/case 9000-0764

FLIPR® pipette tips, clear, non-sterile, 384-well, 50
racks/case

9000-0763

FLIPR® 1536 tip gasket, nonsterile, 40 racks/case 9000-0746

FLIPR® 1536 tip block 0200-6112

Table B-2: Pipetting Consumables

B
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Item Part Number
1FLIPR® Pin Tool, 384 5075203
1FLIPR® Pin Tool, 1536 5075194

1. Contact your local Molecular Devices Sales Representative for details regarding this
configure-to- order item.

Table B-2: Pipetting Consumables (continued)

Pipettor Heads

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® Pipettor Head Kit, 96 0200-6071

FLIPR® Pipettor Head Kit, 384 0200-6072

FLIPR® Pipettor Head Kit, 1536 0200-6073
1FLIPR® Pin Tool Kit, 384 and/or 1536 FLIPR PIN TOOLS OC

1. Contact your local Molecular Devices Sales Representative for details regarding this
configure-to- order item.

Table B-3: Pipettor Head Kits

Optics Consumables

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® Calcium Optics Kit 0200-6206

FLIPR® Membrane Potential Optics Kit 0200-6207

FLIPR® Voltage Sensor Probes (VSP) Optics Kit 0200-6208

FLIPR® Fura-2 Optics Kit 0200-6271

FLIPR® LED Module, 335–345 nm (UV) 0200-6272

FLIPR® LED Module, 360–380 nm 0200-6178

FLIPR® LED Module, 380–390 nm (UV) 0200-6273

FLIPR® LED Module, 390–420 nm (VSP) 0200-6135

FLIPR® LED Module, 420–455 nm 0200-6148

FLIPR® LED Module, 470–495 nm (Calcium) 0200-6128

FLIPR® LED Module, 495–505 nm 0200-6175

FLIPR® LED Module, 510–545 nm (Membrane Potential) 0200-6127

Table B-4: Optics Kits



Appendix B: Consumables and Accessories

5069582 B 233

Item Part Number

FLIPR® LED Module, 610–626 nm 0200-6150

FLIPR® Emission Filter, 400–460 nm 0200-6213

FLIPR® Emission Filter, 440–480 nm (VSP) 0200-6205

FLIPR® Emission Filter, 475–535 nm 0200-6211

FLIPR® Emission Filter, 515–575 nm (Calcium) 0200-6203

FLIPR® Emission Filter, 526–586 nm 0200-6212

FLIPR® Emission Filter, 565–625 nm (Membrane Potential and VSP) 0200-6204

FLIPR® Emission Filter, 646–706 nm 0200-6214

FLIPR® Custom Filter Set (3) 0200-6221

FLIPR® Single Custom Filter Holder (1) 0200-6276

Table B-4: Optics Kits (continued)

Cell Reservoir Consumables

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® Cell Suspension Reservoir 0200-6222

FLIPR® 250 mL Flask Assembly 0200-6223

FLIPR® 500 mL Flask Assembly 0200-6224

FLIPR® 1 L Flask Assembly 0200-6225

FLIPR® 3 L Flask Assembly 0200-6226

FLIPR® 1 L Buffer Bottle 0200-6227

Table B-5: Cell Reservoir Consumables
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Plates
The following conforming plates, can be purchased from Molecular Devices.

96-Well Read Plates

96-Well Read Plates Part Number Suggested Supplier Phone Number

Black, clear, tissue culture
treated, sterile

353948 Becton Dickinson +1-800-343-2035

3603 Corning/Costar +1-800-492-1110

655090 Greiner (distributed
by E&K)

+1-408-378-2013

165305 Nalge/Nunc +1-800-766-7000

Black, clear, tissue culture
treated, sterile, poly-D-lysine
coated

356640 Becton Dickinson +1-800-343-2035

3667 Corning/Costar +1-800-492-1110

Black, clear, tissue culture
treated, sterile, collagen
coated

356649 Becton Dickinson +1-800-492-1110

White, clear, tissue culture
treated, sterile

353947 Becton Dickinson +1-800-343-2035

3903 Corning/Costar +1-800-492-1110

655098 Greiner (distributed
by E&K)

+1-408-378-2013

165306 Nalge/Nunc +1-800-766-7000

Table B-6: 96-Well Read Plates

96-Well Read Plate Masks Made by Molecular Devices

96-Well Read Plate
Masks

Part Number Plate Manufacturer

96-well slit mask 0200-6143 Becton Dickinson

2300-1362 Corning/Costar

0200-6142 Nalge/Nunc

0200-6144 Greiner

Table B-7: 96-Well Read Plate Masks Made by Molecular Devices
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96-Well Source Plates

96-Well Source Plates Part Number Suggested Supplier Phone Number

V-bottom plate, 96-well 353263
polypropylene

Becton Dickinson +1-800-343-2035

651201
polypropylene

Greiner (distributed
by E&K)

+1-408-378-2013

249944 Nalge/Nunc +1-800-766-7000

U-bottomed plate, 96-well 351190
polypropylene

Becton Dickinson +1-800-343-2035

3365 polypropylene Corning/Costar +1-800-492-1110

267245 Nalge/Nunc +1-800-766-7000

650201
polypropylene

Greiner (distributed
by E&K)

+1-408-378-2013

Deep-well plate, 96-well 353966
polypropylene

Becton Dickinson +1-800-343-2035

780270
polypropylene

Greiner (distributed
by E&K)

+1-408-378-2013

278752
polypropylene

Nalge/Nunc +1-800-766-7000

Table B-8: 96-Well Source Plates

384-Well Read Plates

384-Well Read Plates Part Number Suggested Supplier Phone Number

Black, clear, tissue culture
treated, sterile

353262 Becton Dickinson +1-800-343-2035

3712 Corning/Costar +1-800-492-1110

781091 Greiner with lids
(distributed by E&K)

+1-408-378-2013

MGB101-1-2 Matrical +1-509-343-6225

MGB101-1-3
0.17 mm-thick
glass

Matrical +1-509-343-6225

142761 Nalge/Nunc +1-800-766-7000

Black, clear bottom, tissue
culture treated, sterile, poly-D-
lysine coated

356663 Becton Dickinson +1-800-343-2035

3664 Corning/Costar +1-800-492-1110

Table B-9: 384-Well Read Plates
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384-Well Read Plates Part Number Suggested Supplier Phone Number

Black, clear, tissue culture
treated, sterile, collagen
coated

356667 Becton Dickinson +1-800-343-2035

White, clear, tissue culture
treated, sterile

353963 Becton Dickinson +1-800-343-2035

3707 Corning/Costar +1-800-492-1110

781098 Greiner (distributed
by E&K)

+1-408-378-2013

142762 Nalge/Nunc +1-800-766-7000

Low volume black, clear,
tissue culture treated, sterile

3542 Corning/Costar +1-800-492-1110

788092 Greiner (distributed
by E&K)

+1-408-378-2013

Table B-9: 384-Well Read Plates (continued)

384-Well Source Plates

384-Well Source Plates Part Number Suggested Supplier Phone Number

Flat bottom plate 353265
polypropylene

Becton Dickinson +1-800-343-2035

3702 polystyrene Corning/Costar +1-800-492-1110

781201
polypropylene

Greiner (distributed
by E&K)

+1-408-378-2013

265496 polystyrene Nalge/Nunc +1-800-766-7000

U/V-bottom plate 3657 polypropylene Corning/Costar +1-800-492-1110

781280
polypropylene

Greiner (distributed
by E&K)

+1-408-378-2013

264573
polypropylene

Nalge/Nunc +1-800-766-7000

Deep-well plate 353996
polypropylene

Becton Dickinson +1-800-343-2035

3965 polypropylene Corning/Costar +1-800-492-1110

781270
polypropylene

Greiner (distributed
by E&K)

+1-408-378-2013

MP102
polypropylene

Matrical +1-509-343-6225

Table B-10: 384-Well Source Plates 
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1536-Well Read Plates

1536-Well Read Plates Part Number Suggested Supplier Phone Number

Black/Clear, tissue culture
treated, sterile

783092 Greiner with lids
(distributed by
E&K)

+1-408-378-2013

White/Clear, tissue culture
treated, sterile

781098 Greiner
(distributed by
E&K)

+1-408-378-2013

Table B-11: 1536-Well Read Plates 

1536-Well Source Plates

1536-Well Source Plates Part Number Suggested Supplier Phone Number

Deep-well plate 782270
polypropylene

Greiner (distributed
by E&K)

+1-408-378-2013

Table B-12: 1536-Well Source Plates

Source Reservoirs

Source Reservoirs Part Number Suggested Supplier Phone Number

Omni tray 2428110
polystyrene

Nalge/Nunc +1-800-786-7000

Table B-13: Source Reservoirs

Assays

Calcium Flux Consumables and Accessories

Item Part Number Suggested Supplier Phone Number

FLIPR® Calcium 6 Assay Kit:
Bulk Kit
Explorer Kit
Express Kit

R8190
R8191
R8195

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Calcium 6 QF Assay Kit:
Bulk Kit
Explorer Kit
Express Kit

R8192
R8193
R8196

Molecular Devices +1-800-635-5577
+1-408-747-1700

Table B-14: Calcium Flux Consumables and Accessories
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Item Part Number Suggested Supplier Phone Number

FLIPR® Calcium 5 Assay Kit:
Bulk Kit
Explorer Kit
Express Kit

R8186
R8185
R8187

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Calcium 4 Assay Kit:
Bulk Kit
Explorer Kit
Express Kit

R8141
R8142
R8143

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Calcium 3 Assay Kit:
Bulk Kit
Explorer Kit
Express Kit

R8090
R8091
R8108

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Cardiocytoxicity Assay Kit:
Bulk Kit
Explorer Kit

R8211 (10 plates)
R8210 (2 plates)

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Fura-2 QBT Calcium Assay
Kit:
Bulk Kit
Explorer Kit

R8197
R8198

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Penta System Calcium
Optics Kit:

LED Module, 470-495 nm
Emission Filter, 515-575 nm

0200- 6206 Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Penta System Fura-2 Optics
Kit:

LED Module 333-345 nm
LED Module 380-390 nm
Emission Filter 475-535nm

0200-6271 Molecular Devices +1-800-635-5577
+1-408-747-1700

Hank’s Balanced Salt Solution (10X
stock)

14065- 056 Thermo Fisher 1-800-828-6686

HEPES buffer solution 1X 9319 Irvine Scientific +1-800-437-5706

Probenecid, crystalline P8761 Sigma +1-800-325-3010

Carbachol (receptormediated
positive control)

C4382

UTP, Na salt (receptormediated
positive control)

U6625

Ionomycin (positive control) 407950 CalBiochem +1-800-854-3417

Table B-14: Calcium Flux Consumables and Accessories (continued)
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Membrane Potential Assay Kit Consumables and Accessories

Item Part Number Suggested Supplier Phone Number

FLIPR® Membrane Potential
Assay Kit

R8034 (BLUE)
R8123 (RED)

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Penta System Membrane
Potential Optics Kit:

FLIPR® Penta System LED
Module, 510–545 nm
FLIPR® Penta System Emission
Filter, 565–625 nm

0200-6207 Molecular Devices +1-800-635-5577
+1-408-747-1700

Hank’s Balanced Salt Solution
(10X stock)

14065-056 Thermo Fisher 1-800-828-6686

HEPES buffer solution 1X 9319 Irvine Scientific +1-800-437-5706

Carbachol (receptor-mediated
positive control)

C4382 Sigma +1-800-325-3010

Table B-15: Membrane Potential Assay Kit Consumables and Accessories

Potassium Assay Kit Consumables and Accessories

Item Part Number Suggested Supplier Phone Number

FLIPR® Potassium Assay Kit
Evaluation Kit
Explorer Kit
Bulk Kit

R8330
R8222
R8223

Molecular Devices +1-800-635-5577
+1-408-747-1700

FLIPR® Penta System Calcium
Optics Kit:

FLIPR® Penta System LED
Module, 470-495 nm
FLIPR® Penta System Emission
Filter, 515-575 nm

0200-6206 Molecular Devices +1-800-635-5577
+1-408-747-1700

Hank’s Balanced Salt Solution
(10X stock)

14065-056 Thermo Fisher 1-800-828-6686

HEPES buffer solution 1X 9319 Irvine Scientific +1-800-437-5706

DMSO D8418 Sigma +1-800-325-3010

Probenecid P8761 Sigma +1-800-325-3010

Table B-16: Potassium Assay Kit Consumables and Accessories
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Recommended Assay Equipment and Supplies
The following recommended assay equipment and supplies are not available through
Molecular Devices:

5mL, 10mL, 25mL sterile serological pipettes
Rechargeable pipettor for 2–25mL pipettes
Sterile tissue culture water
Gloves
Culturemedium to grow cells
EDTA and Trypsin/EDTA to lift cells
Hemacytometer and counter
Sterile test tubes 15mL and 50mL or smaller tubes for compounds dilutions
1 NNaOH solution to dissolve probenecid



5069582 B 241

Appendix C: FLIPR Penta Plate Dimensions

Note: Molecular Devices is not responsible for instrument malfunctions if the
provided dimensions are incorrect.

The following dimensions derive from specifications distributed by the individual vendors.

Becton Dickinson

Plate Type Part # Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

96-well Black/Clear 353948 8 12 read 349 14.28 11.23 3.50 14.53 9.01

96-well Black/Clear,
Collagen-Coated

356649 8 12 read 349 14.28 11.23 3.50 14.53 9.01

96-well Black/Clear,
PDL-Coated

356640 8 12 read 349 14.28 11.23 3.50 14.53 9.01

96-well
White/Clear

353947 8 12 read 349 14.42 11.19 3.50 14.66 9.00

96-well U bottom,
polypropylene

351190 8 12 source 340 14.23 11.33 2.49 14.62 8.99

96-well V bottom,
polypropylene

353263 8 12 source 340 14.24 11.35 3.70 14.61 8.99

96-well 2mL Deep
Well,
polypropylene

353966 8 12 source 2000 13.88 10.62 — 44.24 9.04

384-well
Black/Clear

353962 16 24 read 120 12.21 9.05 2.90 14.32 4.49

384-well
Black/Clear,
Collagen-Coated

356667 16 24 read 120 12.21 9.05 2.90 14.32 4.49

384-well
Black/Clear,
PDL-coated

356663 16 24 read 120 12.21 9.05 2.90 14.32 4.49

384-well
White/Clear

353963 16 24 read 120 12.26 9.06 2.90 14.34 4.49

Table C-1: Becton Dickinson Plate Dimensions

C
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Plate Type Part # Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

384-well flat
bottom
polypropylene

353265 16 24 source 140 12.15 9.27 2.90 14.40 4.50

384-well Deep
Well,
polypropylene

353996 16 24 source 400 11.83 8.83 — 43.69 4.51

1536-well
Black/Clear

353255 32 48 read 12 11.04 7.85 3.80 10.41 2.25

1536-well
White/Clear

353258 32 48 read 12 11.03 7.84 3.80 10.42 2.25

Table C-1: Becton Dickinson Plate Dimensions (continued)

Corning/Costar

Plate Type Part
#

Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

96-well Black/Clear 3603 8 12 read 360 14.30 11.20 3.57 14.22 9.00

96-Well
Black/Clear,
PDL-Coated

3667 8 12 read 360 14.30 11.20 3.57 14.22 9.00

96-well
White/Clear

3903 8 12 read 360 14.30 11.20 3.57 14.22 9.00

96-well U bottom,
polypropylene

3365 8 12 source 360 14.30 11.20 2.92 14.22 9.00

384-well
Black/Clear

3712 16 24 read 112 12.12 8.99 2.79 14.22 4.50

384-Well
Black/Clear,
PDL-coated

3664 16 24 read 112 12.12 8.99 2.79 14.22 4.50

384-well
White/Clear

3707 16 24 read 112 12.12 8.99 2.79 14.22 4.50

384-well flat
bottom polystyrene

3702 16 24 source 112 12.12 8.99 2.79 14.22 4.50

384-well U bottom,
polypropylene

3657 16 24 source 95 12.12 8.99 2.65 14.20 4.50

Table C-2: Corning/Costar Plate Dimensions
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Plate Type Part
#

Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

384-well block,
polypropylene

3965 16 24 source 180 12.12 8.99 2.69 27.80 4.50

Table C-2: Corning/Costar Plate Dimensions (continued)

Greiner

Plate Type Part # Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

96-well
Black/µClear

655090 8 12 read 392 14.38 11.24 3.50 14.40 9.00

96-well
White/µClear

655098 8 12 read 392 14.38 11.24 3.50 14.40 9.00

96-well U
bottom,
polypropylene

650201 8 12 source 310 14.38 11.24 3.70 14.60 9.00

96-well V
bottom,
polypropylene

651201 8 12 source 340 14.38 11.24 3.70 14.60 9.00

96-well 2mL
Deep Well,
polypropylene

780270 8 12 source 2420 14.38 11.24 3.00 44.00 9.00

384-well
Black/µClear

781091 16 24 read 138 12.13 8.99 2.90 14.40 4.50

384-well
White/µClear

781098 16 24 read 138 12.13 8.99 2.90 14.40 4.50

384-well flat
bottom
polypropylene

781201 16 24 source 152 12.13 8.99 2.90 14.40 4.50

384-well V
bottom,
polypropylene

781280 16 24 source 145 12.13 8.99 2.90 14.40 4.50

384-well
Deep Well,
polypropylene

781270 16 24 source 240 12.13 8.99 2.70 22.00 4.50

Table C-3: Greiner Plate Dimensions
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Plate Type Part # Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

1536-well
Black/µClear,
Low Base

783092 32 48 read 13 11.01 7.87 1.80 10.40 2.25

1536-well
Deep Well,
polypropylene

782270 32 48 source 18 11.01 7.87 2.50 10.10 2.25

Table C-3: Greiner Plate Dimensions (continued)

Matrical

Plate Type Part # Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

384-well
Black/.17mm-thick
glass

MGB101-
1-2

16 24 read 120 12.13 8.99 2.85 14.40 4.50

384-well
Black/Clear
polystyrene

MGB101-
1-3

16 24 read 120 12.13 8.99 2.85 14.40 4.50

384-well Deep
well polypropylene

MP102 16 24 source 225 12.13 8.99 4.90 27.40 4.40

Table C-4: Matrical Plate Dimensions

Nalge/Nunc

Plate Type Part # Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

96-well
Black/Clear

165305 8 12 read 400 14.48 11.20 2.30 14.80 9.00

96-well
White/Clear

165306 8 12 read 400 14.48 11.20 2.30 14.80 9.00

96-well U
bottom

267245 8 12 source 500 14.30 11.30 2.20 14.30 9.00

96-well V
bottom

249944 8 12 source 450 14.48 11.20 3.40 14.40 9.00

Table C-5: Nalge/Nunc Plate Dimensions
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Plate Type Part # Rows Columns Type Well
Volume
(μL)

A1 Column
Offset "Y" 
(mm)

A1 Row
Offset "X" 
(mm)

Bottom
(MM)

Top
(MM)

Well
Offset
(mm)

96-well 2mL
Deep Well,
polypropylene

278752 8 12 source 2000 14.30 11.30 2.50 44.00 9.00

384-well
Black/Clear

142761 16 24 read 120 12.10 9.00 2.70 14.40 4.50

384-well
White/Clear

142762 16 24 read 120 12.10 9.00 2.70 14.40 4.50

384-well flat
bottom
polystyrene

265196 16 24 source 120 12.10 9.00 2.70 14.40 4.50

384-well U
bottom

264573 16 24 source 120 12.10 9.00 2.70 14.40 4.50

Table C-5: Nalge/Nunc Plate Dimensions (continued)
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Appendix D: FLIPR Penta Instrument LED and Filter
Combinations

The following are recommended LED and emission filter combinations for listed target
assays.

Target Assay LED (nm) LED Part # Emission
Filter (nm)

Penta Filter
Part #

Penta Kit
Part #

Fura-2 335-345 and
380-390 (UV)

0200-6272
0200-6273

475-535 0200-6211 0200-6271

MQAE 360-380 (UV) 0200-6178 400-460 0200-6213 NA

Voltage Sensor Probe (VSP) 390-420 (UV) 0200-6135 440-480 0200-6205 0200-6208

Tango™ GPCR Assay System (FRET) 390-420 (UV) 0200-6135 440-480
515-575

0200-6205 NA

CFP, eCFP/YFP 420-455 0200-6148 475-535 0200-6211 NA

FLIPR Calcium Assay Kits 470-495
(Blue)

0200-6128 515-575 0200-6203 0200-6206

Calcium, Fluo-4 470-495
(Blue)

0200-6128 515-575 0200-6203 0200-6206

Calcium, Fluo-3 495-505 0200-6175 526-586 0200-6212 NA

JC-1 495-505 0200-6175 565-625 0200-6212 NA

FLIPR Membrane Potential Assay Kits 510-545
(Green)

0200-6127 565-625 0200-6204 0200-6207

Rhod-2 & Rhod-4 510-545 0200-6127 565-625 0200-6204 NA

Alexa 633 & Bodipy 610-626 0200-6150 646-706 0200-6214 NA

BRET 2 luminescence assay with ICCD
Camera

NA NA 440-480
526-586

0200-6205
0200-6212

NA

Single Custom Filter Holder
Three Custom Filter Holders

NA
NA

NA
NA

NA
NA

0200-6276
0200-6221

Table D-1: FLIPR Penta Instrument LED and Filter Combinations

D
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Appendix E: Data Processing Algorithms

This appendix uses results of a hypothetical experiment to describe the algorithms that can
be used to adjust data. These options are all applied from the Correction dialog.

Hypothetical Experiment
Consider the results from an experiment consisting of wells A1–A9. The wells are classified
into three groups:

A1–A3: Negative ControlWells (–Ctrl). These wells contain the same dye-loaded cells and
buffers as the other wells, yet are not exposed to a stimulus.
A4–A6: ExperimentalWells (Exp). These cells receive the experimental stimulus.
A7–A9: Positive ControlWells. (+Ctrl). These cells either (1) receive a stimulus known to
elicit a predetermined response or (2) demonstrate themaximal activity from an agonist.

In the following experiment, six samples, also known as pictures, readings, or frames, were
taken at five second intervals. After Sample 3was taken, buffer, with or without stimulus,
was added to the wells.

Note: The longer time between readings 3 and 4. This time includes the time
necessary for the 96-well pipettor to transfer liquids from the source plate to the cell
plate and is automatically corrected for by the FLIPR Penta System.

The data presented is in the same format as the export data files generated using the
FLIPR Penta System software. In this example, only nine wells are considered.
In Table E-1, the results of the experiment are presented without Spatial Uniformity
Correction, Negative Control Correction, Positive Control Scaling, or Subtract Bias Value.

Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

3 –
Ctrl

A4 Exp A5 Exp A6 Exp A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0 8000 8500 9500 8200 9200 8800 1000 9500 8700

2 5 8200 8600 9400 8300 9000 9000 9500 9700 9000

3 10 8400 8500 9200 8500 9000 9100 9700 9700 9400

4 20 8600 8400 9200 45000 50000 42000 57000 52000 54000

5 25 8600 8800 9200 37000 42000 35000 53000 50000 50000

6 30 8800 8500 9500 30000 25000 29000 50000 51000 50000

Table E-1: Hypothetical Experiment

E
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An inspection of the fluorescence counts taken at Sample 1 (time = 0) shows some inter-well
variability (range 8000–10000). Variability can be the result of differences in cell density or well
positions (so-called ‘edge effects’ where cells on the outside of the plate are less dense than
their internal neighbors), dye loading, non-uniform illumination, buffer variations or any
other effect which is constant throughout the experimental run. These variations can
complicate data interpretation.

Determining Crosstalk Correction
The crosstalk correction algorithm compensates for light from onewell affecting the read out
from a neighboring well.
If themiddle well in the drawing belowwas empty and the eight wells surrounding it would
have signal, themiddle well would show up as having a certain value based on the amount of
light crossing over from each of it’s neighbors. The percentage of crosstalk from wells directly
next to (B) the well of interest is assumed to be different from the percentage of the
crosstalk from the wells diagonal (A) from the well of interest, therefore these two values are
entered for the crosstalk correction. In this calculation, only the immediate neighboring wells
are assumed to impact themiddle well.
When the crosstalk correction is applied, the Horizontal/Vertical factor and the Diagonal
Factor are applied in a matrix, which automatically subtracts the percentage of each of the
neighboring well’s value from themiddle well’s value. If the crosstalk correction option is
selected it is the first correction applied to the data. Crosstalk correction is done in real time
and no resulting data is stored. it is recommended to test this correction during assay
optimization.
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Determining Spatial Uniformity Correction
The spatial uniformity correction algorithm compensates, to a certain extent, for of the
above-mentioned variations using a correction factor applied to all plate wells and samples.
The correction factor is derived by calculating themean fluorescence counts of all wells at
Sample 1, for example:

Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

A3 –
Ctrl

A4
Exp

A5
Exp

A6
Exp

A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0 8000 8500 9500 8200 9200 8800 10000 9500 8700

Mean (A1-A9) 8933

Spatial Uniformity Correction Factor Calculation (Mean/Well)

Well- Specific
Correction Factor

A1 A2 A3 A4 A5 A6 A7 A8 A9

1.12 1.05 0.94 1.09 0.95 1.02 0.89 0.94 1.03

Table E-2: Correction Factor

Note: In actual practice, data from all 96wells are included in the calculations, but in
this example, data from only nine wells are presented, to simplify the example.

Each well-specific spatial uniformity correction factor is calculated by dividing themean
fluorescence counts of all wells by the fluorescence counts of each well (taken at Sample 1.)
The table above also presents the correction factor for wells A1–A9.
All samples taken from a particular well aremultiplied by their well-specific correction factor.
For example, all samples from A1 aremultiplied by 1.12, A2 by 1.05, and so on.
The results of applying the spatial uniformity correction factor are presented in the table
below. Note the decreased variability range of wells A1–A9 in Sample 1 (8900–8976) as
compared to the same data prior to applying the correction algorithm (8000–10000).

Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

3 –
Ctrl

A4 Exp A5 Exp A6 Exp A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0 8960 8925 8930 8938 8924 8976 8900 8930 8961

2 5 9194 9030 8836 9047 8730 9180 8455 9118 9270

3 10 9408 8925 8648 9265 8730 9282 8633 9118 9682

4 20 9632 8820 8648 49050 48500 42840 50730 48880 55620

5 25 9632 9240 8648 40330 40740 35700 47170 47000 51500

Table E-3: Spatial Uniformity Correction factor
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Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

3 –
Ctrl

A4 Exp A5 Exp A6 Exp A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

6 30 9856 8925 8930 32700 33950 29580 44500 47940 51500

Table E-3: Spatial Uniformity Correction factor (continued)

If the spatial uniformity correction factor is applied to plates with empty wells, non
dye-loaded cells, or a panel of cells containing different dyes and/or dye concentrations, the
well-specific fluorescence counts are skewed by the correction factor. However, the EC50 of
the agonists tested are not affected.

Determining Negative Control Correction
The negative control correction algorithm corrects for changes in fluorescence that occur in
all wells over the course of the experiment. Causes for these changes in fluctuations in
fluorescence include dye leakage from cells, fluid addition artifacts, changes in illumination
power, dye photo-bleaching, and temperature drifts.
The negative control correction factor is derived by first calculating themean fluorescence of
each of the samples of the negative control wells.

Sample Time Well

A1 – Ctrl A2 – Ctrl 3 – Ctrl Mean Correction Factor

1 0 8960 8925 8930 8938 1.00

2 5 9194 9030 8836 9017 0.99

3 10 9408 8925 8648 8994 0.99

4 20 9632 8820 8648 9033 0.99

5 25 9632 9240 8648 9173 0.97

6 30 9856 8925 8930 9237 0.997

Themean of Sample 1 is divided by themean of each of the samples to give the sample-
specific correction factor. Each sample is multiplied by its sample-specific correction factor.

Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

3 –
Ctrl

A4 Exp A5 Exp A6 Exp A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0 8960 8925 8930 8938 8924 8976 8900 8930 8961

2 5 9194 8940 8748 8957 8643 9088 8370 9027 9177

3 10 9314 8836 8562 9172 8643 9189 8547 9027 9585

4 20 9536 8732 8562 48560 48015 42412 50223 48391 55064

5 25 9343 8963 8389 39120 39518 34629 45755 45590 49955

6 30 9560 8657 8662 31719 32932 28693 43165 46502 49955
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For example, A1 Sample 1 is multiplied by 1.00.

Note: The negative control correction factor wells contain the same cells and dyes as
the experimental and positive control wells.

Determining Positive Control Scaling
The positive control algorithm compares the percent change in fluorescence counts of the
positive control wells with all wells. This algorithm facilitates comparisons of results between
data runs, such as different plates, by controlling factors such as cell density, cell response,
laser power, or exposure time. This algorithm also makes EC50 comparisons easier.
Calculate themeans of all samples of the positive control wells.

Sample Time Well Mean Difference from Sample 1S

A7 + Ctrl A8 + Ctrl A9 + Ctrl

1 0 8900 8930 8961 8930 0

2 5 8370 9027 9177 8858 -72

3 10 8547 9027 9053 9053 123

4 20 50223 48391 55064 51226 42296

5 25 45755 45590 49955 47100 38170

6 30 43165 46502 49955 46541 37610

The difference in fluorescence counts between Sample 1 and all of the samples is calculated.
The greatest difference is determined. 100 is divided by the greatest difference in
fluorescence counts to give the positive control correction factor, for example, 100/42296 =
0.0024. All samples aremultiplied by the correction factor 0.0024.

Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

A3 –
Ctrl

A4
Exp

A5
Exp

A6
Exp

A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0 21 21 21 21 21 21 21 21 21

2 5 21 21 21 21 20 21 20 21 23

3 10 22 21 20 22 20 22 20 21 23

4 20 23 21 20 115 113 100 119 114 130

5 25 22 21 20 92 93 82 108 108 118

6 30 23 20 20 75 78 68 1021 110 118

Note: All wells, at samples 1–3, range from 20 to 23%. The positive control wells at
Sample 4 range from 114 to 130%while the negative control wells remain at around
20% throughout the experiment.
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Determining Subtract Bias
The subtract bias algorithm determines the change in fluorescence over background
fluorescence. The user determines the sample number chosen as background. This
algorithm, by default, is always switched on and subtracts from Sample 1. The choice in the
sample number to use as background depends on the assay conditions. For example, the
addition of agonist can dilute the fluorescence signal in the supernatant, which would appear
as a drop in fluorescence. In this case, the best choice for background is the sample taken at
the bottom of this drop in fluorescence.
In our example, the percent positive fluorescence at Sample 1 is around 20% for all wells.
Subtracting the background at Sample 1would make the data easier to interpret.
Sample 1 (or any sample chosen by the operator) from each well is subtracted from the
samples from the samewell.

Sample Time A1 –
Ctrl

A2 –
Ctrl

A3 –
Ctrl

A4
Exp

A5
Exp

A6
Exp

A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0

2 5 1

3 10 1 1 1

4 20 1 94 92 79 98 93 109

5 25 1 71 72 61 87 87 97

6 30 1 54 57 47 81 89 97

The results show only numbers above zero. The subtract bias algorithm places the data in a
readily interpretable form. The positive control wells at Sample 4 range from 93–109%
positive. In contrast, the negative control wells remain close to zero percent positive
throughout the experiment. The experimental wells show two wells with about 90% activity
and one with 79% activity at Sample 4.
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Determining Response Over Baseline
The response over baseline correction algorithm compensates, to a certain extent, for
variations within a single well.
The correction factor is derived by calculating themean fluorescence counts in each well
between the baseline start and end samples.

Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

A3 –
Ctrl

A4
Exp

A5
Exp

A6
Exp

A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0 8000 8500 9500 8200 9200 8800 10000 9500 8700

2 5 8200 8600 9400 8300 9000 9000 9500 9700 9000

3 10 8400 8500 9200 8500 9000 9100 9700 9700 9400

Mean 8200 8533 9367 8333 9067 8967 9733 9633 9033

Note: In actual practice, data from all 96-wells are included in the calculations, but in
this example, data from only nine wells are presented, to simplify the examples.

All samples taken from a particular well are divided by their well-specific mean baseline
correction factor. For example, all samples from A1 are divided by 8200, A2 by 8533, and so
on.
The results of applying the response over baseline correction factor are presented in the
table below. Note the data is displayed is displayed as a fold increase of the response
compared to the baseline with Sample values ranging in the single digits (0–6).

Sample Time Well

A1 –
Ctrl

A2 –
Ctrl

A3 –
Ctrl

A4
Exp

A5
Exp

A6
Exp

A7 +
Ctrl

A8 +
Ctrl

A9 +
Ctrl

1 0 0.98 1.00 1.01 0.98 1.01 0.98 1.03 0.99 0.96

2 5 1.00 1.01 1.00 1.00 0.99 1.00 0.98 1.01 1.00

3 10 1.02 1.00 0.98 1.02 0.99 1.00 0.98 1.01 1.00

4 20 1.05 0.98 0.98 5.4 5.51 4.68 5.86 5.40 5.98

5 25 1.05 1.03 0.98 4.44 4.63 3.90 5.45 5.195 5.54

6 30 1.07 1.00 1.01 3.60 2.76 3.23 5.14 5.29 5.54
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Appendix F: Using AquaMax Sterilant

AquaMax Sterilant can be used to clean and sterilize the fluid paths in the Cell Reservoir and
Cell Suspension module.

Principle of Use
Accumulated residues and contaminating microorganisms have the potential for causing
significant adverse effects on the operation of liquid handling equipment. Proteins in cell
culturemedia, salts and minerals in buffers and other reagent components used in liquid
handling equipment can build up on fluid path surfaces, clogging channels and probes
resulting in incomplete or inaccurate dispensing and aspiration of liquids. In addition,
microorganisms such as bacteria, fungi and molds can also accumulate in the fluid path
creating similar fouling problems. Simply flushing the fluid path with water or ethanol/water
solutions is often ineffective in the removal of residue.
AquaMax Sterilant was developed for the purpose of removing organic and inorganic
material, and killing microorganisms, including endospores, in liquid handling instrument
fluid paths. In addition, AquaMax simultaneously removes endotoxin from the fluid paths.
Endotoxin is a substance produced by Gram negative bacteria that is known to cause a
variety of significant cellular reactions in vitro, including cell activation and death. Thus
minimizing the amount of endotoxin in fluid paths is necessary in order to avoid detachment
and adverse effects on mammalian cells during the course of subsequent experiments. A
two-hour treatment with AquaMax substantially removes endotoxin adhering to interior
fluid path surfaces.

Contents
4X Concentrated Solution A: detergent in buffered aqueous solution (2 x 1 L bottles)
Solution B: sodium hypochlorite in aqueous solution (2 x 14mL bottles) [16 500mL DW4
washes]

Materials Required but Not Provided
Deionized water
250mL graduated cylinder
1 L beaker, bottle or flask
2mL pipettor

F
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Storage
The unopened kit package can be stored at room temperature (between 10°C/50°F and
40°C/104°F).
After opening the kit, store 4X Concentrated Solution A and 1X Solution A (prepared by
mixing 1 volume of 4X Concentrate Solution Awith 3 volumes of deionized water) between
10°C/50°F and 40°C/104°F.
After opening the kit, store the tightly capped bottle of Solution B between 2°C/35.6°F and 8
°C/46.4°F. Avoid freezing any of the solutions.

Reagent Preparation
500mL Sterilant is sufficient to run the automated cleaning cycle on the AquaMax DW4 liquid
handling system.
1X Solution A can be stored for 30 days in a capped bottle between 10°C/50°F and
40°C/104°F.

Preparation of 500 mL 1X Solution A

Combine 125mL of 4X Concentrate Solution A and 375mL deionized water in a 1 L
beaker, bottle or flask and mix thoroughly.

For other needed volumes:
Add 1 part of 4X Concentrate Solution A and 3 parts deionized water.

Preparation of Complete Sterilant:

Within 1 hour of use, add 0.2% (final v/v) Solution B to 1X Solution A and mix thoroughly.
For 500mL of complete Sterilant:

Use 1mL of Solution B.

Reagent Use
Follow the recommended cleaning procedures in the user guide for the specific liquid
handling instrument to be cleaned.
For stubborn cleaning situations, the Sterilant must sit static in the fluid path for 30minutes
half-way through the cleaning cycle before continuing to completion.
For endotoxin removal, the Sterilant must sit static in the fluid path for 2 hours half-way
through the cleaning cycle before continuing to completion.
Rinse the fluid path with at least twice the volume of deionized water immediately after
cleaning.

Warnings, Precautions and Limitations
For research use only.
When handling these reagents, gloves and eye protection must be worn.
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Do not ingest.
Use in a well ventilated environment.
For more safety information, see theMaterial Safety Data Sheet for Solutions A and B.
As supplied, Solution Amight not be sterile.

The following information is being provided in compliance with Worker and Community
Right-To-KnowRegulations:

Solution A, 4X Concentrate
Chemical Composition
The chemical composition of this solution is a trade secret and proprietary property of
Molecular Devices.

Solution B
Chemical Composition, CAS #
Sodium Hypochlorite, Solution, 7681-52-9
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Appendix G: Robotic Integration

This document describes the interface between a FLIPR Penta System and a robotic
instrument. The intention of the document is to provide a general overview of the interface
between the instrument and robot and a detailed description of the communication
protocol between the ScreenWorks Software, which run on the host computer of the
FLIPR Penta System instrument, and the robotic control software.
Information contained in this document might change as new development occurs—we
recommend checking with your Molecular Devices sales representative for updated
information.

Conventions
Bold text is used for commands
Italic text is used for parameters
Parameters in bracket [parameter1] are optional
Parameters are separated by comma
<CR> is the ACSII code for ‘carriage return’ which indicates end of the command or end
of the response
<TAB> represents a tab
<SP> represents a space
| represents OR

Interface Versioning
As of version 1.1 of the automation interface, the interface is versioned separately from the
ScreenWorks Software and FLIPR Penta System firmware. The interface now provides a
command so it can be queried for its version number. This command is described in detail
later in this document.

G
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Instrument Overview

Basic Function

FLIPR Penta System is a fluorescencemicroplate reader used primarily for kinetic live
cell-based fluorescence and luminescence assays. A typical assay involves the following
steps:

Introduction of a read plate containing cells in solution or compounds into the
instrument.
Acquisition of a baseline read (or series of reads) to determine the background
fluorescence or luminescence signal from the read plate.
Introduction of a potentially activating (or potentially inactivating) compound into the
well or cells in suspension.
Monitoring the changes in the fluorescence or luminescence signal from the read plate
for a period of time immediately following the introduction of the compound.
Further additions of different compounds to the well are typical in an assay on a
FLIPR Penta System. Between additions, the pipette tips used for fluid transfer may be
replaced or washed.

Cell response in a typical assay typically begins within 2 seconds of fluid addition and is
monitored for 1–3minutes. Fluorescence or luminescence signals aremonitored at
wavelengths and frequencies selected by the user within the physical constraints of the
instrument.

Hardware Introduction

To accomplish the assays described, the instrument includes the following subsystems:
Embedded control system—The instrument contains an embedded control system for
use in controlling the instrument. This control system is accessed only by the
ScreenWorks Software, which is supplied with the instrument.
Plate reader— The optics subsystem includes an illumination source with excitation
filters, emissions filters in a three-position filter changer, and a CCD camera. This system
is used to read both fluorescence and luminescence assays.
Pipettor — In order to accomplish kinetic assays, the instrument contains a pipettor
which can add fluids to the read plate during a series of reads. The pipettor, equipped
with a 96-well, 384-well, or 1536-well head, can be used for general purpose fluid transfer
between any of the plates in the instrument. Each head type uses pipette tips, or a pin
tools. For 96- and 384-well pipettor heads, this is a disposable plastic pipette tip. For
1536-well this is a metal tip block. Alternatively, 384-well and 1536-well pin tool heads
have replaceable pin tools.
Tip and pin washer— Each instrument includes a washer which can be used to wash tips
or pins between fluid transfers. The washer consists of two parts—a washer control
module and a wash reservoir. Installed on the right side of the instrument, the sensors,
and control valves. These components connect to the wash reservoir located in position
5 of the system stage.
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FLIPR Cycler Plate Handler — An optional plate handler is available that is capable of
moving plates from a location outside of the instrument to any of the first four stage
positions and vice versa. The second component of the FLIPR Cycler Plate Handler is an
automated door system that allows plates to be exchanged while an assay is in progress.

Layout

The basic layout of the instrument subsystems is demonstrated in the following illustration:

As the illustration indicates, the top instrument compartment contains the pipettor and
plate platform (stage). Plates are placed in the read position of the 5-position platform in
order to be read by the plate reader, which is located in the optics compartment below the
platform.
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Plate Layout

The stage has 4 positions where plates and/or tips may be placed. Thesemay be:
Position 1: Source Plate 1 or Tip-loading
Position 2: Source Plate 2
Position 3: Read Plate
Position 4: Source Plate 3 or Cell Reservoir

A tip wash reservoir for tips or pins is available in position 5.

Users may place either tip racks or plates in the tip-loading position (position 1) and Cell
Reservoir or plates in Cell Reservoir position (position 4). The wash reservoir is not disposable
but is replaced by users when the head type is changed.

Plate-Handling System

Users may manually place plates or tip racks in the instrument or deliver them automatically
using a robot or stacker.
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In manual mode, users access the plate stage through a large, manually operated door. This
door opens on a vertical hinge, mounted to the left side of the door. An observation panel is
built into this door and may be removed by users to attach to the top instrument
compartment. In this arrangement, users can observe assays in progress (data quality can
be poor or simulated) in order to debug assay setup issues.
At the start of an assay, the door latches to prevent users from accidentally interrupting an
assay in progress or injuring themselves. The door also latches for most other instrument
actions not associated with an assay, for example, load tips, unload tips, and signal test. This
latch remains engaged throughout the assay or operation. In manual mode, this latch
automatically disengages at the end of the assay.
For robotic integration, plates are delivered to a single location outside of the instrument.
The placement area for robotic delivery of plates to the instrument is to the left of the
instrument. The locations for manual and robotic access to the instrument are shown below:

A further illustration of this arrangement shows the relation of the plate handler to the
pipettor system.

Terminology

Themanual access door side of the instrument is called the front of the instrument. From
this, the following illustrates the named sides of the instrument:

Robotic Plate Loading

Plates are shuttled into the instrument by a plate handling subsystem called the FLIPR Cycler
Plate Handler. To lessen dead time between assays and to handlemore source plates in an
assay than can be accommodated on the plate stage, the robotic access door(s) and FLIPR
Cycler plate handler are able to exchange plates and tips while an assay is running.
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The following diagram illustrates the steps involved in loading plates in robotic mode:

A reverse process is used when unloading plates in remotemode.

Optics Access Door

The plate reader optics aremounted to the plate stage directly below the read plate position.
A door is provided to the optics compartment for users to change emission filters and LED
modules. This door is also latched when an assay is in progress to prevent users from
interrupting assays or injuring themselves.

Washer Placement

A tip/pin washer is included with the system and is placed on the lower right side of the
instrument, towards the front. Extensive work has been done to isolate plumbing for the
washer from other optical or power components. Access for tubing to the washer is required
in any installation.
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Cell Suspension Placement

The Cell Suspension module option is available for the FLIPR Penta System. When installed,
the Cell Suspension module is mounted on the lower right side of the instrument and the
Cell Reservoir is inside of the instrument. Access to themodule is necessary during testing.

Other Instrument Access Areas

The following diagram illustrates other important access areas in the instrument.

On the right rear of the instrument, AC power enters. Directly above this entry is themain
power switch. The power switch should be accessible in both robotic and manual modes.
There are three indicator lamps near the power switch. Access to view these indicators can
be useful for debugging instrument power problems. Themain communication connection
from the instrument to the host computer is located immediately above these power
indicators.
The instrument status panel, located next to the upper door handle, indicates whether or
not the instrument is running and safe to open. It includes an emergency Interrupt button
to stop any processes.
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The panel has two lights as well as the Interrupt button. From the top of the panel these are:
Assay Running (Locked)—Yellow light
The FLIPR Penta System is performing a task. The upper and lower doors are locked and
cannot be opened until the task finishes or is halted using the Interrupt button.
Assay Finished (Unlocked)—Green light
No tasks are being run and it is safe to open the upper and lower instrument doors.

The Interrupt button is an override button to halt all tasks, so you can access the
instrument. If pressed the yellow light flashes until the system has reached a safe state to
open the doors, then the green light comes on.

CAUTION! The Interrupt button immediately ends the experiment and should only be
used in emergencies. Interrupting the instrument while an assay in progress almost
always results in the loss of the plate being run. If this button is pressed, the yellow
‘busy’ light flashes until the instrument is safely unlatched. The system may need to
be reinitialized by selecting Reset from the Instrument menu prior to resuming normal
instrument function.
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Monitor and Keyboard Placement

The host computer provided with FLIPR Penta System is mounted to the instrument’s right
side. This computer provides the only direct user interface and path to control the
instrument. Monitor and keyboard for this computer aremounted to an adjustable arm on
the instrument’s front right. The following image illustrates this installation.

The host computer, keyboard, and monitor may bemoved to a different location at the
user’s discretion. Wherever the host computer is placed, it must be directly connected to the
instrument. It is not possible to communicate between the host computer running the
ScreenWorks Software and the instrument across a network. A short communication cable is
provided between the computer and instrument. In order to move the computer, the user
may need to provide an alternate cable. This cable must be a shielded crossover Category 5
cable.

Required Access Areas

The all inclusive system dimensions with the FLIPR Cycler Plate Handler and Cell Suspension
modules are approximately 53 inches (1346mm)wide by 29 inches (737mm) deep by 70
inches (1787mm) tall. The FLIPR Penta System is designed with rolling castors so it can be
readily moved to make necessary adjustments and perform maintenance. Leveling feet are
also installed on the lower instrument chassis. These feet are typically used for stabilizing the
instrument when integrated with a robot, but can also be used to establish a uniform
instrument deck level in situations where the lab floor is not flat. When running an
experiment, pleasemake sure the instrument’s feet are lowered and leveled.
The computer and monitor aremounted to the right front side of the instrument with the
included clamp, requiring a minimum lab space of 85 inches (2159mm)wide by 61 inches
(1549mm) deep for maneuverability. Aminimum 28 inch (711mm) square footprint for tip
wash bottles and chiller is required to the right side of the instrument. This space is also
recommended to allow access to themain power-switch, washer tubing and communication
connections.
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The cabinet should have a user access space of 48 inches (1219mm) in front for users to
exchange tips, plates and reservoirs. An additional 24 inches (610mm) behind and 10 inches
(254mm) to the left should be left available for servicing the instrument.

WARNING! The FLIPR Penta System can weigh as much as 860 lbs (390 kg).
Ensure adequate personnel are present when installing or moving the system.
Follow all necessary safety precautions and use proper moving techniques.

The following drawings illustrate these requirements:
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FLIPR Penta System Control Architecture

General Description

The FLIPR Penta System consists of a host computer and a stand-alone instrument.
ScreenWorks Software is installed on the host computer supplied with the instrument. This
software is the primary user interface. ScreenWorks Software is used to setup protocols, run
assays, analyze and export data. ScreenWorks Software communicates to the standalone
instrument with a dedicated connection using a communication protocol proprietary to
Molecular Devices. The status of the instrument and assay is monitored by ScreenWorks
Software, which then displays data as it is collected.
A stand-alone instrument has all the hardware and firmware components required to
perform an assay and report the results. It does not have the ability to display the results of
experiments directly to a user. The user may not directly communicate with the stand-alone
instrument in order to obtain data or to configure and run assays.
The host computer supplied with the FLIPR Penta System is configured with two Network
Interface Cards (NICs). The first NIC is used to communicate with the instrument using a fixed
IP address - this connection cannot be used for any other purpose. The second NIC is
provided to connect the host to the Local Area Network (LAN) or to other devices (for
example, router, hub, scheduling workstation).
ScreenWorks Software and the instrument have two operating modes. The first of these is
Manual mode. The second mode is Remotemode. ScreenWorks Softwaremust be placed in
Remote Mode in order to be controlled externally by third-party software via the
automation interface.

Manual Mode

By default, the instrument starts in Manual mode.
In Manual mode, configure assays in ScreenWorks Software and manually load plates and
tips into the instrument. The following simple diagram illustrates this interaction:



FLIPR Penta High Throughput Cellular Screening System User Guide

272 5069582 B

In Manual mode, a second network connection on the host computer is not monitored. It is
provided primarily to connect to your network to transfer data from the FLIPR Penta System
host computer for storage or analysis elsewhere.

Remote Mode

By transitioning into RemoteMode, ScreenWorks Software can be configured to
communicate with external devices such as robots and stackers supplied by third parties.
These devices can be used to supply plates and tips to the FLIPR Penta instrument.
When in remotemode, third-party software is given full control over the internal plate
handler, FLIPR Cycler plate handler. The FLIPR Penta System software does not initiate any
plate handling events. The general philosophy here is to put the third party software in
charge and provide status information to allow it to make decisions on when the
FLIPR Penta System should load or unload plates and start assays. Third-party software
monitors the assay through the ScreenWorks Software automation interface and provides
additional plates and tips to the instrument as needed. External devices might not
communicate directly with the FLIPR Penta System instrument but only with the automation
interface.
Interact with the third-party software to select a protocol or preload a protocol in
ScreenWorks Software before entering remotemode. The automation interface does not
provide the functionality to create assay protocols. Interact with ScreenWorks Software
while assays are running remotely to QA data and monitor progress.
The control system to communicate between ScreenWorks Software and robotic controller
can be configured in several ways. The following illustrations are provided to illustrate the
range of options available. These examples are not exhaustive.
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Third-Party Software via Network

Third-Party Software on the FLIPR Penta System Host Computer
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Direct Connection From a Third-Party Software Host to the FLIPR Penta System
host

Communication Protocol and Address

Communication between third-party software and ScreenWorks Software uses the TCP/IP
protocol. The third-party software can be resident on another computer outside of the
FLIPR Penta System or on the instrument host computer.
If the third-party software is remote to the host computer, the ScreenWorks Software
receives communication through the IP address of the host computer on which it is running.
If the third-party software is run on the instrument host computer, the ScreenWorks
Software receives communication through IP address 127.0.0.1 (localhost).
In all cases, ScreenWorks Software sends and receives commands through TCP/IP port 7.

General Remote Mode Use

This section provides a brief overview of running a FLIPR Penta System in remotemode.
Later sections describe some detailed issues in more detail. This section provides some
context for the introduction of the interface command set in the following section.
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Instrument Startup

When the instrument is powered on, it performs a series of initialization steps which can take
several minutes. These steps include:

Configuring the camera
Initializing the pipettor
Initializing the plate handler and automatic door (if included)
Determining and checking the installed LEDs
Determining the installed emission filters
Initializing the tip washer
Communicating with the chiller

By default, the instrument is in manual mode upon startup. In this mode, themain manual
access door is unlocked, the outer automated door is closed, and the FLIPR Cycler plate
handler is moved outside the instrument, above the automation landing pad. As long as the
instrument is in manual mode, the outer automated door and plate handler do not move
from these positions, except during an instrument reset.

Software Startup

To use the instrument, the host computer must be started and ScreenWorks Softwaremust
be run. ScreenWorks Software establishes communication with the instrument and
determine the instrument status and configuration. The instrument status and configuration
can be determined by looking at the Instrument Status toolbar. This toolbar has two tabs.
The Instrument Status tab shows the current instrument status including the status of
assays in progress. The Instrument Config tab shows which LED modules, emission filters,
and heads are installed.

Protocol Creation

The user must create assay protocols in manual mode. They do not need to load these
protocols prior to placing the instrument into remotemode, but any protocol that is used in
remotemodemust be created and saved with a valid protocol file name prior to entering
remotemode.
Users should test all protocols in manual mode prior to attempting to run them in remote
mode.

Instrument Setup

Prior to placing the instrument into remotemode, the user may want to load tips or plates
into the instrument. These actions can be done in remotemode but in certain conditions it is
advisable to do this through themain manual door prior to entering remotemode.
If tips are used for an extended period of time and the tips/source 1 position is used as a
source position, it is best to load the tips manually before placing the instrument into
remotemode.
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If boats or reservoirs are used as source plates, these should be loaded by hand in manual
mode. The FLIPR Cycler plate handler must not be used to load reservoirs because the plate
handler moves rapidly and large wells spill liquid within the instrument.

Instrument Mode Setting

Prior to running an assay in remotemode, users must place the instrument into remote
mode by selecting Instrument > Set Remote Mode from themain menu.
After the user requests transition to remotemode, the instrument locks themain manual
doors, moves the plate handler inside of the instrument, closes the inner automated door,
and opens the outer automated door. This is the default position for remotemode. At the
end of any plate handling operation, the instrument returns to this position. The outer
manual doors remain locked as long as the instrument is in remotemode.
The instrument assumes that any plates in the instrument when it transitions to remote
mode are acceptable for use until a protocol has been run, which indicates that the plate is
no longer needed.

Loading Protocols

In remotemode, protocols are loaded using the openprotocol command. This command
loads the requested protocol and closes any other files open at the time that the command
is sent. Protocols open regardless of whether they are valid. This command is described in
more detail later in this document.

Running Protocols

After the instrument has been placed in remotemode and a protocol is opened, the protocol
may be run by sending the runprotocol command. When a protocol begins to run in remote
mode, any data files currently open close. This command is described in more detail later in
this document.

Instrument Status Updates

The instrument can be queried at any time for instrument status, even when in manual
mode. The status command is described in detail later in this document.

Plate Status Tracking

Themost important information in the status command is the status of the plates in the
instrument. From the status response, four possible information items may be determined
about the plates in each of the four plate positions.
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The first item that can be determined is the plate assigned to the plate position for the
protocol to be run. This is the plate name assigned in ScreenWorks Software for a particular
plate type and assigned to that position for the current protocol. This information could be
used by the robot to confirm that the correct plate type is delivered to the required position.
ScreenWorks Software and the FLIPR Penta System instrument have no method to
determine whether the plate delivered is of the required type and always assumes that the
plate type delivered is correct.
The status response also indicates whether a plate is present in each possible location. This
indication is a direct readout of the status of the plate presence sensors in the instrument.
This readout does not depend on whether a plate is required in the position or if the plate
present is the correct plate.
The REMOVEPLATES line in the status signals that the plates in the indicated positions have
completed. Plates complete in different ways. If the plates are source plates, ScreenWorks
Software indicates that they are finished when an aspiration from the plate is completed and
that aspiration is checked to show that the plate is finished after the aspiration. For tip racks,
they aremarked as complete as soon as tips have been loaded or unloaded to/from them.
Read plates aremarked as complete at the end of the last read in the assay in which they are
used.
TheNEEDPLATES line indicates plates that are needed for the assay in progress to continue.
The instrument indicates that it needs a plate if it gets to an operation that requires a plate in
a particular location and that location is either empty or contains a plate that was previously
marked as finished.

Bar Code Tracking

Bar codes can be tracked in an assay in two ways.
First, the bar code can be supplied to the software by the robot controller when the robot
controller instructs the ScreenWorks Software to load a plate. The software records the bar
code values of the plates delivered in the appropriate data file in which they are used.
Second, the instrument attempts to read a bar code for all plates it loads using the plate
handler. If this value is not overridden by one supplied by the robot controller, this bar code
is recorded in the data file when the plate is used.
Regardless of themethod used to deliver bar code information to the instrument, all bar
code information might not be present when an assay is started, since all required plates
might not be present in the instrument. Since the software can be configured to name the
data file based on the bar codes of the plates used, it is possible that the data file name
changes as an assay is completed.
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Setting Up Protocols for Remote Control Use
Protocols must be created in manual mode before entering remotemode.
Protocols should also be tested in manual mode to ensure that they work as expected.
Setting up protocols is described in the user guide and you should be familiar with this
process before reading further in this section. See Setting Up an Assay Protocol on page 149.
This section describes particular items you should be aware of when setting up protocols to
be run in remotemode.

Settings Screen

Read Mode Settings

In the settings screen, configure the read modes. The settings for the read mode are
dependent on the assay dye, plate type, cell type, and condition. These settings are
determined during assay development and no changes are required when switching into
remotemode.

Note: It is not possible to automatically vary these settings based on the particular
cell plate loaded.

Assign Plate Settings

Assign plates to the required positions for the assay in the Assign Plate to Position group
box. The assignment of plates can be critical to the smooth functioning of the assay.
Only one type of plate can be assigned to a position throughout an assay. For example, it is
not possible to assign a normal plate to a position for the first part of an assay and then
assign a deep-well plate to that position for the rest of the assay.
The read plate is always assigned to the read position. There are no special suggestions in
remotemode for this assignment.
The assignment of source plates and tips should be carefully considered. The pipettor and
the plate handler are both used in remote assays and must share the space above the plate
locations. The instrument monitors the locations of the pipettor and the plate handler and
moves them if necessary to prevent collisions. The pipettor and plate handler are never
allowed to be above the same plate position at the same time. Plates should be arranged to
minimize potential interactions between the plate handler and the pipettor.
The following guidelines can be helpful in assigning plate positions for automation:
Open reservoirs with very large wells cannot be handled by the plate handler. These plates
must be placed in the instrument manually prior to entering manual mode. Replacing these
plates requires the user to halt remote control and place the instrument in manual mode to
manually replace or refill the reservoir. Deep well plates are a good alternative to using these
plates.
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If tips are loaded in the experiment, they must be assigned to the Source Plate 1 location.
When tips are assigned to this position, the position cannot be used for source plates.
Unless the tips are going to be changed for every plate, it is a good idea to load the tips prior
to placing the instrument into remotemode. Alternatively, the user could create a tip
configuration protocol which load and wash the tips. This assay can be run and then the
empty tip rack can be removed by the robot to allow the source 1 position to be used for
other plates. As of v1.1 of the automation interface, tip loading and tip washing is available.
Plates that are switched frequently should be placed closer to the left side of the instrument
(near the automated landing pad) than plates which are not switched frequently.
Deep well plates (or reservoirs) which can be used for a series of assays before being replaced
can be placed in the source 3 location, as long as it is not being used for Cell Reservoir. This
minimizes the interaction between the pipettor and the plate handler when switching plates
during themajority of assays.
It is only possible to RESET the instrument if a tip rack is present in the instrument. A RESET is
required if the instrument enters a fault condition. If automated recovery from fault
conditions is desired, the tips/source 1 position should be used for tips only and an empty
tip rack should be left in this position at all times.

Data File Name Settings

Configure the desired data file name in theData File Name group box.
If the Include Bar Code box is selected, the bar codes for all of the plates which have been
checked as requiring them are included in the data file name. Bar codes are separated by an
underscore (_). If a bar code cannot be read, or one has not been provided during the
loadplate command, the software records Bad_bar_code.
The settings for the data file name are ignored in remotemodewhen the data file name is
included with the runexperiment command line. Care should be taken when using this
command to ensure that data file names are always unique to prevent the overwriting of
data files.
If the ScreenWorks Software is allowed to create the data file name, it always ends in _
###.fmd, where ### is the plate number with this base name. Using this option ensures that
no data is lost due to file overwriting.

Folder Settings

This area is used to assign the directories used in saving the data and export files. There is no
difference between settings for these directories in remote control mode and in manual
mode.
Running in remote control can produce large amounts of data. ScreenWorks Software does
not allow new assays to begin if less than 50MB of hard disk space is available. Monitor hard
disk capacity and maintain adequate space to save data.
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Saving data across a network connection is not recommended in any case. If a protocol is
created that saves data across a network connection, you might be unable to run the
protocol if the network connection becomes unavailable. If a protocol that saves across the
network is running when a network connection is interrupted, data can be lost and the
software can encounter problems.

Temperature Control Settings

This area allows the user to set the temperature control set point for the protocol. The
instrument must already be at this set point prior to running the assay.
If a protocol requiring temperature control is loaded and the runexperiment command is
sent, the software confirms that the instrument has achieved this temperature. If the
instrument has not reached the temperature, the software responds with an error. If the
temperature has been reached, the experiment runs.

Auto Print Options Settings

In remotemode, problems with the printer can disrupt the continued operation of the
system. No automatic printing is recommended in remotemode.

Analysis Screen

There are no special notes regarding the Analysis screen in remote control. Setup this screen
as you would for any manual assay.
It is very important to take care to set up groups, display, and reduction settings prior to
running a large number of plates. These settings should be set in the protocol so that they
are automatically replicated in each data file as it is created. It is very tedious to go back to
each data file and change these settings manually.

Transfer Fluid Processes

In general, settings for transferring fluids in remote control are the same as in manual mode,
with three exceptions. These are in aspiration height over multiple plates, and the Pause In
Well edit box.

Aspiration Height over Multiple Plates

When running in remotemode, a user might want to use a common addition source plate
over a series of plates. The protocol(s) for this can be done in a couple of ways. The simplest
way to do this is to create a single protocol which aspirates from the lowest allowed point in
the source well. When doing this, you have to determine themaximum amount of liquid in
the well so that the liquid displaced during insertion of the tip into the well is not pushed out
of the well. This limits the amount of liquid that can be used in the source well. Alternatively,
you can choose to create a series of protocols at successively lower aspiration start levels.
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To provide an example of this situation, consider a user using a 384-well plate with a 250 μL
well. This source plate is used to add a common agonist to all wells. In the assay, 20 μL of this
agonist is added. Leave the plate in the instrument for a series of plates before replacing it.
The FLIPR Penta System allows protocols that begin aspiration as low as 8 μL for this plate.
Inserting a 384-well tip all the way to the bottom of this plate displaces 50 μL of liquid.
In the simplemethod described above, do not start with more than 190-200 μL of liquid in
the plate because any more can spill liquid when the tip is fully inserted. The single protocol
begins aspiration at 8 μL height. Run this assay 9 times before replacing the plate, leaving
10-20 μL of liquid in the wells after the source plate is removed.
In themore complexmethod, fill the wells to 230–240 μL. Then, set up an assay that would
start aspiration at ~240 μL in height, a second assay to start at ~220 μL, and a third assay to
start at ~200 μL. Continue to create separate assays at different heights or use the third
assay for the remaining plates. In this case, 11 plates can be run before the plates need to be
changed.
The simplemethod is simpler to setup and run. Themore complexmethod allows source
plates to be switched less often. It also decreases the proportion of wasted common
reagents. Finally, it can decrease carryover of compounds sticking to the outside of the tips,
especially if the protocols are created to retrieve liquid from progressively lower heights all
the way through the well height.

Pause in Well Edit Box

The Pause in Well edit box on the Edit Dispense screen allows you to require that the
pipettor remain in the well after dispensing. This pipettor operation leaves the tips in the well
for the time specified. When the tips are in the well, it might not be possible to exchange
plates from any position, and certainly not from the read or source 3 positions. For this
reason, use of this option is not recommended in remotemode.

Wash Tips Processes

No special requirements are needed for theWash Tips process.

Note: The pipettor and the plate handler do not share the tip reservoir position. For
this reason, plate handling can proceed unhindered during wash operations.

Mix Fluid Processes

TheMix Fluids process does not require any special changes during protocol creation.

Note: The samewarning that applies to Pause in Well for dispensing also applies
here.

Also, mixing in any well can interfere with plate handling, so use of this function might
require some experimentation.

Read Processes

No special requirements are needed for Read processes.
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Finish with Source Processes

This notifies the plate handler to remove the plates in remotemode.

Wash Cell Reservoir Processes

No special requirements are need for theWash Cell Reservoir process.

Command Set

Command Syntax

All commands and parameters must be sent in lower case and end with <CR>.
All responses are given in lower case and end with <CR>.
Response from ScreenWorks Software has one of the following forms:
ok<CR>

errorcode, error string<CR>

status<CR>

ok<CR> indicates the command was started successfully or command is executed
successfully.
errorcode, error string<CR> indicates command failed because of either an indicated
condition or an instrument error. Error codes are followed by a comma, a space, and
then a string describing the error of up to 300 characters. Error strings are entirely lower
case.
status<CR> is the formatted status text which was requested.

Version <CR>

Command Description

This command returns the version string for the automation interface command set.
This command is only supported for versions 1.1 and newer. Older versions return the error
c69, badly formed or unrecognized command in response to this command.

Command Parameters

There are no parameters associated with this command.

Example Command Line

version<CR>

Example Response

1.1<CR> or c69, badly formed or unrecognized command.<CR>
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Suggested Steps in Command Usage

This should be the first call made to the instrument after making a TCP/IP connection to
ScreenWorks Software. To ensure problem free operation of your application for
FLIPR Penta System customers, the robotic integrator must consider limiting use of the
application to interface versions they have tested.

Status <CR>

Command Description

The status command returns the status of the instrument. The status response is an ASCII
text string which includes:

Information about the instrument type and firmware version.
Whether the instrument is functioning normally or an error occurred. If an error has
occurred, this field contains an error code and an error string of less than 300 characters.
The error code and error string is separated by a comma and space.
The instrument status field reports a summary of status information including whether
the instrument is busy, faulted, error, resetting, aborted, or idle. It also reports whether
the instrument is remote or manual mode. In manual mode, only status information is
available through this interface. All other commands do not function. Finally, this line
reports whether the software is online (connected to the instrument) or not.
Whether an experiment is running or not—do not open or start another experiment
until the first is finished.
Name of the plates assigned to each position.
Whether plates are present or not on plate locations.
Whether plates need to be loaded or removed.
Whether the plate handler is busy or idle.
Whether the landing pad has a plate or not.
Camera temperature. Status returns “not_ok” while camera CCD temperature is cycling
and/or out of range as defined by factory firmware settings, “off” if camera temperature
control is disabled, or “ok” otherwise. The factory setpoint depends on the installed
camera:
EMCCD camera: -70°C (-94°F) ± 2°C
HS EMCCD camera: -70°C (-94°F) ± 2°C
ICCD camera: -20°C (-4°F) ± 5°C
Also returns actual CCD temperature and setpoint.
Chamber temperature. Status reports “not_ok” while chamber is not at setpoint
temperature (typical factory tolerance of ±0.5 °C/± 41°F, “fault” if sensor does not return
a reading, “off” if chamber temperature control has been disabled, or “ok” otherwise.
Waste/fill bottle status.
Tips on|off.
Outer auto door, open/closed—if it is closing it is reported as closed.
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Example Command Line

status<CR>

Response Format

instrument <SP>instrument name<TAB>

version<SP>mm/dd/yyyy<TAB>

function<SP>ok|errorcode|fatalcode,[errorstring]<TAB>

inst_status<SP>busy|fault|error|resetting|abort|idle,remote|manual,o

ffline|online<TAB>

exp_running<SP>yes|no<TAB>

readplate<SP>platename|none,have|empty<TAB>

sourceplate1<SP>platename|none,have|empty<TAB>

sourceplate2<SP>platename|none,have|empty<TAB>

sourceplate3<SP>platename|none,have|empty<TAB>

loadplates<SP>re[,s1,s2,s3,ti]|none<TAB>

removeplates<SP>re[,s1,s2,s3,ti]|none<TAB>

platehandler<SP>idle|busy_load|busy_remove<TAB>

plate_on<SP>yes|no<TAB>

camera_temp<SP>ok|not ok|off,temp,setpoint<TAB>

chamber_temp<SP>ok|not_ok|fault|off<TAB>

waste_bottlea<SP>ok|full<TAB>

waste_bottleb<SP>ok|full<TAB>

fill_bottlea<SP>ok|empty<TAB>

fill_bottleb<SP>ok|empty<TAB>

tips<SP>on|off<TAB>

outer_auto_door<SP>open|closed<CR>

Example Response

instrument<SP> tetra<TAB>

version<SP> sep 30 2004<TAB>

function<SP> d70, initialization halted because tips are loaded. please

verify that the appropriate tip rack (96,384,1536)is loaded and select

reset <TAB>

inst_status<SP> idle,remote,online<TAB>

exp_running<SP>no<TAB>

readplate<SP> default384,have<TAB>

sourceplate1<SP>default384,have<TAB>

sourceplate2<SP>none,have<TAB>

sourceplate3<SP>none,have<TAB>

loadplates<SP>none<TAB>

removeplates<SP>none<TAB>

platehandler<SP>idle<TAB>

plate_on<SP>no<TAB>

camera_temp<SP>ok,-35,-35<TAB>

chamber_temp<SP>off,0,0<TAB>

waste_bottlea<SP>ok<TAB>
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waste_bottleb<SP>ok<TAB>

fill_bottlea<SP>ok<TAB>

fill_bottleb<SP>ok<TAB>

tips<SP>on<TAB>

outer_auto_door<SP>closed<CR>

Suggested Steps in Command Usage

Send status command.
Response is the instrument status.

Loadplate<TAB>Location, Last Plate[, BAR CODE] <CR>

Command Description

Loads plate or tips to the specified location from landing pad. The plates or tips must have
been placed on the instrument landing pad prior to the command being issued. Up to 13
plates (1 source plate, 12 compound plates) can be used in single experiment.
Additional parameters are available to provide the bar code for the delivered plate and
identify the final plate for an assay.
The bar codes of up to 5 plates can be recorded in the data file.

Command Parameters

There are four parameters available for use with this command.
The parameters are location, bar code, and last plate. The location parameter is required.
The bar code and last plate parameters are optional. If the bar code parameter is used then
the plate order parameter must also be used.
Location parameter must be one of following:

re–which indicates read plate location.
s1–which indicates source plate 1 location.
s2–which indicates source plate 2 location.
s3–which indicates source plate 3 location.
ti–which indicates tips loading location.

The tips and source 1 location are the same position. Either the “ti” or “s1” parameter can be
used to indicate this position.
Bar code parameter must be:

String up to 20 characters.
String can have letters, numbers, underscore, and spaces.

The instrument always attempts to read a bar code while loading a plate. If a bar code is
supplied through the loadplate command, any bar code actually found on the actual plate
loaded is ignored.
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The last plate parameter indicates whether or not the plate being loaded is the last plate in
the current experiment. This parameter must be “yes” or “no”. The last plate parameter is no
longer used by the FLIPR Penta System and ScreenWorks Software but continues to be
required for compatibility reasons.

Example Command Line

loadplate<TAB>re, no, abcd1234<CR>

Example Response

ok<CR> or c10, error string<CR>

Suggested Steps in Command Usage

1. Check if instrument status is acceptable, such as no error state, no plate on landing pad,
no plate in target location, plate handler is idle.

2. Put plate on landing pad.
3. Send loadplate command.

Response is OK, confirming command started execution or Condition code related to
command, that confirming command could not start execution.

4. Monitor plate handler status for completion, and error status for any other kind of error.

Command Specific Error Responses

Instrument is not functionalCondition code is C00
Invalid plate locationCondition code is C05
Plate handler busyCondition code is C10
Landing pad does not have a plateCondition code is C20
Plate location already has a plateCondition code is C15

Removeplate<TAB>location <CR>

Command Description

Removes plate or tips from the specified location. If source plate3 location is set for tips in
the current experiment, the instrument assumes tips are present in that position.

Command Parameters

There is one parameter, location, for this command.
Location parameter must be one of following:

re–which indicates read plate location.
s1–which indicates source plate 1 location.
s2–which indicates source plate 2 location.
s3–which indicates source plate 3 location.
ti–which indicates tips loading location.
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Note: The tips and source 1 location are the same position. Either the “ti” or “s1”
parameter may be used to indicate this position.

Example Command Line

removeplate<TAB>s1<CR>

Example Response

ok<CR> or c20, error string <CR>

Suggested Steps in Command Usage

1. Check if instrument status is acceptable (no error state, no plate on landing pad, plate
present in target location, plate handler is idle).

2. Send removeplate command.
Response is OK, that confirming command started execution or Condition Code related
to command, that confirming command could not start execution.

3. Monitor plate handler status for completion, and error status for any other kind of error.
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Command Specific Error Responses

Instrument is not functionalCondition code is C00
Invalid plate locationCondition code is C05
Plate handler busyCondition code is C10
Landing pad has a plateCondition code is C21
Plate location doesn’t have plateCondition code is C16

Openprotocol<TAB>File Name<CR>

Command Description

This command opens the specified protocol. Any documents open before this command is
sent close automatically. Only one protocol can be open at the time.

Command Parameters

There is one parameter, file name, for this command.
File name parameter is the complete file name of the protocol to be opened, including path
and file type identifier (*.fmp).

Example Command Line

openprotocol<TAB>c:\screenworks\protocols\myprotocol.fmp<CR>

Example Response

ok<CR> or c30, error string <CR>

Suggested Steps in Command Usage

1. Make sure experiment is not running.
2. Send openprotocol command.

Response is OK, that confirming command executed or Condition code related to
command, that confirming command did not execute.

Command Specific Error Responses

Experiment is runningCondition code is C25
Protocol not foundCondition code is C30
Protocol could not be openCondition code is C35
Invalid protocol nameCondition code is C36
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Findprotocols<TAB>Folder<CR>

Command Description

This command returns all the protocols in the specified folder. The command returns a
comma-delimited list containing all of the *.fmp type files saved in the indicated directory.
Each of these files are NOT checked to confirm that the protocols that they contain are valid
for the current instrument configuration.

Command Parameters

There is one parameter, folder, for this command.
The folder parameter identifies the folder for which a list of all *.fmp type files are returned.
The folder must be complete and in the correct Windows format, including the drive
identifier and a closing backslash(\).

Example Command Line

findprotocols<TAB>c:\screenworks\protocols\<CR>

Example Response

[myprotocol1.fmp,myprotocol2.fmp,myprotocol3.fmp]<CR> or c45, error string
<CR>

Suggested Steps in Command Usage

Send findprotocol command at any time.
Response is a list of protocols separated by comma or Condition code related to
command, that confirming command could not execute.

Command Specific Error Responses

Folder does not existCondition code is C45
Invalid folder nameCondition code is C46
Current document is not valid protocolCondition code is C50
No protocols found in dirCondition code is C56

Runexperiment<TAB>[Data File Name]<CR>

Command Description

This command runs the currently open protocol, if it is valid for the current instrument
configuration.
Running any protocol creates a data file and shifts the software focus to this data file for the
duration of the experiment. When running in Remotemode, the data file is closed
automatically when the experiment is done and the focus automatically returns to the
protocol file.
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Command Parameters

There is one optional parameter, data file name, for this command.
If a data file name parameter is used with this command, the data file created by running the
current protocol is named data file name. The filename is appended to theData folder path
specified in the protocol Settings screen in the ScreenWorks Software. Never specify data file
name containing a full path.
If the data file name parameter is not given, the data file created is saved with the auto save
name as indicated in the Settings screen in the ScreenWorks Software.

Example Command Line

runexperiment<TAB>mydata10312003.fmd<CR>

Example Response

ok<CR> or c50, error string <CR>

Suggested Steps in Command Usage

1. Check if instrument is functioning fine.
2. Make sure the experiment is not running.
3. Open protocol first by sending openprotocol command.
4. Send runexperiment command.

Response is OK, that confirming command started execution or Condition code related
to command, that confirming command could not start execution.

5. Monitor status for completion, and error status for any other kind of error.
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Command Specific Error Responses

Instrument is not functionalCondition code is C00
Experiment is runningCondition code is C25
Current document is not valid protocolCondition code is C50
Invalid data file nameCondition code is C47

Stopexperiment<CR>

Command Description

This command stops the current action being performed by the instrument.
The stopexperiment command stops the experiment immediately. This can halt the
instrument pipettor in themidst of a motion. In this case, the instrument immediately
enters a fault state and an instrument reset is required. In addition, the pipettor might not
be in motion but might have tips that contain fluid or are in a source or target plate. In these
cases, it might be possible to recover without resetting by washing the tips. Regardless, an
instrument reset is recommended following the use of any stopexperiment command.

Command Parameters

There are no parameters associated with this command.

Example Command Line

stopexperiment<CR>

Example Response

ok<CR> or c55, error string <CR>

Suggested Steps in Command Usage

1. Check if instrument is functioning fine.
2. Make sure experiment is running.
3. Send stopexperiment command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

4. Monitor status for completion, and error status for any other kind of error.

Command Specific Error Responses

Instrument is not functionalCondition code is 00
No experiment is runningCondition code is 55
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Clearerror<CR>

Command Description

Cleans error in case recoverable error occurred.

Command Parameters

There are no parameters associated with this command.

Example Command Line

clearerror<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Check instrument status.
2. Check if error is occurred.
3. Send clearerror command.

Response is OK confirming the software has attempted to clear the error.
4. Monitor status for error is cleared.

Loadtips<CR>

Command Description

This command loads the tips onto the pipettor head from position s1.
This command executes when commanded if tips are not already loaded and any plate is in
the tips position. The instrument is not capable of confirming that the plate in the tip load
position is actually a tip rack. It is the responsibility of the user to ensure that the plate in
that position is actually a tip rack. Attempting to load tips when a plate, rather than a tip
rack, is in the tip load position results in an instrument fault and can result in damage to the
plate, the instrument, or both.

Command Parameters

There are no parameters associated with this command.

Example Command Line

loadtips<CR>

Example Response

ok<CR>
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Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Check the instrument status to make sure tips are not already loaded.
3. Place tiprack in tipload position via the loadplate command.
4. Send loadtips command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

5. Monitor status for completion, and error status for any other kind of error.

Command Specific Error Responses

Can't load tips, tips on pipettorCondition code is C58

Unloadtips<CR>

Command Description

This command unloads the pipette tips from the pipettor head into an empty tip rack placed
into the tip load position.
This command executes when commanded if tips are loaded and any plate is in the tips
position. The instrument is not capable of confirming that the plate in the tip load position is
actually an empty tip rack. It is the responsibility of the user to ensure that the plate in that
position is actually an empty tip rack. Attempting to load tips when a plate or full tip rack,
rather than an empty tip rack, is in the tip load position likely results in an instrument fault
and can result in damage to the plate, the instrument, or both.

Command Parameters

There are no parameters associated with this command.

Example Command Line

unloadtips<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Check the instrument status to make sure tips are currently loaded.
3. Ensure that an empty tip rack is in tip load position.
4. Send loadtips command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

5. Monitor status for completion, and error status for any other kind of error.
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Command Specific Error Responses

Can't unload tips, tips not on pipettorCondition code is C59

Cyclecameratemp<CR>

Command Description

This operation cycles the camera temperature by setting the camera setpoint to 20°C (68°F),
waiting for the camera to reach this setpoint, resetting the camera to -45°C (-49°F), and then
waiting for the camera to return to this temperature.
This command can be useful when transitioning from fluorescence to luminescence
experiments. Cycling the camera temperature allows the camera CCD chip to recover from
the high light levels present during fluorescence experiments and improves data quality in
subsequent luminescence experiments.
This command requires up to 15minutes to complete execution.

Command Parameters

There are no parameters associated with this command.

Example Command Line

cyclecameratemp<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Send cyclecameratemp command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

3. Monitor status for completion, and error status for any other kind of error.

Tempcontrolonoff<TAB>Temp<CR>

Command Description

This command sets the temperature setting for the instrument chamber. After sending this
command, the robotic controller should monitor the instrument temperature to confirm
that the instrument reaches the setpoint. Some protocols do not execute until the required
temperature is reached.

Example Command Line

tempcontrolonoff<TAB>12<CR>
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Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Send tempcontrolonoff command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

3. Monitor status until the instrument reports that it has reached the requested
temperature.

Command Specific Error Responses

Temperature Control System is not functioningC60

Washtips<TAB>Fluid Type, Wash Cycles, Volume/Stroke, Aspirate
Speed, Pump Speed, Strokes, Hold Time, Dispense Speed<CR>

Command Description

This command is the equivalent of selecting Instrument> Manual Operation > Wash Tips
from themain menu of the ScreenWorks Software. This selection washes the pipette tips
with the parameters provided.

Command Parameters

There are eight required parameters for this command. All eight parameters must be
supplied for this command to properly execute. For some of the parameters, acceptable
values can vary depending on the head type currently installed on the instrument. The
following table lists the parameters, their purpose, and the appropriate range for the
commands.

Parameter Description Acceptable values or range

96-well
head

384-well
head

1536-
well head

Fluid type Indicates which wash fluid bottle to be used. a, b

Wash Cycles Number of wash reservoir fill/drain cycles to
complete. The requested # of strokes is repeated
for each cycle.

1,2,3,4,5

Volume/stroke Volume to be drawn into the pipette tip in each
stroke.

5–206
(double)

1–28
(double)

1–3
(double)
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Parameter Description Acceptable values or range

96-well
head

384-well
head

1536-
well head

Aspirate speed Pipettor aspiration speed in micro liters per
second.

5.00,
10.00,
20.00,
30.00,
40.00,
50.00,
75.00,
100.00,
125.00

0.50,
1.00,
2.00,
5.00,
7.00,
10.00,
15.00,
20.00,
25.00,
30.00

0.25,
0.50,
0.75,
1.00,
1.25,
1.50,
2.00,
3.00,
5.00,
10.00

Pump speed Speed to run the pumps which fill and drain the
wash reservoir. Two speeds, fast and slow, are
available. Slow is recommended for use with
wash solvents which tend to bubble.

fast, slow

Strokes Number of times which the pipettor fills and
empty with the requested volume in each wash
cycle.

1–20
(integer)

Hold time Pause time in seconds at the top of the stroke of
the pipettor

0–15

Dispense speed Pipettor dispense speed in micro liters per
second.

5–200
(double)

1–50
(double)

1–10
(double)

Example Command Line

washtips<TAB>a,2,28.0,20.00,fast,5,0.0,20.0<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Ensure that tips are loaded.
3. Send washtips command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

4. Monitor status until the wash is complete.

Command Specific Error Responses

Tips not loaded C68
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Configuration<CR>

Command Description:

The configuration command returns the configure of the instrument. The configuration
response is an ASCII text string which includes:

Information about the instrument type and firmware version.
Pipettor head’s type.
Tip washer’s type.
Bar code reader installed or not.
Plate handler installed or not.
Cell Reservoir installed or not.
Camera type installed.
Chiller installed or not.
LEDs installed.
Emission filters’ wavelength.

Example Command Line

configuration<CR>

Response format

instrument<SP>name<TAB>

version<SP>version#<TAB>

pipettor<SP>96|384|1536|384pintool| 1536pintool|no<TAB>

tip_washer<SP>96|384|1536|no<TAB>

bar_code<SP>installed|not installed<TAB>

plate_handler<SP>installed|not installed<TAB>

cell_reservoir<SP>installed|not installed<TAB>

camera_installed<SP>emccd|iccd<TAB>

chiller_installed<SP>installed|not installed<TAB>

wave1<SP>no led|470-495 nm|510-545 nm|390-420 nm|420-455
nm|610-626 nm|360-380 nm|525-550 nm|525-570 nm|570-595
nm|590-614 nm|620-648 nm|495-505nm|360-380 nm <TAB>

wave2<SP>no led|470-495 nm|510-545 nm|390-420 nm|420-455
nm|610-626 nm|360-380 nm|525-550 nm|525-570 nm|570-595
nm|590-614 nm|620-648 nm|495-505 nm|360-380 nm <TAB>

emfilt1<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535
nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675
nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB>

emfilt2<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535
nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675
nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB>

emfilt3<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535
nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675
nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB>

<CR>
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Example Response

Instrument<SP>tetra<TAB>

version<SP>2.1.0.0<TAB>

pipettor<SP>96<TAB>

tip_washer<SP>96<TAB>

bar_code<SP>installed<TAB>

plate_handler<SP>installed<TAB>

cell_reservoir<SP>installed<TAB>

camera_installed<SP>emccd<TAB>

chiller_installed<SP>installed<TAB>

wave1<SP>470-495 nm<TAB>

wave2<SP>510-545 nm<TAB>

emfilt1<SP>515-575 nm<TAB>

emfilt2<SP>515-575 nm<TAB>

emfilt3<SP>515-575 nm<CR>

Suggested Steps in Command Usage

Send configuration command.
Response is instrument configuration.

Statusex<CR>

Command Description

The statusex command is an extension of status command. It returns the status of the
instrument in more details than the status command. The statusex response is an ASCII text
string which includes all status command response information plus:

Tip washer status
Cell Reservoir status
Camera chiller status
Camera intensifier status

Example Command line

statusex<CR>

Response format

instrument <SP>instrument name<TAB>

version<SP>mm/dd/yyyy<TAB>

function<SP>ok|errorcode|fatalcode,[errorstring]<TAB>

inst_
status<SP>busy|fault|error|resetting|abort|idle,remote|manual,offline|online<T
AB>

exp_running<SP>yes|no<TAB>

readplate<SP>platename|none,have|empty<TAB>

sourceplate1<SP>platename|none,have|empty<TAB>
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sourceplate2<SP>platename|none,have|empty<TAB>

sourceplate3<SP>platename|none,have|empty<TAB>

loadplates<SP>re[,s1,s2,s3,ti]|none<TAB>

removeplates<SP>re[,s1,s2,s3,ti]|none<TAB>

platehandler<SP>idle|busy_load|busy_remove<TAB>

plate_on<SP>yes|no<TAB>

camera_temp<SP>ok|not ok|off|busy|fault,temp,setpoint<TAB>

chamber_temp<SP>ok|not_ok|fault|off|busy<TAB>

waste_bottlea<SP>ok|full<TAB>

waste_bottleb<SP>ok|full<TAB>

fill_bottlea<SP>ok|empty<TAB>

fill_bottleb<SP>ok|empty<TAB>

tips<SP>on|off<TAB>

outer_auto_door<SP>open|closed<TAB>

tip_washer<SP>ok|not_ok|off|busy|fault<TAB>

cell_reservoir<SP>ok|not_ok|off|busy|fault,stir rate<TAB>

chiller_status<SP>ok|not_ok|off|busy|fault,temp,setpoint<TAB>

intensifier_status ok|not_ok|off|busy|fault<CR>

Example Response

instrument<SP> tetra<TAB>

version<SP>2.1.0.0<TAB>

function<SP>ok<TAB>

inst_status<SP>idle,remote,online<TAB>

exp_running<SP>no<TAB>

readplate<SP>default96,have<TAB>

sourceplate1<SP>default96,have<TAB>

sourceplate2<SP>default96,have<TAB>

sourceplate3<SP>default96,have<TAB>

loadplates<SP>none<TAB>

removeplates<SP>none<TAB>

platehandler<SP>idle<TAB>

plate_on<SP>no<TAB>

camera<SP>temp ok,0,0<TAB>

chamber_temp<SP>off,0,0<TAB>

waste_bottlea<SP>ok<TAB>

waste_bottleb<SP>ok<TAB>

fill_bottlea<SP>ok<TAB>

fill_bottleb<SP>ok<TAB>

tips<SP>on<TAB>

outer_auto_door<SP>open<TAB>

tip_washer<SP>ok<TAB>

cell_reservoir<SP>not_ok,0<TAB>

chiller_status<SP>ok,18.0, 18.0<TAB>

intensifier_status<SP>ok<CR>
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Cellflaskcontrol<TAB>Rate<CR>

Command Description

This command sets the stir-rate for the cell-flask control. After sending this command, the
robotic controller should monitor the instrument stir-rate to confirm that the instrument
reaches the setpoint.

Command Parameters

There is one required parameter, rate, for this command.
If a value of zero is used for the rate parameter, the cell flask control stops stirring. If a valid
value for rate is used, the cell flask control turns on and stirs at this rate. Valid values for rate
are integers between 1–25.

Example Command Line

cellflaskcontrol<TAB>22<CR>

Example Response

ok<CR>

Suggested Steps in Command usage

1. Make sure an experiment is not running.
2. Send cellflaskcontrol command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

3. Monitor status until the instrument reports that it has reached the requested stir-rate.

Command Specific Error Responses

C76–Cell flask stirring rate parameter was not sent
C77–Parameter is out of range. Range is …

Washcellreservoir<TAB>Fluid Type, Fill Speed, Drain Destination,
Drain Speed, Wash Cycles, Hold Time, Volume Level<CR>

Command Description

This command is the equivalent of selecting Instrument > Manual Operation > Wash Cell
Reservoir from themain menu of the ScreenWorks Software. This selection washes the Cell
Reservoir with the parameters provided.
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Command Parameters

There are seven required parameters for this command. All seven parameters must be
supplied for this command to properly execute. The following table lists the parameters,
their purpose, and the appropriate range for each parameter.

Parameter Type Description Acceptable values or
range

Fluid type string Indicates the fluid bottle to be used. Fluid 1, fluid 2, fluid 3,
fluid 4, cell flask.

Fill speed integer Speed to run the pumps which fill the Cell
Reservoir. Range from 1–10 where 1 is very
slow, and 10 is very fast.

1–10

Drain
destination

string Indicate the bottle to drain fluid to. Fluid 1, fluid 2, fluid 3,
fluid 4, cell flask, waste a,
waste b.

Drain speed integer Speed to run the pumps which drain the Cell
Reservoir. Range from 1–10 where 1 is very
slow, and 10 is very fast.

1–10

Wash cycles integer Number of wash reservoir fill/drain cycles to
complete.

1,2,3,4,5

Hold time float Pause time in seconds, leaving the fluid in the
reservoir for desired period of time before
draining it.

0–300

Volume string This indicate the level of fluid to be filled in the
Cell Reservoir.

low, high

Example Command Line

washcellreservoir<TAB>fluid 2, 6, waste a, 8, 1, 0, high<CR>

Example Response

Ok<CR>

Suggested Steps in Command usage

1. Make sure an experiment is not running.
2. Ensure that tips are loaded.
3. Send washcellreservoir command.

Response is OK, confirming that command execution has begun, or a Condition code
related to the command indicating that execution could not begin.

4. Monitor status until the wash is complete.
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Command Specific Error Responses

C77–Parameter is out of range. The range is ...
C78–The number of parameters for wash Cell Reservoir commands is invalid.
C79–Invalid volume parameter. It must be 'low' or 'high'.
C72–Hold time is too small.
C73–Hold time is too large.

Error Handling and Reporting

Interface Errors

Interface errors are errors that are generated by issuing a command. These errors are
detected upon receipt of the command by ScreenWorks Software and are reported in the
response to the command. These errors consist of a single alpha character and a two or
three-digit code. Specific errors are listed with the command that can generate them in Table
G-1.

Error
Code

Description

C01 Instrument is not in Remote Mode. Only ‘status’ command can be sent while instrument
is in Manual Mode.

C05 Invalid plate location.

C10 Plate handler is busy.

C15 Plate location already has a plate.

C16 Plate location has no plate.

C20 Landing pad has no plate.

C21 Landing pad has plate.

C25 Experiment is running.

C35 Protocol could not be opened.

C36 Invalid protocol name.

C45 Folder does not exist.

C46 Invalid folder name.

C47 Invalid data file name.

C50 Current document is not valid protocol.S

C55 No experiment is running.

C56 No protocols found in dir.

C57 The temperature parameter (int) was not sent.

Table G-1: Interface Errors
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Error
Code

Description

C58 Can't load tips, tips on pipettor.

C59 Can't unload tips, no tips on pipettor.

C60 The temperature control system is not functioning.

C61 The aspirate speed is out of range.

C62 The pump speed can only be Slow or Fast.

C63 Invalid number of wash strokes.

C64 Invalid number of parameters for the wash tips command.

C65 Invalid number of wash cycles.

C66 Invalid protocol parameters discovered at runtime.

C67 Invalid wash fluid parameter.

C68 Can't wash tips, tips are not on.

C69 Unrecognized or badly formatted command.

C70 Volume stroke too large.

C71 Volume stroke too small.

C72 Hold time is too small.

C73 Hold time is too large.

C74 Dispense speed is too large.

C75 Dispense speed is too small.

C76 Cell flask stirring rate parameter was not sent.

C77 Parameter is out of range.

C78 The number of parameters for wash Cell Reservoir commands is invalid.

C79 Invalid volume parameter. It must be 'low' or 'high'.

Table G-1: Interface Errors (continued)

Table G-2 documents the errors onemight encounter when sending the runexperiment
command. The errors explain how the currently opened protocol does not match
instrument configure or instrument is not ready to run current protocol.

Error
Code

Description

E100 Invalid LED filter combination! Calibrate it or choose valid combination.

E110 Plate does not exist in plate library. Choose existing plate or add it into plate library.

E111 Plate is not present or is not in the proper location.

Table G-2: runexperiment Command Errors
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Error
Code

Description

E112 Door(s) are opened. Close the doors before start your experiment.

E113 Load Tips position not checked! Check Load Tips position for auto load tips or manually load
tips before running experiment.

E114 The chamber temperature is not in range.

E115 Experiment wash tips and there is no tip washer.

E116 Bottle A is empty! Refill it or use another bottle.

E117 Bottle B is empty! Refill it or use another bottle.

E118 Waste bottle A is full. Please empty the bottle to continue.

E119 Waste bottle B is full. Please empty the bottle to continue.

E120 Remove plates redundant.

E121 Error relate to the data folder. The path is not valid, or cannot be accessed. Or there are not
enough disk space.

E122 Error relate to the export folder. The path is not valid, or cannot be accessed. Or there are
not enough disk space.

E123 The read interval is too short. Please check settings in Read views.

E124 Invalid aspirate parameters [in the protocol].

E125 Invalid dispense parameters [in the protocol].

E126 The wash tips parameters are invalid.

E127 Invalid fluid bottle specified in wash tips process.

E128 Invalid Read Mode configuration. You tried to take fluorescence (with excitation) and
luminescence (without excitation) reading in one protocol. This is not allowed.

E129 Invalid Read Mode configuration. Camera gain or gate time is out of range. Please check
your protocol settings.

E130 The protocol has transfer cells and/or wash Cell Reservoir operations even though the Cell
Reservoir is not installed.

E131 Cell Reservoir is not ready.

E132 Cell flask spinning rate could not be set. Please check your instrument status.

Table G-2: runexperiment Command Errors (continued)

Instrument Errors

Instrument errors are errors that are generated by executing a command. These errors are
detected during the execution of the command by the instrument. They are reported in the
status response in the function line. These errors consist of a three-digit numeric code.
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Instrument errors fall into two general categories, recoverable and fatal errors. When fatal
errors occur, the instrument can not continue to do any operation. It aborts any pending
operations. When recoverable errors occur with user interaction, the instrument can
continue.
The status command returns ERRORCODE or FATALCODE.

Error codes 100–199 are call Molecular Devices Tech support errors.
Error codes 200–299 are instrument recoverable errors.
Error codes 300–399 are instrument non-fatal errors.
Error codes 400–499 are instrument fatal errors.
Error codes 500–599 are instrument diagnostic errors.

A full list of these errors can be found in Troubleshooting on page 209.

Remote Interface Revision History

V1.0

First release.

V1.1

Added the following new commands:
version
loadtips
unloadtips
cyclecameratemp
tempcontrolonoff
washtips

Error code response include text description after code, for example, c45, folder does not

exist.

V1.2

Added Error Code:
C01, Instrument is not in Remote Mode.Only status command can be sent while
instrument is inManual Mode.
Bug Fix:
Commands made to the remote interface could sometimes take a long time and cause the
remote interface to not respond to the client application within an acceptable timeframe.
Client applications were able to work around this bug with massive TCP/IP timeouts
(minutes) which made a true hang or network dropout undetectable. This workaround is no
longer required.
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The interface is unchanged, and if the client is correctly parsing the status response, no
changes should be required in the client application, with the exception of reducing the
TCP/IP timeout back to an acceptable value, for example, < 10 seconds. As always, rigorous
regression testing of client code is encouraged.

V1.3

Added the following new commands to support new functionality in the Tetra Plus:
statusex
configuration
cellflaskcontrol
washcellreservoir

Note: Tips location has changed from the Source 3 location to the Source 1 location.

Barcode Specifications

About Bar Codes

The FLIPR Penta System bar code scanner is an OEM module with decode capability to most
commonly used bar code symbols in industry worldwide. The list includes:

WPC (UPC /EAN/JAN
IATA
Code 39
Interleaved 2 of 5
Industrial 2 of 5
Code 128
Code 93
MSI/Plessey
Codabar (NW-7)

Bar Code Recommendations

The bar code reader implementation allows a bar code read down to 7.5mil (0.20mm) on
photographic-quality symbols and ambient light < 450 ft-candles.
We recommend, however, the user stay above 7.5mil (0.26mm) sincemost bar code
printers might not have the resolution needed to match the required aspect ratio for a
minimum of 3mm-high symbol lines. Before adjusting the bar code scanner to the bar code
label location on themicroplate, some general guidelines to the preparation and quality of
the bar code label need to be followed for optimum performance:

Theminimum height or size of the symbol bars depends on the code symbol and the
density used. Try to keep the height of the symbol bars to more than 0.12 in. (3.0mm).
Do not change the aspect ratio required by the label printer. Do not force the bar code
symbol size to fit on your label space i.e., maintain the aspect ratio free of distortion.
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Align the bars horizontally (side-to-side) and vertically (top-to-bottom) if possible, to
keep space available on the bar code label.
Keep a fewmillimeters (2–4) of empty dead or silent zone on both ends of the code-
symbol lines. Keep all symbol lines away from the label corners and lifted edges.
Optimize your characters so there is no need to cram a lot of lines on the label.
Keep the longitudinal dimension of the labels/symbols to less that 1.25–1.50 in. (30–
40 mm).
Choose themedia (label substratematerial or paper) print or transfer ink to give good
contrast and optimal reflection. Metalized, very shiny or clear background labels may be
less reliable. Test a sample if using a new color or surfacematerial.

Bar Code Specifications
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Appendix H: Electromagnetic Compatibility

Regulatory for Canada (ICES/NMB-001:2006)
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est confomre à la norme NMB-001 du Canada.

ISM Equipment Classification (Group 1, Class A)
This equipment is designated as scientific equipment for laboratory use that intentionally
generate and/or use conductively coupled radio-frequency energy for internal functioning,
and are suitable for use in all establishments, other than domestic and those directly
connected to a low voltage power supply network which supply buildings used for domestic
purposes.

Information to the User (FCC Notice)
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 18 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be required to correct the
interference at their own expense. Changes or modifications made to this equipment not
expressly approved by the party responsible for compliancemay void the FCC authorization
to operate this equipment.

H
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